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and all such warranties are explicitly and expressly denied.
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Chapter 1

Installing Adagio

The installation process is similar for each Adagio product. This chapter will look in
detail at the standard install procedure for any Adagio product. We’ll use Adagio
Ledger’s installation as an example.

When installing any Adagio product on a network, no other users
should be running Adagio. The Adagio install checks to make sure
no other users are running Adagio. If any other user is running
Adagio, an error message is displayed, indicating: "Cannot
currently update Adagio [application] in the following directory".
The files in use are shown. The install has no way to tell who the
other users are. All users should exit all Adagio applications and
re-try installing. When necessary, the workstation and Service Pack
install programs also check to ensure no others are running Adagio.

Each Adagio product gives you the option to run a standard install or to do a custom
install, where you can make changes to the default installation options if desired. The
following sections will look at each type of install. But first, we’ll discuss an
important pre-installation issue.
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Pre-Installation
Before you begin installing any Adagio product, you will need to take note of the
product labels that are included with your CD, or have on hand the serial number
and install code that was emailed to you with a downloaded product.

Download Files
If you received your serial number and install code by email, please note the
following information that you should have received in the email:

• the product name,
• the version number and release date,
• the extraction password,
• the serial number, and
• the install code.

This information is vital. Without it, the downloaded file is useless.

Please be sure to print a copy of the email and store it in a safe place. We also
recommend saving the email in your email software for future reference.

Physical CD
If you have a physical CD, please note the labels. Each product comes with a large
label and two smaller ones. These labels all indicate:

• Adagio CD date,
• the product name,
• the version number and release date,
• the serial number, and
• the install code.

This information is vital. Without it, the CD is useless.

Please make sure that you retain these labels in the event that you ever need to
re-install the product. We strongly recommend using the labels in the following way:

• Peel off the largest label and place it on the inside cover of the product
manual. If this is an upgrade, you may want to place the new label over any old
label you already have on the inside cover of the manual so that you don’t
have mismatched CDs and serial numbers.

Pre-Installation
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• Stick one of the two smaller labels on the CD sleeve. The CDs are all
electronically imprinted with a date. The Adagio CD date on the CD and the
label must match. Therefore, a new Adagio Ledger CD cannot be used in
conjunction with the serial number and install codes from an older Adagio
Ledger CD. Because of this, it is very important that the CD and its
appropriate serial number and install codes are kept together.

• Use the third small label as you see fit. You may want to stick it on the product
invoice or elsewhere in your filing system.

Pre-Installation
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General Installation Notes
• Please refer to our website at www.softrak.com under Support,

Compatibility for up to date information about products and versions that are
compatible with the module you are wanting to install.

• When installing an Adagio module or running a workstation install on a
network, you must be logged into the network as the actual User of the
station, and this User must have full installation privileges during the install;
otherwise the installation will not be completed successfully. They require
enough rights to write information to the registry.

Information pertaining to printing reports is written to the user’s Windows
Registry, and if the installation was not performed as this user, the
information is not saved. The result is that this workstation or this User will be
unable to print reports.

If you do not want to change the network rights permanently, grant the user
rights prior to performing install or workstation install, then change them back
afterward. This will enable the proper files to be updated.

• The install and workstation install (but not the Service Pack install) check the
“Opportunistic Locking” settings to ensure they are correctly set on the
workstation. If the settings are incorrect, a warning is displayed and you are
asked if you want to change the settings.

Proper “Opportunistic Locking” settings are required at each workstation (and
on the server) to ensure the integrity of your accounting data in a multi-user
environment.

Opportunistic Locking settings can also be checked and set using the Check
System Utility (found in the Softrak\System folder on the server).

• Microsoft VISTA and Windows 7’s acceptable security policy is that all
programs should be run with User Account Control (UAC) turned ON.
As well, while a user can be an Administrator, the preferred account type
is as a Standard User, in which case when programs are installed, the UAC
function will prompt for an Administrative account and password. All
VISTA and Windows 7-compatible Adagio programs are meant to run
using this scheme, but installing them requires the following
considerations:

General Installation Notes
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1 Only 8.1 or later Adagio programs will be supported when installing using a
Vista or Windows 7 machine (Crystal Reports mut be 8.5B).

2 To install or upgrade an Adagio program locally onto a VISTA or Windows 7
machine, you must be logged on as the user who will be using the program,
and should abide by the above policy.

3 To install or upgrade an Adagio program to a network using a VISTA or
Windows 7 machine, you must be logged on as the user who will be using the
program(s) on that workstation. If that user is not an Administrator, then the
user must first temporarily become a VISTA or Windows 7 Administrative
User. The user must then temporarily have UAC turned OFF. When all
programs have been installed, the user should turn UAC back ON and then
should become a Standard User, if required.

Once the Adagio program on the network has been installed or upgraded,
then each workstation must be updated. On each workstation, you must be
logged on as the user who will use the program, and should abide by the
above policy. You can start the Adagio program, which will automatically run
a workstation install if one is required, or run either the wksetup.exe program
or the allwkst.exe program to update the individual workstation(s). As well,
see Note below.

4 If, on a VISTA or Windows 7 machine, there will be two or more Windows
users who will run an Adagio program (whether locally or from a network),
these other users can remain as VISTA/Windows 7 Standard Users and with
UAC turned ON, and then, as usual, you should run wksetup.exe (or
allwkst.exe if for a network). As well, see Note below.

While in general the auto-workstation feature will work, if you
find that it briefly flashes a screen and then exits, you must run
wksetup.exe.

General Installation Notes
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Standard Install
To install Adagio Ledger using the Standard Install option, follow these steps.

1) Insert the CD in the drive, or go to the location where you downloaded the
Adagio software and run the install file (setup.exe).

If Windows is set to Auto-Run on your system, the install screen will appear
automatically. If not, use the Run option on the Windows start menu to locate
the file ADAGIO.EXE on your CD drive (usually drive D:), and then click OK to
begin the install. The following window appears:

Using the serial number and install code provided to you on the labels that came
with the CD (see the Pre-installation section earlier in this chapter for more
information) or via email for downloaded software, enter the appropriate
numbers here.

Standard Install
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2) When you’ve entered the install code and serial number, click OK to proceed.
The Welcome! window appears.

3) If it is not already selected, click the Standard Install radio button, then click
Next. The Standard Install window is displayed:

Standard Install
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You must set two options before proceeding:

Option Description

Destination
Directory

This is the drive to which the Adagio program will be
installed.

The install automatically selects a drive and directory
for you; however, this drive and path can be changed
if desired.

If you are installing on a network, select a network
drive.

The default directory is \SOFTRAK followed by a
directory that uses the program code for its name. For
example, Adagio Ledger would be installed in
\SOFTRAK\LEDGER.

To change the Destination Directory, click the Browse
button and select an alternate drive and/or path,
making sure that your selection always ends with the
above two subdirectories (\SOFTRAK\LEDGER).

Report Tables Drive The report tables drive defaults to the drive on which
other Adagio programs are found. The Report Tables
Drive should be the same for all Adagio products.

If you are installing on a network, select a network
drive.

To change the default drive selected, click the down
arrow and select an alternate drive.

When running under Vista or Windows 7 workstation and
installing on a network, you will see a Network Drives button in
the lower left corner of the Standard or Custom Install window. If
you must install to a network drive that is normally accessible but
you cannot see it during this install, you will need to turn 'off' the
Windows User Account Control setting in order to see the mapped
network drive. Refer to General Installation Notes on page 1-4.

When you’ve made your selections, click Next.

Standard Install
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4) If you do not have a previous version of this Adagio product installed, you will
then be prompted with a Program Group selection window:

Please see the section later in this chapter entitled Program Group Selection for
details on choosing a program group and, if desired, a sub-group.

Click Next when you’re ready to proceed.

Standard Install
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5) If you are installing over a previous version of the Adagio program, you will see
a sample data prompt. You can either replace the old sample data by clicking Yes
or skip the installation of fresh sample data by clicking No.

6) The Ready to Install window appears:

Click Install to begin the process. You will see a progress dialog indicating how
far along the installation is at any given time.

7) When the install process is complete, the program will tell you:

Standard Install
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Click View to look at the README file at this time, or click Finished to exit the
install.

It is a good idea to review the information in the README file
either at the time of the install or later, as it contains valuable
information about new features and changes to the product .

This completes the standard install; you are now ready to begin working with your
Adagio program.

Standard Install
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Custom Install
To install Adagio Ledger using the Custom Install option, follow these steps.

1) Insert the CD in the drive, or go to the location where you downloaded the
Adagio software and run the install file (setup.exe).

If Windows is set to Auto-Run on your system, the install screen will appear
automatically. If not, use the Run option on the Windows start menu to locate
the file ADAGIO.EXE on your CD drive (usually drive D:), and then click OK to
begin the install. The following window appears:

Using the serial number and install code provided to you on the labels that came
with the CD (see the Pre-installation section earlier in this chapter for more
information) or via email for downloaded software, enter the appropriate
numbers here.

Or, if you wish to run a time-limited evaluation in order to decide whether you’d
like to purchase the Adagio product or not, leave these fields blank and click
OK. The evaluation copy that gets installed is crippled in some small ways, and
can only be used for a certain period of time.

Custom Install
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2) When you’ve entered the install code and serial number, click OK to proceed.
The Welcome! window appears.

3) If it is not already selected, click the Custom Install radio button, then click
Next. The Custom Install window is displayed:

Custom Install
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You must set three options before proceeding:

Option Description

Destination
Directory

This is the drive to which the Adagio program will be
installed.

The install automatically selects a drive and directory
for you; however, this drive and path can be changed
if desired.

If you are installing on a network, select a network
drive.

The default directory is \SOFTRAK followed by a
directory that uses the program code for its name. For
example, Adagio Ledger would be installed in
\SOFTRAK\LEDGER.

To change the Destination Directory, click the Browse
button and select an alternate drive and/or path,
making sure that your selection always ends with the
above two subdirectories (\SOFTRAK\LEDGER).

Report Tables Drive The report tables drive defaults to the drive on which
other Adagio programs are found. The Report Tables
Drive should be the same for all Adagio products.

If you are installing on a network the report tables
drive must be a network drive.

To change the default drive selected, click the down
arrow and select an alternate drive.

Backup Files If you’d like to retain a copy of the files that the install
program overwrites, turn this option on. The install
will copy the original version of those files to a
subdirectory called BACKUP. To illustrate, if you
install your Adagio Ledger to
C:\SOFTRAK\LEDGER, the backup files would be
placed in C:\SOFTRAK\LEDGER\BACKUP.

To omit the saving of backup files, turn this checkbox
off.

Custom Install
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When running under Vista or Windows 7 workstation and
installing on a network, you will see a Network Drives button in
the lower left corner of the Standard or Custom Install window. If
you must install to a network drive that is normally accessible but
you cannot see it during this install, you will need to turn 'off' the
Windows User Account Control setting in order to see the mapped
network drive. Refer to General Installation Notes on page 1-4.

4) Click Next when you’re ready to proceed. The Installation Components
window appears:

This screen gives you the option to install the following:

Option Description

Application Files These are the Adagio program files themselves.
Unless you are merely installing fresh sample data,
you will always want to leave this option on.

Sample Data A set of data that can be used to experiment and
familiarize yourself with the Adagio program,
without affecting your company’s live data. Leave this
option on if you want the sample data to be installed.

Custom Install
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Option Description

Help Files All Adagio programs come equipped with an on-line
Help system which provides detailed information
about using the program. To install this Help system,
leave this option on.

Report Tables This option allows you to install the tables necessary
for using a report writer such as Crystal Reports for
Adagio with the data from this Adagio program. If
you use any report writer, leave this option on.

Workstation Setup
Files

If you intend to run this Adagio program on a
network, on multiple workstations, turn this option
on. If you are installing to a local drive, leave this
option turned off.

Click any of the above components once if you do not wish to install that
component. Click Next when you’re ready.

5) If you do not have a previous version of this Adagio product installed, you will
then be prompted with a Program Group selection window.

Please see the section later, entitled Program Group Selection, for details on
choosing a program group and, if desired, a sub-group.

Click Next when you’re ready to proceed.

Custom Install
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6) If you are installing over a previous version of the Adagio program, you will see
a sample data prompt.

You can either replace the old sample data by clicking Yes or skip the installation
of fresh sample data by clicking number. The installation will proceed.

7) The Ready to Install window appears:

Click Install to begin the process. You will see a progress dialog indicating how
far along the installation is at any given time.

Custom Install
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8) When the install process is complete, the program will tell you:

Click View to look at the README file at this time, or click Finished to exit the
install.

It is a good idea to review the information in the README file
either at the time of the install or later, as it contains valuable
information about new features and changes to the product.

This completes the custom install; you are now ready to begin working with your
Adagio program.

Custom Install
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Installing on a Network
If you wish to run an Adagio program on more than one workstation, you must
install the program on a network drive. You should then run either the
WKSETUP.EXE program to run the workstation install for individual modules on
each individual workstation which will run Adagio; or, run the ALLWKST.EXE
program to run the workstation install for all or multiple modules on each
workstation as noted below.

Alternatively, you can drill down to the application folder on the server (eg.
Softrak\LEDGER) and run the program. This will invoke the AutoWorkstation
Install within the program.

Before you begin installation on a network, make sure that your Adagio data resides
on a network drive.

You should install Adagio from a workstation, rather than at a
network server. Simply install it from the workstation, but select a
network drive on the server to install to. After, proceed to do the
workstation installs on all workstations that will be running
Adagio. Refer to General Installation Notes on page 1-4.

Installing the Program
First, you will need to install the Adagio program itself. To do this, go through the
installation steps in either the Standard Install or Custom Install sections.

• Standard Install. In Step 3, select a network drive on which to install the
Adagio program.

The Standard Install will automatically install Workstation files if you install
the program on a network drive.

Also make certain in step 3 that your Adagio data resides on a network drive.

• Custom Install. In Step 3, select a network drive on which to install the
Adagio program.

Also make certain in step 3 that your Adagio data resides on a network drive.

In Step 4, confirm that the Workstation Setup Files checkbox is turned on.

Installing on a Network
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Installing the Workstation Setup
Once installation is complete, you must install the workstation setup program on
each computer that will be running the Adagio module.

There are three ways to do a workstation install. You can run a workstation install
specifically for a single Adagio module or, if you are installing multiple Adagio
applications on each workstation, you can use the All Workstation install, which will
do the workstation install of multiple Adagio applications simultaneously. The third
way is to drill down to the application folder on the server (eg. Softrak\LEDGER)
and run the program. This will invoke the AutoWorkstation Install within the
program.

When installing under Vista or windows 7 workstation on a network, you must first
turn off User Account Control (UAC); otherwise the install will not be able to see
mapped network drives and the installation cannot be completed successfully.

Single Module Install
To run the workstation install for one specific module (eg. Ledger):

1) In Windows Explorer, go to the drive where you installed Adagio Ledger, and
then to the directory \SOFTRAK\LEDGER\WKSETUP\.

2) Find the file WKSETUP.EXE. Double-click this file to begin the workstation
setup installation.

3) The workstation setup install screen will appear, with the Welcome! dialog box.
From the welcome dialog, confirm the destination and version and click Next.

4) The next two screens allow you to make a backup of any files replaced by the
workstation install and to select the program group for the specific Adagio
module on your Windows start menu.

The final screen simply asks for confirmation and lists the options that you have
chosen to install. To install the program(s), click Install.

Alternatively, you can drill down to the application folder on the server (eg.
Softrak\LEDGER) and run the program. This will invoke the AutoWorkstation
Install within the program.

Installing on a Network
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Multiple Module Install
To run the All Workstation install for all or multiple Adagio applications:

1) In Windows Explorer, go to the drive where you installed Adagio BankRec, and
then to the directory \SOFTRAK\ALLWKST. For example, if you installed
Adagio BankRec on network drive F:, go to F:\SOFTRAK\ALLWKST.

2) Find the file ALLWKST.EXE. Double-click this file to begin the workstation
setup installation.

3) The workstation setup install screen will appear, with the Welcome! dialog box.
From the welcome dialog, you can check to see if any of the modules installed on
this workstation need updating to current versions. Select either one Adagio
module to install, or select Install all Modules, which will install all available
modules on this workstation. Click Next.

4) If you choose to install all modules, you will be asked if you want to create a
backup and a program group for Adagio on your Windows start menu. Click
Next.

5) The final screen simply asks for confirmation and lists the options that you have
chosen to install. To install the program(s), click Install.

If you have chosen to install only one Adagio module, the program will take you
back to the Welcome screen when it is finished. If you have installed all available
Adagio modules, the program will display a list of the modules installed and from
there you can exit the program.

With a few exceptions, when you later upgrade an Adagio module,
when you open the module if the workstation install/update has
not already been completed, you will be told that the workstation
is not current and must be updated. This is referred to as the
AutoWorkstation Install. Press Next to complete the workstation
update.
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Check System Utility
There is a utility program to check the status of the Adagio products installed on a
workstation to determine if the workstation is up to date with versions of Adagio
products and related files installed on your server.

After installing the Adagio modules you can run the utility by selecting System
Status Check from the module's Help menu.

Initially, you will be asked if you wish to proceed. Indicate yes and the following
window will appear:

The utility will list any problems encountered or any updates needed to properly run
Adagio products.

CHKSYS also checks for correct "Opportunistic Locking" settings on the workstation.
It allows you to change to the correct settings without having to manually make
changes in the registry. Proper Opportunistic Locking settings are required at each
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workstation (and on the server) to ensure the integrity of your accounting data in a
multi-user environment.

Opportunistic Locking settings on Windows servers (but not
Novell) must be checked and set separately.

Novell Client settings are not checked or set by CHKSYS. This must
be done manually in the Novell Client properties. On older Novell
Client versions, set Opportunistic Locking to Off; on newer client
versions, set File Caching = 0 (Off).

The two buttons on the bottom, left corner of this utility serve the following
purposes:

Button Description

View Session Details This button calls up a list of the files, registry
entries, and applications that the Utility reviewed
during the system check. It also displays errors and
warnings.

Once you've displayed the results, note that the
location of a detailed history log is specified at the
bottom of the window, if you wish to review it at a
later time.

List Versions Use this button to display a list of installed Adagio
programs that are current and another list of those
that are not.

Check Lanpak Status This button will provide a summer of how many
LanPaks of each type are installed on your system.

This button is useful to confirm if an upgrade has
been successfully completed before or not.

Check System Utility
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Button Description

Check R/W Status Clicking this button will take you to another
window, where you can check all Adagio
directories for their read/write statuses; or you can
check a specific directory which you choose.

This button is useful if there are installation
problems and you need to ascertain whether the
user has appropriate read/write permissions or
not.

Check Lanpak Status This button will provide a summer of how many
LanPaks of each type are installed on your system.

This button is useful to confirm if an upgrade has
been successfully completed before or not.
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Upgrade Install
If you are installing an upgrade, you need to enter the serial number and install code
from the Upgrade Product Label that came with your upgrade (see the earlier section
on Pre-installation), or was provided in the email from Softrak Systems. A previous
version of the Adagio module should already be installed on your computer before
installing the upgrade. If a previous version is not already installed, you can still
install the upgrade. After entering the upgrade serial number and install code, you
will also have to enter the serial number and install code from your original version.

Please make sure you retain the Upgrade Product Label or email containing the serial
number and install code.

To install the upgrade, select the type of install you wish to run and go to the referred
page number for complete instructions.

• Standard Install, page 1-4
• Custom Install, page 1-12

Upgrade Install
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Service Pack Install
If you are installing the Service Pack you do not need to enter a serial number or
install code. A previous copy of the Adagio module must be already be installed, and
must be the same version as the Service Pack (e.g. 8.0B), before the Service Pack can
be installed.

To install the Adagio module Service Pack, run the Service Pack install program and
follow the instructions on the screen.

After installing the Service Pack, and depending on the version you were running
prior to installing it, a workstation install may be required at each station running the
Adagio module. To determine if a workstation install is required, start the Adagio
module at the station. The workstation install will be automatically started if
required.

If you are updating multiple applications at the same time, it may
be faster to run the All Workstation install to update all
applications at once on the station. Refer to the section on
"Installing on a Network" on page 1-19 for more information.

Service Pack Install
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Program Group Selection
During the install process, you may be prompted to select a program group:

This window allows you to indicate the program group to which the program icons
will be added, and it also allows you to create sub-groups. For example, if you want
all of your Adagio products to be under one start list item called “Adagio”, you
might enter Adagio as the program group, and type the name of the specific Adagio
program in the sub-group field.

We recommend that you accept the defaults in this screen. This will give you a single
entry called “Adagio” on the start list for the entire Adagio suite, as in the above
example. Below this item will be sub-menu entries for each Adagio program that gets
installed, such as Ledger, Receivables, and Payables, as well as direct shortcuts to
each module. Within each sub-menu, entries would appear to allow you to run the
program, to view Help, to work with the sample data, and so on. Your Start List item
would look as follows:

Adagio � Ledger � Adagio Ledger
Receivables Ledger Help
Payables Ledger Readme

Ledger Sample Data

Alternatively, you could leave the sub-group blank. This would allow for two other
schemes. For each program, you could call the Program Group: “Adagio Ledger”,
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“Adagio Receivables”, and so on. Your start list would contain a new entry for each
module. It would look as follows:

Adagio Ledger � Adagio Ledger
Adagio Invoices Ledger Help
Adagio Payables Ledger Readme
Adagio Receivables Ledger Sample Data

Or, if you leave the Program Group as “Adagio” and leave the sub-group blank, all
entries for all modules would be listed within the single start list entry. This list could
get quite long if you are installing several Adagio modules. Your start list would look
like this:

Adagio � Adagio Ledger
Adagio Invoices
Adagio Payables
Adagio Receivables
Ledger Help
Ledger Readme
Ledger Sample Data
Invoices Help
Invoices Readme
invoices Sample Data
Payables Help
Payables Readme
Payables Sample Data
Receivables Help
Receivables Readme
Receivables Sample Data
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Command Line Parameters
Adagio allows you to use command line parameters to start the program. Command
line parameters are set as properties for the program, and allow you to bypass certain
fields in the Open Adagio dialog box each time you start Adagio. The parameters are
as follows:

Parameter Description

/u Allows you to set a default user

/p Allows you to set a default password

/d Allows you to set a default data path

/e Allows you to set a default data extension

/t Allows you to set a default session date YYYYMMDD

Since command line parameters can bypass certain security functions such as user
identification and passwords, you must ensure that you are the only user on that
particular machine and that password security is not a concern in your office before
using command line parameters.

Setting Command Line Parameters
To set command line parameters:

1) Right-click the Adagio module icon on your desktop and then select Properties
from the pop-up menu that appears.

2) Click the Shortcut tab.

3) Click to locate your cursor at the end of the information in the Target field (the
drive and directory where you installed the Adagio module, and the name of the
program file).

4) Type in the desired parameter and then the default information for that
parameter. For example, to set a default user, type /uSYS. Do not leave a space
between the parameter and the default information.

5) Continue typing in as many parameters (with the associated default information)
as you require, leaving a space between each one. If you set all the parameters,
Adagio will bypass the Open Adagio Data dialog box entirely each time you
start up the Adagio module.
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You must use the /d and /e parameters together since they only function as a pair.
Therefore, if you intend to use one of these parameters, you must use both.

Using /u and /p in a shortcut is no longer necessary if you are using Adagio
versions 8.1B and higher. This has been replaced by the 'Remember user name' and
'remember password' features as seen on page 1-31.

Command Line Parameters
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Setting Up Data Sets
When you begin using any Adagio product for the first time, you will either have to
set up an existing data set for the first time, or create a new data set. To do this:

1) Start up your Adagio program. For this example, we’ll use Adagio Receivables.
When you start the program, the Open Data window appears:

2) Enter your User ID and Password. The default user ID is SYS and the default
password is SYS.

Enter the data path for the data files. Alternately, you can click the File folder
button to browse through existing drives and directories or you can click the
Directory button to see a list of previously opened paths.

Enter an extension which will be applied to all the data files you create.

By turning on one or both of the 'Remember' options on the Open
Data window, the user name and password can be remembered and
authenticated by the Windows user logging in to Adagio. This
allows you to default your Adagio user name or password by
logging into Windows (on the same workstation).

At time of writing, this function may not be available in all current
releases.

Click the Create button.
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3) The Data Creation window appears:

Select the drive, path and extension for your new data set. If other Adagio
databases already exist for the company, select the same path and extension. You
can create a new directory for your data set; see the following section on
“Creating a New Data Directory” for details.

Click OK to proceed. You will receive a prompt asking if you’re sure you wish to
create data at that location. Click Yes.

4) You may then be asked to indicate the location of some required program files.
One this information is entered for one Adagio database, it will be used for all
further Adagio products that use the same path and data extension.

5) If this is your first time creating or selecting this particular Adagio database, the
EZFile Directories dialog box will appear.

Setting Up Data Sets
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If you are running Adagio FX standard version (Simply Accounting
or QuickBooks), just accept the defaults and click OK.

This dialog box requires you to complete two fields. Adagio will attempt to
automatically select the locations of the program files discussed below for you.

Field Description

Currency path The currency path must contain currency files starting
with "MC" and having an extension of ".LD4". You
will find the currency files in the
\SOFTRAK\SYSTEM directory. Reinstall Adagio if
these files are not found in this directory.

If you are using Adagio with a multi-currency
database and have more than one company, you may
have a different set of currency files for each
company. These currency files may be located in the
company data directory or another directory other
than \SOFTRAK\SYSTEM. In this case, select the
path to the appropriate path to the currency files for
the company. Refer to the Adagio MultiCurrency
documentation for further details.

If you attempt to select a path in which the
above-mentioned files are not found, you will get an
error message. Select the path again using the browse
button.

EZTasks path All Adagio products must use the same EZTasks path.
If this is not correct in a multi-user environment, data
corruption may result. We recommend pointing all
Adagio products at your \SOFTRAK\SYSTEM
directory.

The EZTasks.ld4 file will be created by Adagio if it
does not exist. You may receive a message indicating
that the file does not exist, but will be created. Click
OK to proceed.

6) When you're finished entering these files, click OK. Your data will be set up
according to your specifications.
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If the wrong paths are chosen, delete the file ADSPROF.xxx (where
.xxx is your company database extension) from your data directory.
Start the Adagio module and open the database. The EZFile
Directories dialog will be displayed. Enter the correct path
information.
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Creating a New Data Directory
Adagio modules allow you to create a new data directory when you are creating a
new data set. In the data creation window:

Simply type in the new data path and extension you desire before clicking OK. For
example, if you want to add a data set in a new subdirectory called DATA under
C:\SOFTRAK\APWIN, a subdirectory that does not already exist, you would type:

C:\SOFTRAK\APWIN\DATA

in the Data Path field.
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Assuming you wanted the extension .DAT, you would type

DAT

in the Extension field. When you click OK, you will receive the following prompt:

Simply click Yes to create the new directory and data set.
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Logging into Adagio
The Open Adagio Receivables Data dialog box appears each time you start Adagio
Receivables.

Adagio Receivables comes preloaded with the user ID of SYS and a password that is
also SYS. Unless this is an upgrade from an earlier version of Adagio Receivables,
you must log in with this user ID and password the first time Receivables is used.
This is the default Adagio system administrator user ID. It cannot be deleted but it
can be changed. Since it provides access to all Adagio Receivables screens and
functions, you may want to change both the system administrator user ID and
password for security purposes. Please refer to page 3-56 or your online Help for
instructions on changing the user ID and password.

The following table describes each field:

Field Description

UserID /
Password

Each Adagio user should be assigned a user
identification code. Refer to page 3-56 for more
information about setting up users..

Remember user name Turn this option on to have the Adagio user name is
remembered and authenticated by the Windows user.
This allows you to default your Adagio user name by
logging into Windows (on the same station).
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Field Description

Remember password Turn this option on to have the Adagio user password is
remembered and authenticated by the Windows user.
This allows you to default your Adagio password by
logging into Windows (on the same station).

Last Access Displays the session date used when you last accessed
or ran the program.

Date This is the session date. It defaults to the current system
date. If you need to change the date, use the calendar
button to the right, or type in the desired date.

NOTE: If you want to log in to Receivables using a session
date within the month and year that initially display in the
Date field, all you need do is type one or two numbers
representing the date you want to use. (Eg. If date displayed
initially is 12/12/2008 and you now want to log in using
12/15/2008, all you need do is type 15 in the date field. The
month and year will populate automatically.)

You are able to use the one or two-character date entry
method in any 'date' field within Adagio Receivables
and many other modules.

Data path Enter the drive and data path for your company's data
by clicking once in this field and typing the information
in, or by clicking the Browse button and selecting the
correct drive and data path from the Data Selection
dialog box that appears.

There is another button to the far right of this field.
Click this 'multiple folder' button to view a list of
Previously Opened data sets. This feature is especially
helpful if you are maintaining multiple data sets (e.g.
Adagio Receivables data for multiple companies). If
you wish to use one of these previously-opened data
sets, simply click the desired Company Name to select
it, then click Open.

NOTE: Adagio modules can remember what datasets have
been accessed by each user of that module. The first time each
user logs in to a module, they will be prompted to respond
whether or not they want Adagio Receivables to do this.

Logging into Adagio

Page 1-38 Adagio Fundamentals



Field Description

Extension Enter the extension used by your company's data here.
For example, to use the sample data, you would enter
SAM here.

When you have entered all fields, click Open.

It should be noted that, at time of writing, not all features are
available in all current modules.
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Chapter 2

User Interface

Softrak’s Adagio products all have an easy to use interface, designed to reduce your
learning curve with the similarities throughout the suite of products.

Taking you on a quick tour of the user interface, we’ll start by looking at the
windows and forms in the Adagio suite, using Adagio Payables as an example.
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Main Window
The main window in Adagio Payables is straightforward and easy to use.

The Title Bar indicates which product you’re using. In the above example, it’s Adagio
Payables.

The remaining features on this screen require further examination.

The Menu Bar
The Menu Bar is each product’s command center. Each option on the menu bar calls
up a drop-down menu of commands that you can use to:

• set up your company profile and tables,
• access the specification editor (for Adagio products except Adagio Ledger) to

create and modify specifications,
• create, edit, print, and post documents,
• print many useful reports, and call up the product’s Help system.
• Access other Adagio modules directly from the Adagio menu.

Main Window
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The Button Bar
Each product puts several commonly used commands on a Button Bar, or toolbar,
that remains on screen at all times unless you choose to deactivate it. Each command
is represented by an individual button, and each button displays a graphic that
visually describes the command. You activate Button Bar commands by clicking the
appropriate button one time with the left mouse button.

The Button Bar eliminates some of the steps needed to activate the commands
included on it, and because of this, it can greatly speed up your work.

You can hide the Button Bar from view if you prefer not to use it. To do so, select
Options from the File menu and click the Toolbar field once. Repeat this process to
turn the Button Bar back on again.

This action only turns off the toolbar in the main window. If you
want to hide the Designer toolbar, you must do so within the other
application itself. If you have set your screen display to 640 x 480
pixels, turning the Button Bar off will afford you a little more space
for your windows.

The Status Bar
The Status Bar at the bottom of the main window displays valuable information to
help you use each product more efficiently.

Depending on what you are doing in the program, or where your cursor is on the
screen, the status bar will display certain pertinent pieces of information that you
may find useful.

• Button Bar functions. When the cursor is over a button on the Button Bar, the
Status Bar displays a short description of the button’s function. This
information appears on the left side of the Status Bar.

• Menu command descriptions. When you highlight a menu command, the
Status Bar displays a short description of the command. Try clicking the Edit
menu and highlighting the Company Profile command by moving your cursor
over it, or by pressing the Down Arrow key three times. You will notice that
the left side of the Status Bar displays a brief explanation of this command,
such as: Edit the company profile.

The Button Bar
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On the right side of the Status Bar, you are also given the following pieces of
information:

• the company name for the data set you are currently working with,
• the date and time the last integrity check was run,
• the user i.d. information, and
• the date and time.

If desired, you can hide the Status Bar from view. To do so, select Options from the
File menu and click the Status bar field once. Repeat this process to turn the Status
Bar back on again.

This action only turns off the Status Bar in the main window. You
cannot deactivate the Designer’s Status Bar. Because screens appear
differently on monitors with different size and display settings, it is
recommended that you turn the Status Bar off if your screen display
is set to 640 x 480 pixels.

The main Designer window for each product is set up in much the same way, with a
title, menu, button, and status bar.

The Button Bar
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Cursors
Each product uses a similar set of cursors to aid you in your work. We’ll quickly
explain what the most commonly seen cursors do, and when they will appear.

The Arrow cursor is the primary cursor. This cursor is used for making menu
selections, working in dialog boxes, working with scroll bars, etc.

The Double-Arrow cursor is a resizing cursor. The cursor changes to a number of
different double-arrow cursors whenever it is over a resizing handle on a screen,
dialog box, bit-mapped graphic, line, shape, text block, or field.

The section resizing cursor appears when you move your cursor between the column
headings in any table-format windows (such as Open Batches or the Detail tab of an
open check). You can use this cursor to resize the columns, change the order of the
columns, or to call up the Column Editor. (See the section in The Column Editor later
in this chapter for more information.)

The Hourglass cursor is the cursor that appears whenever Adagio is processing a
command you have selected. When the hourglass is visible, you cannot select any
other commands or carry out any further functions.

The Insert cursor appears when you are editing fields. When it is flashing in a field,
you can edit that field by typing in the desired information.

The Crosshair cursor is the cursor that appears whenever you are inserting a section,
field, label, memo, line, shape, or bitmap onto a specification in the Designer.

The Drag and Drop cursor is available in the Designer whenever you are dragging an
item over an area where it can be dropped. It also appears when you have two
windows open in a module (such as Open Batches and Archive Batches), and are
dragging a batch or check to another location to copy or move it.

The Drag (or Stop) cursor appears in the Designer whenever the item you are
dragging is over an area where it cannot be dropped.

Cursors
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Adagio Menu
If you have other Adagio programs installed on your system, you may notice a new
Adagio option on the main menu bar. This menu allows you to quickly open any
other Adagio program while in the current program. For example, if you’re working
in Adagio Receivables and you have Adagio Invoices as well, you can just go to the
Adagio menu and switch over to Adagio Invoices quickly, to work in the same
database without having to log in again.

You must have data from these programs present in the same directory as the current
Adagio program or they will not show up on the Adagio menu. When you open
other programs from the Adagio menu, the same data set and user ID will
automatically be used. This saves you from having to log in to the other programs.

Adagio Menu
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MDI Interface
The MDI or Multiple Document Interface is a feature that permits you to open more
than one window at a time. Each function has its own window; for instance, in
Adagio Checks, the Open Batches function is one window, while the Company
Profile and Vendor List are separate windows. The ability to open multiple windows
at one time gives you extra freedom as you work. There are many useful applications
for this feature, such as the following.

Example 1
If you are creating a check in Adagio Checks’ Open Batches function and you realize
that you need to add a new distribution code in order to complete the check, you can
make excellent use of the MDI interface. Rather than exiting the check, adding the
new distribution code, and then returning to insert the detail which required the new
distribution code on the check, you can simply open the Edit | Distributions function
in another window.

While still in the check screen, select Distributions from the Edit menu, add the
missing distribution code, and then click on the Title Bar of the check you were
creating to activate it (bring it to the front of the screen) and insert the detail with the
new distribution code on your check. You will find that using the MDI interface in
this kind of situation speeds up your check entry process considerably.

Example 2
With both the Open Batches and Archive Batches windows open in Adagio Invoices,
you can click on an open batch that you wish to archive and, while holding the left
mouse button down, drag the open batch to the Archive Batches window. (You may
have to tile or manually move one of these windows so you can see both batch lists at
one time.) When you release the left mouse button in the Archive Batches window,
the Archive dialog box appears.

You should be aware, however, that there are certain situations in which you cannot
open another window. Sometimes you are required to complete what you are doing
and exit out of that dialog box or window before you can open another window.

A final point about the MDI interface. If you do have multiple windows open, you
can go back and forth between them by clicking the Title Bar of the window you
want to work in next. By doing so, you are simply activating that window and
pulling it to the front of the screen, over top of the other windows you have open.
You can also tile windows using the commands on the Window menu, or manually
move and resize them so that you can see the information in all of your open
windows at one time.

MDI Interface
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Running Multiple Instances
Adagio allows you to run multiple instances on the same station. This allows sites
with multiple companies to open, for example, Adagio Ledger for more than one
company at a time on the same computer. It also benefits single company sites where
you want to perform two or more functions at the same time, such as entering
batches and printing reports. Each additional instance uses a license. Therefore, an
Adagio Lanpak must be installed to use this feature.

Notes on Multiple Instances
• Although you can run multiple instances of Adagio applications, the name of

the Adagio application you’re currently running is not included on the Adagio
menu (see the Adagio Menu topic earlier in this chapter for more information).
You must open other instances of the currently opened Adagio application
from your Start menu or a desktop shortcut.

• When running multiple instances of Adagio applications, the program adds an
instance number to the window titles, such as "Adagio Ledger (2)" for the
second instance, and so on.

• To help you differentiate between the databases you have open in the multiple
instances of Adagio, you may wish to take advantage of the background color
option in the Company Profile. This option allows you to set a different
background color for the main windows in your Adagio application, for the
individual databases you're working with.

The background color must be set in each individual Adagio
application, for each database.

• Specification Designers and Financial Reporter: From each copy of Adagio
that you are running, you can only start one instance of the Specification
Designer or the Financial Reporter from the Maintenance menu. However, this
isn't a problem since you can open multiple specifications or Financial
Reporter files within that one instance of the designer or Financial Reporter
application.

If you are running two or more instances of Adagio Ledger on the same
database and wish to print documents with the Financial Reporter in each
case, only one instance of the Financial Reporter will be opened. However,
you can open multiple specification documents for printing or select to Print
Financial Statements from Ledger's Reports menu.

Note that you can't open the Financial Reporter from the Maintenance menu if
the Financial Reporter is already open by any instance of Adagio Ledger,
whether to print or to maintain reports. Furthermore, if the Financial Reporter
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is open to maintain financial specifications, other instances cannot open it to
print or maintain. There are no restrictions if you are running two instances of
Adagio Ledger on different databases.
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Chapter 3

Common Features

The Adagio suite of products share some common features that are intended to save
you time and to prevent entry errors. We’d like to familiarize you with some of these
special features.
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Security: Users and Groups
Adagio includes a Group and a User Setup function that allows the system to
prevent unauthorized users from entering the system and restricts specified users
from accessing certain areas of the system.

To do this, you must first set up user groups, which define what parts of the program
the users are allowed to access.

For example, if you are setting up user groups in Adagio Invoices, you may want to
create a group for users who can enter invoices, but are not allowed to edit the
Company Profile or change the General Options. You might also want to allow only
senior staff members to access functions such as the User Setup and Group Setup
functions.

User groups must be added in each Adagio application you use, for each company
database. If you use “User Group A” in Adagio Invoices, you must also create a
“User Group A” in all other Adagio programs that will be accessed by users who are
assigned to that group. If a “User Group A” does not exist for an application, and a
user assigned to that user group attempts to log in to the application, an error
message is displayed and the user will not be logged in.

You will also want to disable the File | Group Setup menu choice for most groups,
to prevent users from editing their own group to allow themselves access to
restricted menus.

You cannot disallow the system administrator (SYS) from accessing
any functions. This is a safety measure in case you accidentally
disallow everyone from a particular function.

Once you’ve set up your groups, you can proceed to adding individual users,
assigning them to the various security groups you’ve set up as you do so.

Security: Users and Groups
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Group Setup

Creating a New User Group
To access the user group list, select Group Setup from the File menu. This screen
lists all the user groups currently set up on your system.

To create a new user group, click the New button. The Edit Group window will
open. In some Adagio programs, this window will have a single screen for setting
Menu Access permissions; in others, it will have two or more sections or tabs. These
screens / tabs will be discussed in the following sections.

Once you have added all your user groups, you can then add users to the system and
assign each user to a user group. See the section on setting up users for more
information on how to do this.

Adagio modules at the version 9.0A level; or higher also have a
Listing button on the Group Setup window. The Listing button
evokes the Print Security Groups window from which you can print
the security options for a range of Groups. You can also specify
whether to print all possible items each group could have access to
or only those items each group has access to.

Security: Users and Groups
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Menu Access
This screen allows you to specify a group code and select which menu options you
want the group to be able to access.

Complete each field according to the following table:

Field Description

Group Enter a code for the new user group.

If you want to view a list of user groups currently in use,
click the Finder button on this field.

Description Enter a description for the new user group.

Permit all If you want users assigned to this group to have access to
all functions of this Adagio program, turn this box on.

If you want to allow the users in the group to have access
to most functions, turn this box on. This selects all the
options. You can then deselect options to bar access.
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Field Description

Expand all If you click this box, the “Menu access” tree will expand to
display all options.

Menu Access Select which functions you want to allow users access to,
and deselect the functions you want to bar their access to.

When you disallow a user group access to a function, it
will appear greyed-out in the menu bar when they log in.

Additional Options tabs
When present, the additional option tab(s) gives you extra options which control the
access privileges for users in this group.

The fields on this tab(s) vary depending on the Adagio program you’re in. Please
refer to the online Help documentation for the module you are using for detailed
information.

Security: Users and Groups
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User Setup
For the Adagio programs to differentiate users, you must add each user to the
system. When you do this, you can also specify a user group for each user.

Adding Users to the System
1) From the File menu, select User Setup. The User Setup Maintenance window

appears. All current users on the system are listed in this window.

2) Click the New button to add a new user. The Edit User dialog box appears.

Security: Users and Groups
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3) Complete each field according to the following table:

Field Entry

Initials Enter initials or some other form of identification for the
user. Up to three alphanumeric characters, symbols or
spaces are allowed. This will be the User ID, which is used
when logging in to the system. This field cannot be blank.

Name Enter the user’s name. Although this field is optional, it
can make it easier to identify users in the list.

Group Click the Finder button and select a user group for this
user. The user group defines the access privileges for the
user. An entry is required in this field, except for the
system administrator since the system administrator
cannot be denied any access privileges.

Password Enter a password for the user. Up to eight alphanumeric
characters, symbols or spaces are allowed. This field is
optional, but it is recommended to maintain security.

Edit columns Check this box if you want the user to be able to access the
Column Editor.

See the Adagio Fundamentals manual for more information on
the Column Editor.

Edit GridView Turn this option on if you want the user to be able to edit
Views in Adagio GridView. If this option is not turned on,
the user will only be able to open Views, but will not be
able to edit or create Views.

This option applies only to Adagio GridView users, and
affects only the launching of Adagio GridView from the
Adagio menu within the Adagio module.

Security: Users and Groups
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Field Entry

Enable SF Export Turn this option on to allow the user to export Smart
Finder (F6) results using Excel Direct.

If the option is turned off, the Excel Direct button will be
disabled on Smart Finder (F6) windows.

NOTE: If a change is made to this option while the user the
change is being made for is logged in to Adagio Receivables, the
change will not take effect until that user logs off then back in
again.

At the time of writing, this feature may not be available in
all current modules.

Enable SF Printing Turn this option on to allow the user to print Smart Finder
(F6) results.

If the option is turned off, the printer button will be
disabled on Smart Finder windows.

NOTE: If a change is made to this option while the user the
change is being made for is logged in to Adagio Receivables, the
change will not take effect until that user logs off then back in
again.

At the time of writing, this feature may not be available in
all current modules.

4) Click OK to save the user when you have completed all of the fields. The user
will be added to the list.

Editing a User’s Information
Once a user is added to the system, you can change the user’s information, but you
cannot change the user’s initials. To edit a user’s information, select the user in the
User Setup Maintenance window, then click the Edit button.

If you want to change the user’s password, you must first check the Change
password box. The password field will then become active. This is a safety measure,
so that the password cannot accidentally be altered.

Click OK when you are finished, or click the Cancel button to discard any changes
you made.
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You cannot change a user’s initials (User ID). If you need to change
a user’s initials, you must delete and then recreate the user with the
new initials. To delete a user, select the user in the User Setup
Maintenance window, then click the Delete button.

Active Users
The Active Users option on the Help menu will display a list of all users who are
currently working in the currently-opened data set in any Adagio application. This
may be useful in cases where Adagio cannot complete a function until all other users
have exited a data set.

Security: Users and Groups
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Setting Currency Codes
All accounting software applications using a database must use the same currency.
Therefore, if you use Adagio to access a database that uses a different currency than
your home currency, you must set the currency Adagio uses to access that database.
Adagio allows you to set a default currency code, create a new currency code or edit
an existing code.

Setting the Currency Code
You can set Adagio applications to use any currency code in your system.

To set the default currency for a database:

1) Select Currency Codes from the File menu. The Edit Currency Codes screen
appears. Three currency options are listed.

2) Select the default code from the pull-down list in the Default currency field.

Setting Currency Codes
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Adding a Currency Code
If a database uses a currency that does not exist in your system, you can add the
currency.

To add new currency codes:

1) Select Currency Codes from the File menu. The Edit Currency Codes screen
appears.

2) Click the New button. The Edit Currency Code window appears.

3) Complete the following fields in the Edit Currency Code window:

Field Entry

Currency code The Finder shows already-used currency codes. Enter a
new code here.

Description Enter a description of the currency code.

Symbol Enter a symbol for the currency code.

Position of symbol Select from the drop-down list a description of the position
of the currency code symbol in a numerical display.

Negative number
format

Select either a leading-, a trailing- or () to indicate a
negative number.

Thousands symbol Select either a comma, period or space as the separator
between thousands in a numerical display.

Setting Currency Codes
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Field Entry

Decimal symbol Select either a period or comma as the separator between
whole numbers and decimals.

Number of decimal
places

Enter the number of decimal places to include in the
display.

Display format This field simply illustrates the effects of your display
choices on a sample number, and cannot be edited.

4) Click OK to save the currency code once you have completed all of the fields.
The currency code will be added to the list. You may partially complete the
screen or edit some entries later. Click Cancel at any time to exit the Add
Currency Codes window without saving any of the information you entered.

Copying a Currency Code
To copy a currency code:

1) Select a currency by clicking on it.

2) Click the Copy button. The following screen appears.

3) Enter a name for the new currency code. The new code will use the same
information as the selected code.

Setting Currency Codes

Page 3-62 Adagio Fundamentals



Editing a Currency Code
You can edit the information for any currency code in your system at any time. To
edit an existing currency codes:

1) Select Currency Codes from the File menu. The Edit Currency Codes screen
appears.

2) Select the currency code you want to edit by clicking on it.

3) Click the Edit button. The Edit Currency Code window appears.

Setting Currency Codes
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4) Make the required changes. Refer to the section earlier on Adding a Currency Code
for detailed descriptions of each field.

5) Click OK when you have finished making changes. Click Cancel at any time to
exit the Edit Currency Codes window without saving any changes.
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Workstation Options
All Adagio programs have a Workstation Options function off of the File menu. It
allows you to default the printer to be used for reports and specifications, if the
particular module uses specification, as well as to set report preview options.

Field Entry

Report Preview
Options

Enter the zoom factor you want used as the default when
you preview reports on this workstation.

Additionally, select Full screen to have the Preview
window itself use your entire screen size. Select Partial
screen to have the Preview window use part of the screen
only.

Report printer Allows you to select a specific printer for reports. Click the
down arrow button to select from the list of printers
installed in your system.

All of the Adagio programs that use the Designer (see
Chapter 9) to print invoices, checks, orders, and so forth,
will also include a similar option which allows you to
specify the printer that should be used for those special
documents.

The options you set here are saved by workstation rather than by data set. This
allows individual workstations to set the options that will work best for them -- such
as different default printers.

Workstation Options
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User Preferences
User preferences are used to set up Adagio user specific preferences for various
report, display and other options in the module.

If no individual user preferences have been set up while logged into
the particular module as that Adagio user, all preferences will use
the preferences originally set for the Adagio System Administrator,
user SYS.

General Options
Options ‘By Application’ are user specific for all datasets using the particular
module/application. Options ‘By Company’ are stored for a single dataset.

The exception is the Implied decimal option, which is a global setting that affects all
Adagio modules that support the function and all datasets used by the user.
Particularly within the General preferences, some of the options presented will vary
depending on the module they are stored in.

User Preferences
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When the Set All Users button is activated, all Adagio users’ preferences for this
modules are reset to those of the Adagio system administrator. However, users
having access to User Preferences may still make changes to their own preferences.

The Set All users button is only visible to the Adagio system
administrator, user SYS.

The standard options provided across the Adagio suite of programs include:

Field Entry

Toolbar Displays the toolbar at the top of the Adagio program’s
screen.

Toolbar text Includes descriptive text for each function on the toolbar.

Toolbar raised Displays each function on the toolbar as a distinct button.

Status bar Displays the status bar at the bottom of the Adagio
program’s screen.

Calculator button If you wish to add a Calculator button to your toolbar, turn
this option on. This will enable you to launch to Windows
calculator from the toolbar at any time.

Save window
position

Causes a window to open in the same location it was when
you last opened it.

Save window size Causes a window to open the same size it was when you
last opened it.

Auto-advance
smart finder

When this option is turned ‘on’, the next time you access
the Smart Finder on a grid, the focus will be on the next
record in the grid that matched the criteria.

When the option is ‘off’, the next time you access the Smart
Finder on a grid, the focus will be on the search criteria
value field.

NOTE: Use F6 in the Smart Finder window to toggle the focus.

User Preferences
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Field Entry

Implied decimal NOTE: This option only is a global option that affects all Adagio
modules that support the function and all datasets used by the
user.

If you turn the option on, Adagio will assume you want a
decimal automatically entered before the last two numbers
(eg. typing 400 in a numeric field and tabbing to the next
field will result in the number being changed to 4.00;
typing 400.00 and tabbing to the next field will leave the
number as 400.00).

NOTE: Having Decimal entry turned has no affect on fields
containing a % symbol. For example, typing 100 and tabbing out
of the % field will not make the value become 1.00%. It will
become 100.00%. If you would like the value to be 1%, type
either 1.00 or 1 in these field types.

Nor does it have any affect on Optional Unit fields 1 and 2 that
are defined in the Company Profile ‘Optional field titles’ section.

Alphabetically
sorted field list

Turn this option on to have field lists within Edit Grid
Filters and the Column Editor sorted alphabetically.

On start-up Turning any of these options on will Open the selected
function window immediately after logging into the
Adagio module and/or begin running the selected
function.

For example, if Process Imports is turned on, an Import
template has been set up to auto-import and an import file
for the template exists, when a user logs into the Adagio
module, they will be prompted that transactions exist and
asking if they want to proceed with the import.

Responding Yes will begin the Auto-Import.
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In addition to these standard options that appear across all Adagio programs, some
Adagio modules have program-specific options. The commonly seen additional
options are:

Field Entry

Allow faxing Enabling this option produces a Fax menu option on the
menu bar. The Fax feature allows you to send invoices or
reports directly to fax. See Appendix C for more
information on the Fax feature.

Allow emailing Turn this option on if you wish to allow emailing of letters
and statements from the Reports menu. The Email menu
will not appear if this checkbox has not been turned on.
See Appendix D for more information on using this
feature.

Verify user groups While most Finder fields are verified if the Field
verification checkbox is turned on, the User Groups and
Report Groups functions are verified separately. If you
want to verify that the user group assigned to a user is
valid each time you work with a user file, you must turn
this option on.

Verify report
groups

While most Finder fields are verified if the Field
verification checkbox is turned on, the User Groups and
Report Groups functions are verified separately. If you
want to verify that the report group entered for a customer
is valid each time you work with a customer file, you must
turn this option on.

Another common program option is an “auto add” feature, for Adagio applications
that require the entry of detail lines to invoices and so forth. When you turn any auto
add feature on, such as the Auto add batch entry details in Adagio Ledger, you are
potentially saving yourself time, because as you are in the detail entry mode, clicking
OK or Cancel on the batch entry line detail dialog will allow you to continually add
details without actively calling up a new detail dialog each time. It simply
automatically calls up the detail dialog, and when you’re finished entering your
details you can click Cancel to exit out.

Additionally, when Remember batch entry fields is on, Adagio remembers specific
fields during the creation of new entries. Which fields are remembers can vary from
one module to the next.
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Appearance Options
Appearance preferences are used to set up Adagio user specific preferences for
various display options.

If no individual user preferences have been set up while logged into
Adagio as that Adagio user, all preferences will use the preferences
originally set for the Adagio System Administrator, user SYS.

Options ‘By Company’ are stored for a single dataset for each user.

When the Set All Users button is activated, all Adagio users’ preferences for this
modules are reset to those of the Adagio system administrator. However, users
having access to User Preferences may still make changes to their own preferences.

The Set All users button is only visible to the Adagio system
administrator, user SYS.
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The standard options provided across the Adagio suite of programs include:

Field Entry

Color Background Turn this option on if you want to set a different
background color for the main windows of the Adagio
module. The background color you choose is saved with
this database, and so each time you open this database the
same background color will be used.

This is useful if you work with multiple Inventory
databases and want an easy, visual way to separate them.
Setting a different background color for each one allows
for that visual differentiation.

When you turn this option on, you must then click the
Background button and select a color from the pop-up
window that appears.

Define image or
text properties

You may elect to have a particular graphic and/or text
display on the main screen of this module each time you
access this company’s data.

Image Properties

Path Enter full path and filename of or use the Browse button to
drill down to the graphic/image file you wish to use for
this dataset. Once selected, the image will display in the
image box below the path.

Display Options This field only displays when Image is selected. Choose
one of the following options for how you want your image
to be displayed on the main Adagio window:

Stretch to fit - Use this option to ‘stretch’ the image over
all of the Adagio Inventory main window.

Center - Use this option to ‘center’ the image horizontally
on the main window.

Maintain aspect
ratio

Use this option in conjunction with Stretch to fit. When
used, the image may not stretch horizontally to fit the
entire Adagio module's main window. However, the
image will no longer appear to be ‘stretched’ either.

NOTE: This option is inactive when Center is selected.
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Field Entry

Scale image This option may be used in conjunction with the Center
option. Use it to scale the image size up or down so the
image appears smaller or larger.

NOTE: This option is not active when Stretch to fit is used.

Scale ratio Enter the ratio the image is to be scaled to, eg. 65%.

Text Properties

Text box You may elect to have a particular graphic and/or text
display on the main screen of the module each time you
access this company’s data.

Position Select the screen position you want the text to be anchored
to — Top Left, Top Right, Bottom Left or Center.

NOTE: If an image is also used and Center is selected, the text
will appear in the middle of the image.

Font Use this button to select the font, font style, point size and
attributes of the font used to display the text entered. The
Font button invokes a standard Windows font format
window.

Report Options
While Workstation Options (see page 3-65) are used to define printer and print
preview options, Report Options within User Preferences are used to define what
options should print on reports and the format they will be printed in. Report
Options are also used to define certain report print dialog options, as well as the
print to file defaults.

When the Set All Users button is activated, all Adagio users’ preferences for this
modules are reset to those of the Adagio system administrator. However, users
having access to User Preferences may still make changes to their own preferences.

The Set All users button is only visible to the Adagio system
administrator, user SYS.
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Report Options are user specific and dataset specific when Adagio is used.

The standard options provided across the Adagio suite of programs include:

Field Description
Remember report
settings?

The print options you select on report dialogs can be saved
and used as the defaults the next time the report is printed.
The options are saved by company, so if you set different
options for different datasets, they will be saved
accordingly.

To have your report settings saved, you must turn the
Remember report settings option on.

Report settings are only saved if you print or preview the
report. You cannot simply open a report dialog, change the
settings without printing or previewing, and have those
settings remembered for the future.
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Field Description
Close report dialog
after print?

When this option is turned on, the report print dialog
screen will close automatically after the report is printed.
However, if you use the Preview button, you will still be
returned to the print dialog screen when previewing is
finished.

Date format
(Header/Footer)

Indicate the date format to use on your reports. M stands
for month, Y for year, and D for day.

Date format
(Detail)

Indicate the date format to use in the details on your
reports. M stands for month, Y for year, and D for day.

Time format Indicate the time format to use on your reports. H stands
for hour, M stands for minutes. Use tt to indicate the
position of am/pm.

AM/PM format Select a format for the am/pm indicators.

Show group tree in
preview

Select this box if you want a group tree displayed in the
report preview. You can use this group tree to quickly find
account or department codes in a report preview.

Show parameters
on all pages

Select this checkbox if you want to include a description of
parameters on all pages of a multi-page report.

Show footers Click this box on if you want footers in your report.

Shade header/
footer

Click this box on if you want headers and footers shaded
with the color selected below.

Shade subtotals Click this box on if you want subtotals shaded with the
color selected in the field below.

Shade color Select a color for shading subtotals, headers and footers.

Default print to file
format

When you print reports, you have the option to print to
file. In this field, you specify the file format you would
normally use when printing to file. For example, if you
normally would want to open the printed data in Word,
select Word. If you sometimes put reports on a company
intranet, you might select to print to HTML format instead.

This is only a default; the Print Destination file format can
be changed for specific instances of printing to file.
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Field Description
Default print to file
path

Enter the path to the folder you want to store Inventory
reports that have been printed to a Print Destination of
File.

Exclude ranges NOTE: This option is only active if Remember report
settings? is turned on.

If Exclude ranges is also turned on, then any field range
(including dates) will not be remembered by Adagio.
Other report settings, such as Active only?, will still be
remembered.
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Finders

Standard Finder
Each product includes a Finder feature to help you quickly look up coded values.
This feature is useful for finding codes and account numbers while you are
performing an accounting function. In fields where the Finder is available, a small
button with a picture of a magnifying glass will appear to the right of the field.

To activate the Finder, click the button once. Alternatively, you can press the F5 or
the Down Arrow key to call up the Finder window. The program will call up the
pertinent information for that field. If you know part of the code, you can enter it and
the Finder will place you “close” to the code you require. For example, when you are
creating a check in Adagio Checks, the Finder is available in the Vendor number field
on the Header tab. Just click the Finder button and a list of possible vendor numbers
will appear.

Scroll through the list using the scroll bar down the right side of this list.
Double-click the desired vendor number (Code) and Adagio Checks will insert that
number into the Vendor number field.

Each Adagio product also includes a Smart Finder that allows you to search for
values (such as names, descriptions, cities, postal codes, etc.) in certain fields. Access
the Smart Finder by pressing F6 in any field that has Finder capabilities.

Pressing F5 will also activate the Finder in many “grids” to select customers and
vendors.

Finders
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You can press Ctrl+F5 to recall the last item selected in any Finder
field. This will work across all Adagio products that include this
feature.

The Column Editor is available from the Finder, for customization
of the Finder results. See Chapter 5 for more information on the
Column Editor.

The Smart Finder
The Smart Finder gives you the ability to conduct a search of the current database.

When you click the regular Finder, it displays a standard set of information for each
record on file, such as the customer code, name, address, and credit limit.

The Smart Finder, on the other hand, is essentially a search function. You can search
for a customer on the basis of a contact name, for example, rather than being limited
to the standard customer code list. Any field or column displayed in the Smart
Finder grid may be searched for.

To use the Smart Finder, press F6 in any field in which the normal Finder is available.
Or, you can access the Smart Finder simply by double-clicking in the field itself.

You can also press F6 while in any grid or list that includes a Find button (such as the
Edit Accounts list or Customers list), to bypass the standard Finder that appears in
the Find window and directly launch the Smart Finder.

Finders
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You can also access the Smart Finder from the regular Finder
window by pressing F6.

Use the four fields in the bar across the top of the window to enter your search
criteria.

Select what you want to search for in the first field (eg. Customer Number, Name,
Address, etc.) depending on the fields or columns displayed on the grid.

In the next field, select your preferred search option. Your options are:

Containing, where the search will turn up all records wholly consisting of or
containing a certain string in the selected field. To illustrate, if you selected Cust # as
the field on which to search and entered 345 as the value for the search, the
Containing operation might turn up customers 12345, 23456, or 34567.

Sounds like, where the search will turn up all records that sound like the string
entered as the value.

In the range of, where the search will turn up all records that fall within a certain
range of values.

Equal to, where the search will turn up only the transactions in which the selected
field is exactly equal to the indicated value.

Not equal to, where the search will result in any records that do not contain the
indicated value in the selected field.
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Less than, where the search will turn up all records in which the value in the selected
field is less than the value entered.

Greater than, where the search will turn up all records in which the value in the
selected field is greater than the value entered.

Greater than or equal to, where the search will turn up all records in which the value
in the selected field is greater than, or the same as, the value entered.

Less than or equal to, where the search will turn up all records in which the value in
the selected field is less than, or the same as, the value entered.

In the third field, enter the value for which you wish to search. For example, if you
wanted to search for a customer with a particular postal code, you would enter the
postal code in the third field.

If necessary use the fourth field to specify a boolean operator (such as AND, OR,
AND NOT or OR NOT) and create another row of criteria to be met by the search.
Remember that AND operators are used to narrow the scope of the search results;
whereas, OR operators are used to broaden the scope fo the results returned.

Click the Find button or press Enter when you are ready. If items are found, they
will be listed in the grid below. Double-click the item you want to select the field to
be used.

Whether the focus (highlighting) is in the criteria or in the results
grid depends on the Auto-advance smart finder setting in your User
Preferences - General options (see page 3-66). You can use F6 in the
Smart Finder window to toggle the focus.

Persistent Results
The results from the Smart Finder are also persistent. This means that you can
conduct a Smart Finder search, select an item from the result list, and then return to
the list by simply pressing F6 again. There’s no need to run the search over again.

Additionally, the results remain persistent throughout the Adagio product you’re
working in. If you conduct a search in one function, enter another function, and call
up the Smart Finder again, the results of the last search will be displayed again.

These time-saving measures will allow for less time spent conducting searches in the
Smart Finder.
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Common Features Page 3-79

Note



Printable Results
If you want to print the results, just click the Print button to the far right of the search
fields.

If the Printer button is greyed out, you have not been granted User
Security access (see page 3-56) to use this function. See your Adagio
system administrator.

The default printout will include all of the fields displayed in the Smart Finder.
However, you can also use the Column Editor to specify which fields you want
included on the printout, in what order the fields should appear, and so on. For
information on using the Column Editor, see the Adagio Fundamentals manual.

Exportable Results
Using the small Excel Direct button to the right of the search fields, Adagio allows
you to export your SmartFinder results directly to a blank Excel spreadsheet. A new
instance of Microsoft Excel will be opened and the SmartFinder results will be
written to the spreadsheet with Excel's default new document name. You can then
manipulate the data as you would in any Excel spreadsheet and save the spreadsheet
if you like.

If the Excel Direct button is greyed out, you have not been granted
User Security access (see page 3-56) to use this function. See your
Adagio system administrator.

The Column Editor is available from the Smart Finder, for
customization of the Finder results. See Chapter 5 for more
information on the Column Editor.

Finders
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The Calendar
The Calendar feature is available in all date fields within each Adagio product, as
indicated by the Calendar button to the right of the date fields.

For example, when you start up Adagio Invoices, the Open Adagio Invoices Data
dialog box appears. This dialog includes a date field, which defaults to the current
date. If you want to change the date, just click the button once, press F5, or press the
letter C. A small calendar appears beneath the Date field.

Scroll forward one month at a time by clicking the arrow in the top, right corner of
the calendar (or by pressing PgDn), or scroll back one month at a time by clicking the
arrow in the top, left corner (or by pressing PgUp). Once the correct month is
displayed, select the desired day by clicking it once. The program will insert the
selected date in the field.

Other keys of interest:

• Home quickly selects the current date when the Calendar is active on your
screen.

• End takes you to the last day of the month that is currently displayed.
• Enter will enter the highlighted date in the date field.
• Escape closes the Calendar without changing the date that was originally in the

currently selected date field. Clicking outside the Calendar has the same effect.
• Page Up will move you to the previous month in the calendar; Page Down will

take you to the next month in the calendar.
• You can also change the date without calling up the Calendar. With your

cursor in the date field itself, press the + key on your numeric keyboard to
increase the date by one day. Or press the - sign to move back one day.

The Calendar
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The Calculator
The Calculator is available in all amount (numeric) fields. To call up the Calculator,
do one of the following in any amount field:

• Double-click the left mouse button.
• Press the Down Arrow.
• Press the letter C.
• Press the gray + key on your numeric keypad. This will also copy the contents

of a numeric field into the calculator to perform further calculations.

The Calculator will appear.

This fully functional calculator is useful for performing quick calculations as you
work. If you want to insert the result of your calculations in a field, click OK to exit
the calculator. You will notice that the final total of the calculation you just
performed appears in the field. If you merely want to use the calculator to check
some figures, but do not want the results to appear in the field, perform your
calculations and then click Cancel or press Escape. The results of your calculations
will be discarded and the number in the field will not change.
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Snapping to the Grid
Many Adagio products contain a specification Designer used to create forms for
invoicing, producing checks, deposit slips, picking slips, quotes, statements, etc...
Within the Designer, we’ve added a grid option that helps you place objects on a
specification more accurately.

The grid’s default settings are .2500" vertically and .2500" horizontally, meaning that
when the Snap to Grid option is turned on, objects automatically “snap to” the
specification page in increments of .2500" vertically and horizontally. The primary
advantage to using the Snap to Grid option is the ability to place objects accurately
on a page: aligned with each other in vertical columns, and in evenly-spaced rows
with consistent amounts of white space between objects.

To more easily see the effects of snapping to the grid, open a specification in any of
the Designers (such as Adagio Invoices Designer) and try resetting the default
settings to extremely large increments. Select Options | Properties, and under the
System tab, enter 1.00 inches in the Vertical field, and 1.00 inches again in the
Horizontal field. Click OK to accept these changes.

Now select an object on a specification and try moving it up or down on the page.
Notice how it jumps in 1" increments now. Try moving the same object to the left or
right; again, it jumps to either side in 1" increments. This jumping movement is called
“snapping to the grid”. The object you are attempting to move “snaps” into position,
according to the increments you set in Options | Properties.

You may want to reset the increments to .2500" in both the Vertical
and Horizontal fields again before continuing.

There may be times when you do not wish to snap to the grid; for instance, when you
need to have very precise control over the placement of an object. In these situations,
simply select Snap to Grid from the Options menu to turn this function off. When
you’re finished making the necessary positioning changes, again select Snap to Grid
from the Options menu to turn the function back on. Note that the function is
considered to be “on” when a checkmark is displayed to the left of this menu
command.
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Using Hints
Another feature of the Designers is the ability to view “hints” as you move your
cursor across the Button Bar or the specification. This feature is very similar to the
Status Bar at the bottom of the Designer window, in that it displays the same
information. The only difference is the way in which the information appears.

You will notice that as you move your cursor over top of a button on the Button Bar,
a brief description of that button’s function will appear on the left side of the Status
Bar. Similarly, if you move your cursor over top of an information code on the
specification, the code and its description will appear on the left side of the Status
Bar.

The “hint” balloons display exactly the same information, but the information
appears in small yellow rectangles directly below your cursor. For example, when
your cursor is over the vendor number field in Adagio Checks, the hint will read:

Vendor number

This is an excellent feature when you are first learning how to use one of the
Designer modules, since the hints appear directly beneath the button or field you
require information about. You may also want to continue using the hints feature
even after you are an expert specification designer, since it displays the field
information for you without requiring you to shift your focus down to the Status Bar.

The hint balloon will not appear once you have selected a field (e.g.
you have clicked it once to display the red handles). It will only
appear when you move your cursor over an unselected field.

This function will be turned on automatically when you begin using the Designer. If
you want to turn it off, select Hints from the Options menu. The checkmark beside
this menu command will disappear, indicating that it has been disabled, and the hint
balloons will no longer appear on your screen.
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Printing Options
All Adagio products are fully integrated with Windows printing options. When you
select a check or report to print in an Adagio product, you have numerous options.

First, in the print dialog box that appears each time you attempt to print a document
or a report, you can select your print destination options. Your options are to print to
the screen or to a specified printer. You have the additional option of printing reports
to a file; this option does not apply to documents such as checks, invoices, or picking
slips.

If, however, you prefer to select a different printer driver or alter other print options,
you must click the Setup button.

Printer Setup
When you click the Setup button, the Printer Setup dialog box appears.

This dialog box may vary somewhat depending on your printer
driver and the version of Windows you are running.

In the Printer section of this dialog box, you can either select the Default printer as
your printer driver, or Specific printer to choose a printer other than your default.

To change your printer driver, click the Specific printer option once. Choose the
desired printer driver from the field below, by clicking the down arrow once and
selecting the printer driver from the drop-down list that appears.

Other Printing Options
In the Printer Setup dialog box, you can also:

• Change page orientation. Click Portrait to print on an 8 ½" x 11" page or
Landscape to print the document on an 11" x 8 ½" page.

• Change paper size. Click the arrow to the right of the Size field and select a
different paper size from the drop-down list that appears.

• Change the paper tray. If the printer driver you selected has more than one
paper tray, the Source field allows you to select the preferred tray.

• Finally, the Options button in the Print Setup dialog box gives you still more
printing options. This is a Windows function; for more information on these
options, see your Windows or printer manual.
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Printing Reports
For information on report options in Adagio applications, see Chapter 4.
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Shortcuts
Time is always a hot commodity. That’s why we’ve included several capabilities in
each Adagio product to make your work a little easier, and a little faster.

Right Mouse Button Capabilities
When you are working in any Adagio product, you can speed up your work
considerably by using the right mouse button. While in many of the Adagio product
screens, or when any element of the specification is selected in one of the Designers,
you can click the right mouse button and call up a pop-up menu right next to the
field or specification element. Unlike the standard menus that group commands by
function (editing, inserting, etc.), these pop-up menus are element-specific: that is,
they contain only those commands that are available for use in the selected screen or
for the selected specification element.

The pop-up menus are valuable because:

• they appear right beside your cursor, making them faster and easier to access
than the main menus;

• they contain only the commands you need — you don’t need to search for
commands on a more comprehensive menu;

• they make it easier to learn the products because they eliminate the need to
remember where to find a command, and because you’re dealing with only a
compact list of commands it is easier to pick the right command; and

• they spotlight the things you can do with a field or an element.

The right mouse button pop-up menus are essential in the
Designers, as many of the commands you will need to use are not
included in the menus or on the Button Bar. It is a good idea to get
in the habit of using the right mouse button as often as possible, to
get accustomed to using it; if you do so, you will soon realize the
many benefits of this feature.

Program Options
Another way to speed up your work in the Adagio products is to check out the
special features available to you in the Options command on the file menu. Each
product is different, so we won’t describe any specific options here, but try opening
up the Options function and pressing F1 or clicking the Help button to get more
information on how you can use some of the options presented to you to make your
work easier.
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Data Integrity Checker
Data integrity is a crucial issue when it comes to something as sensitive as accounting
data. One of the valuable features included in each Adagio product is the ability to
check the integrity of your data. You will want to regularly check your data’s
integrity and create back-up copies of your data so that if your accounting data does
become corrupt, you will be able to restore from a backup before too much work is
lost.

Before running this function you will need to have exclusive access to the data. Use
the Active Users function, available from the Help menu, to determine when all
other users have logged out of Adagio.

If Auto-backup after DIC? has been turned on in the Company
Profile, a backup of your data is performed automatically when
DIC is run. If the DIC is clean, the backup file created will have
_Clean appended to its filename. If the data contains errors and
requires a Rebuild, the backup filename will have _PreRebuild
appended to it.

If grid Filters are used (see page 3-97), DIC will automatically refresh all filters and
reset filter styles used. For items that no longer meet any filter criteria, any filter style
previously assigned to them will be removed and reset to the Standard style. For
items that meet more than one grid filter criteria, the style will be reset to that of the
filter containing the highest Style priority. No messages or warnings are given in
DIC. (Refer to page 5-123 for more information about Styles.)

Within some modules, DIC will also reset other Style settings. For
example, in Accounts Payable, If styles have been applied using the
Calculate Vendor Aging function, DIC removes these styles. To
reapply them, you would rerun the Calculate Vendor Aging
function. Please refer to a module's online Help documentation for
further details.

To use this the DIC feature:

1) Close all open windows.

2) Select Data Integrity Check from the File menu.

3) Run an integrity check by clicking the Check button. The Test Results box will
list the data as it is being checked.

If no errors were found, Adagio will indicate that. Click OK.

Data Integrity Checker
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If errors were detected, Adagio will instead indicate that. Click OK. Before
continuing, if you would like to see what the errors were, scroll through the text in
the Test Results box.

Full details of the integrity check are written to the log file in your
company's data directory. The log file will begin with the program
letters, such as OEWINERR.XXX for OrderEntry, where .XXX is
your company's data extension.

When you are ready, click Rebuild. This function attempts to correct all of the
problems found in your data.

Adagio will remind you to backup your data. Please ensure that you back your data
up before continuing with the rebuild function. When your data has been backed up,
return to the Data Integrity Check function and click Rebuild again. When the
rebuild is complete, Adagio will display a message indicating that it is finished.

Turning the Auto-backup after DIC? function ‘on’ in the Company
Profile will automatically perform a backup of the module's data
after every Data Integrity Check.

Once you have run the Rebuild function, you should again do an integrity check to
make certain that the data has been repaired and is now clean.

In the event that your second integrity check reveals unfixed errors,
you will have to restore your data from a back-up copy or get your
data repaired. Contact Softrak Systems for more information on
data repair.

For your reference, the status bar at the bottom of the main Adagio window displays
the date on which the last integrity check was run.
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Backup Adagio Data
The backup feature on the File menu makes it easy to create a backup of your Adagio
data. This is especially useful to backup your data before running the Data Integrity
Check.

This feature can make a backup of:

• the current Adagio module’s data only,
• the current Adagio module’s data and related files, which will include the data

for related modules. For example, if you select this option in Adagio Invoices,
the function will include data from Adagio Receivables and Adagio Inventory.

• all data sets with the same file extension for all Adagio modules and third
party programs that you have installed.

The backup files are saved in the standard ZIP archive format.

Adagio Backup Options
Before running the backup feature, you should first check the Backup Options to
select a directory for the backup ZIP files, a file name prefix and numbering
sequence.

Backup Adagio Data
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To open the Backup Options window, select File | Backup | Backup Options.

The following table describes the fields on this window:

Field Description

Zip Path Enter the path where you want Adagio to store the
backup files.

Click the Folder button to select a path from your
computer or network.

Prefix Enter a prefix for the backup file names. The backup ZIP
files will be named with this prefix, and ending with the
number you enter in the Next Sequence field.

Next Sequence Backup files will be named with the prefix entered in
the Prefix field and a number, which will automatically
increment with each backup. You can change the
number in this field, if desired.
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Field Description

Enable vitalEsafe
uploads

Turn this option on if you wish to also store your
backup files on vitalEsafe's website.

NOTE: vitalEsafe, Inc. is a third party Adagio development
partner.

Username Enter the name of the account you would have
previously created on www.vitalEsafe.com

Password Enter the password you would have previously created
for your vitalEsafe account.

Upload folder Specify the name of the folder you wish to create/use to
store your backup files on vitalEsafe.

Auto upload backups Turn this option on if you want to always store your
backups, not only on your network but on vitalEsafe's
website.

Verify If this is the first time you are setting up your vitalEsafe
backup options or if you are making a change to your
Account, Password or Upload folder, click on the Verify
button to verify the accuracy of your account and
password information. If the upload folder you have
specified does not already exist, you will be prompted if
you want to create it now.

NOTE: This process takes a few seconds. Please be patient.
When your account information has been verified and, if
necessary, your upload folder created, you will receive a
message indicating so.

The small grid at the bottom of this screen displays past backups currently stored in
the backup path selected including the filename, date and size listed.

Click OK when you have edited these fields. You are now ready to run a backup.
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To Back Up Your Data
Generally, you can do three different types of backups:

• the current Adagio module’s data only,
• the current Adagio module’s data and related files, which will include the data

for related Adagio modules. For example, if you select this option in Adagio
Invoices, the function will include data from Adagio Receivables and Adagio
Inventory.

• all datasets with the same file extension for all Adagio modules and third
party programs that you have installed.

Select which type of backup you want to create from the File | Backup menu and the
Backup window will open. Click Start to run the Backup feature.

The following table describes the fields on the Backup window:

Field Description

Zip File: The directory path and zip filename you selected when
you set up the Backup function appears here.

Backup Adagio Data
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Field Description

Data Dir: The data directory/folder you are currently working in
appears here. This indicates the location of the dataset
you will be backing up.

Files: The files you will be backing up are indicated here. For
example, AR*.xxx (where 'xxx' represents your
database's file extension) indicates that you will be
backing up AR data only; *.xxx indicates you will be
backing up all files (Adagio and third party) having the
same database file extension.

Automatically upload
to vitalEsafe

Turn this option on to have another copy of your backed
up files stored on the vitalEsafe website.

NOTE: vitalEsafe, Inc. is a third party Adagio development
partner.

Click Start to begin backing up your files.

You may notice that the Backup window has two tabs: a Messages tab and an Errors
tab. The Messages tab displays the files that Adagio is backing up and the Errors tab
will display errors when applicable.

NOTE: If you have selected to also backup your files to vitalEsafe,
after you click on Start, Adagio will be frozen on your screen while
the backup proceeds. A window indicating that ‘Adagio module is
locked while uploading to vitalEsafe’ will display along with a
progress bar.

However, the progress bar holds at the 50% mark and you may see a
message bar at the top of your Adagio module window indicating
that the program is ‘not responding’. Please disregard this message.
The backup is proceeding.

Instead, refer to your Windows Taskbar. Until the backup is
completed, there will be an icon in the taskbar for VitalEsafe. If you
hover your cursor over it, it will display exactly what percentage of
the backup has completed. Additionally, if necessary, you can right
click on the icon and Cancel the upload.

Click Close when the backup is complete.
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If another user has data open that you want to back up, the Backup
function will not be able to back up the open files. This will result
in an error message. The Errors tab will display the files that were
not backed up.

Multicurrency Files
In newer versions, MultiCurrency files are always backed up for both MultiCurrency
and single currency datasets.

Restoring a Backup
If you ever need to restore a backup, it is highly recommended that you contact your
dealer. While the backup files are saved in a standard ZIP format, you need to be
certain before you overwrite your existing data that the backup copy is in fact the
best copy of your data.

When a database is restored, the existing database in the target
folder must be deleted first. Failure to do so will usually result in
problems. These problems may or may not be immediately
apparent. Problems may not show up until much later.

Copying data files other than an entire dataset is not recommended
and doing so can result in similar problems. When copying a data
set, the original database must be deleted first.

Before deleting an existing database prior to restoring, make a copy
of the existing data or move it to another folder. If your backup
copy is corrupt or cannot be restored for any reason, the existing
database may be the only viable copy of the data that exists.

In both cases, the integrity checker may not and probably will not
report any errors.

Deleting Old Backups
If you want to delete old backup files you must do so manually from the Windows
Explorer. Find the directory you use as your backup directory and delete the old zip
files.
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Notes and Alerts
Adagio products include a feature which allows you to add and maintain notes for
customers, prospects, vendors, items, accounts, jobs or banks. Or, it may also enable
you to enter alerts for customers, vendors, or items. The date and the user’s ID are
recorded with each note so that you can keep track of them. This section explains
how to use this function.

The following discussion of Notes and Alerts uses Adagio Receivables customer
notes as an example. However, the principles are the same whether you are creating
notes for Adagio Receivables customers, SalesCQ prospects, Adagio Inventory items,
or Adagio Payables vendors. (This also pertains to the programs that interface with
those listed, such as Adagio Invoices and Adagio BankRec where you can edit
Receivables customers directly within the program).

1) From the Edit menu, select Customers, or click the Customers button on the
toolbar. The Customer list will open.

2) Select a customer in the list and click the Edit button. The Edit Customer
window will open.
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3) You will notice the Notes/Alerts tab that appears on this window. Click this tab.

4) You can specify whether you want to work with Notes or Alerts. The following
sections explain each option.

Working with Notes
Working with Notes, you have these options:

Field Description

Additional comments You can use this field to enter simple comments. These
comments can be edited by any user and at any time. If
you want to maintain more detailed notes, enter a
Customer Note using the fields below.

Sort notes by You can sort the Notes list by User or by Date / time.

Notes list This box lists all the notes for this vendor.
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Common Features Page 3-97

Edit Customer window: Notes/Alerts tab



To add a new Customer Note, double-click an empty line in the Notes list. The Edit
Customer Note window will open.

The following table describes the fields on this window:

Field Description

User This field displays the current user. Every note records
the current user so that you will always know who
wrote which notes. If you want to change the user ID
recorded with this note, enter the user ID in this field.

Date This field displays the current date, which is recorded
with the note. If you want the note to appear with a
different date, click the Calendar button and select the
desired date.

Time This field displays the current time. You can edit this
field if needed.

Notes Enter the note here.

When finished, click OK and the note will be added to the Customer’s information.

To view a note, select the note in the Notes list on the Notes tab. Then click the Edit
button.
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Working with Customer Alerts
Alerts may be a useful way to pop up very important reminders about a particular
customer. For example, if there is an issue with their account status, you could enter
an alert so that every time someone from your company pulls up their file, they are
aware of important account information. If desired, alerts may be made active
within specific modules and functions only.

Turning on the Enable alerts? option will make active all Alerts entered in the Alert
Description grid. Turning the option off will disable all existing Alerts for this
customer.

The Alerts grid shows the first line of text in each existing Alert, along with what
function the Alert is active for.

To create an Alert, either double click on a blank record in the Alert Description grid
or right click and select New.

The following Edit Customer Alerts window appears:

Select which functions you want the Alert to be active for (eg. IN invoice entry
and/or OE order/invoice/credit note entry). Or, select that this Alert should
actively display (pop-up) in All of the functions listed. What functions you are able
to select from is dependent on which Adagio modules you have data for and the
modules' customer related functions.

You may select to have the user enter their userID as confirmation they have read
the Alert prior to proceeding. Or, for one-time Alerts (perhaps for the first user to
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enter an invoice for the customer in Adagio Invoices or OrderEntry), you might
choose to allow users to Disable the Alert after reading it. This would prevent it
from continually popping up each time the user creates an invoice for the customer.

Enter the text of the Alert and click OK.

Working with 'Other' Alerts in Adagio
To use the Alerts feature for things other than customers (eg. items, accounts, etc.),
click the Alerts radio button at the top of the window.

Alerts may be a useful way to pop up very important reminders about a particular
item; for example, if there is an issue with the item and you want invoice and order
entry clerks to know about it, you could enter an alert so that every time someone
from your company accesses the item, they are aware of the issue.

You can type in any text you wish for the alert, and simply turn on the Active alert?
checkbox to ensure that the alert pops up each time you select this item throughout
Adagio Inventory or any other Adagio 8.0 (or higher) module.

You are able to enter a single alert. When you need to change the alert, edit the
existing alert text to reflect the new alert.
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The spell-checker is active in the Alerts field; simply press F7 to call it up. (See the
following section on Spell Check for more information.)

Spell Check
A Spell Check feature has been added so that you can check the spelling in the Note
functions. To start Spell Check, hit F7 when your cursor is in the Notes text field, or
in the Additional comments text field. The Spell Check window will open.

The table below describes the fields and buttons on the Spell Check window.

Field / Button Description

Not found This word was not found in the Spell Check Dictionary. It
may be spelled incorrectly.

Replace with Enter the correct spelling of the word in this field.

Start Click this button to begin the spell check.

Auto Correct Click this button if you want the word in the Replace with
field to always replace the word in the Not found field. If
you do this, the word will automatically be replaced with
the other every time you run a spell check.

Options Open the Spell Check Configuration window (see section
below).

Undo Last Restores the last spell check action performed and
re-selects the previous misspelled word (if possible). This
button can be pressed multiple times to undo multiple
operations.
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Field / Button Description

Ignore Click this button to ignore this occurrence of the word in
the Not found field.

Ignore All Click this button to ignore all occurrences of the word in
the Not found field.

Change Click this button to replace the word in the Not found
field with the word in the Replace with field.

Change All Click this button to replace all occurrences of the word in
the Not found field with the word in the Replace with
field.

Add Click this button to add the word in the Not found field to
the dictionary. If you do this, the word will always be
recognized as being correctly spelled.

Suggest The Suggest button will, if possible, add additional word
alternatives to the suggestions list.

Spell Check Configuration
Click the Options button on the Spell Check window. The Spell Check
Configuration window opens. This window has two tabs.

The Dictionaries tab allows you to select different dictionaries, add and remove
existing dictionaries.

Notes and Alerts
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The “Main Dictionaries” box lists all dictionaries currently installed on your system.
Select which dictionary to use by clicking on it. If you have a different dictionary
located elsewhere on your computer, click the Add button. If you want to remove a
dictionary from the list, click the Remove button.

The “User Dictionaries” box lists all user dictionaries, which are dictionaries
containing the words you have added to Spell Check. Spell Check creates a default
user dictionary called default.udt. If you want to create a new user dictionary, click
the New button. This is useful if you want two different user dictionaries for
different purposes.

The Options tab allows you to set general options for Spell Check

The following table describes the fields and buttons on this tab.

Field / Button Description

Ignore: Words in
UPPERCASE

Select this option if you want Spell Check to ignore
words typed in all uppercase letters.

Ignore: Words Containing
Numbers

Select this option to ignore words with numbers.

Ignore: HTML Tags Select this option to ignore HTML tags in your text.

Ignore: URLs and E-Mail
Addresses

Select this option to ignore URL web address and
e-mail addresses in your text.

Notes and Alerts
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Field / Button Description

Reset Ignore All Removes any words previously added to the
“Ignore All” list. Words previously in the list will
no longer be ignored when encountered.

Reset Change All Removes any word sequences added to the
“Change All” list. Words that were previously
added to the “Change All” list will no longer be
automatically replaced.

Suggestions: Generate
Automatically

Select this option if you want Spell Check to
automatically generate suggestions for misspelled
words.

Suggestions: From Primary
Dictionary Only

Select this option if you want Spell Check to
suggest only words from the main dictionary
(not your user dictionary).

General: Re-check Replaced
Words

Forces Spell Check to re-check words that it
has replaced as a result of a Change or Change All
operation. This is a useful feature to counteract the
occasional spelling mistake that may occur when
typing a corrected word.

Notes report
Each Adagio module that includes a Notes feature also has a Notes report on the
Reports menu. This report will print all notes based on your criteria, such as note
date or the initials of the user who entered the notes.

Purging Notes
Each Adagio module that includes a Notes feature also allows you to selectively
purge notes from the Maintenance menu. Just enter your purging options, such as if
you want to purge all notes that are older than a given date, and the system will
purge them from your data.

Notes and Alerts
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GridView Inquiries
Users can add Views to Adagio modules that include an Inquiries menu.

To use this feature, first create a Views folder in the module directory.

Then, create a Workspace in GridView containing one or more Views. Copy the
Workspace (.gvs) and the Views (.gv) it uses to the Adagio module’s Views folder.
For example, Adagio Receivables is installed in \SOFTRAK\Receivables, so you
would copy your .gvs and .gv files into the \SOFTRAK\Receivables\Views
directory to access them through the Adagio Receivables Inquiries menu.

Any time you make a change to the views stored within the folder, you will be asked
to Update the Views. This updates the views that will be used on the module's
Inquiry menu.

Remember, if you want an Adagio user to be able to edit the View
when they run it from the Inquiries menu, you must turn on the Edit
Gridview checkbox on their Adagio User record. Otherwise, they
will be able to view and print it only. (See User Setup on page
3-56.)

GridView Inquiries
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Chapter 4

Working with Reports

Across the various Adagio applications, some report options and features are
standard. This chapter will review the basic report printing information for you.
Information on specific reports in each application can be found in that application’s
manual or help file.

For some general information about setting your printing and printer preferences,
see the Printing Options (page 3-85), User Preferences - Report Options (page3-72) and
Workstation Options (page 3-65) sections in Chapter 3.
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Report Features

The Comment Button
A Comment button appears on all Adagio report screens. This button allows you to
enter a comment which is printed on the report, as a one-time addition to this
particular printed copy of the report.

If you want to add a comment to the report, click the Comment button on a Report
screen before you print your report.

The Report Comment window will open. Enter a comment in the field, then click the
OK button.

The comment will be added to the report. Click the Print button to print the report.

This comment applies only to a single printing of the report. It does
not get saved for reuse in the future printings.

Listing Button
For those Adagio programs that include batch list windows, there is a Listing button.
This button takes you directly to the Listing report window, so that you can quickly
print the batch listing without having to go through the Reports menu.

For example, if you were working with the Invoice Batches List in Adagio Invoices
and needed to print the Invoice Batch Listing, just click the Listing button and the
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Print Invoice Batch Listing window will open. There you can select your report
options and print the batch listing.

If you want to select a range of batches for your batch listing, you can select this
range directly within the Batch List window. Hold down the Shift or Control key on
your keyboard and use your mouse to select a range of contiguous batches to include
in the report. Then click the Listing button. Your range will automatically be entered
in the Batch Number Starting and Ending fields.

When selecting a range to use with the Listing button, the range
must be contiguous. For example, selecting batches 1 to 5 is okay,
but selecting batches 1, 3 and 5 will not work.

Saved Report Settings
The options and ranges you choose on report windows are saved by user by
company within User Preferences - Report Options (see page 3-72) so that, if you
commonly use the same settings for a specific dataset, you won't need to reset the
report options each time you print a report.

Close Dialog after Print
Adagio modules contain an option in their User Preferences - Report Options to
Close report dialog after print? If this option is turned on, after clicking the Print
button on a print report dialog, the print dialog will automatically close.

This option has no effect when the Preview button is used. After
Preview, you will still need to Close out of the dialog.

Report Features
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Printing Reports to File
When you print reports, you have the option to print to file.

File Format Options
For each individual Adagio module, you can specify the default file format you
would normally use when printing to file. To do so, go to User Preferences - Report
Options (see page 3-72) and locate the Default print to file format field.

For example, if you normally would want to open the printed data in Word, select
Word. You can also print reports to Excel. Or, if you sometimes put reports on a
company intranet, perhaps you would normally print to HTML format instead.

This is only a default; the file format can be changed for specific instances of printing
to file.

Filename and Location
Each time a report is printed to file, the filename defaults to the name of the report.
The location defaults to your company's data directory.

The filename and location can be changed for each individual report you print. A
default file path may be set within your User Preferences - Report Options (see page
3-72).

If you do not want the report you are currently printing to file to
overwrite/replace the file that currently exists, be sure to specify a
new/different file name for the report you are printing.

Printing Reports to File
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Printing Reports to Fax
One feature you may find very useful is the ability to print forms such as invoices in
Adagio Invoices directly to fax. This may be useful, for example, if you wish to fax
an invoice to one of your customers to expedite payment.

See Chapter 7 for more information on Faxing in Adagio.

Printing Reports to Email
Another feature you may find useful is the facility to print forms such as invoices,
statements, orders, quotes, EFT advice information, etc. directly to your email client.
This may be very useful for emailing invoices or quotes to your clients or prospects.

See Chapter 8 for more information on Emailing in Adagio.

Printing Reports to Fax

Working with Reports Page 4-111



Report Files
The source files for all reports in Adagio modules can be found in a subdirectory
called StandardRP, off the main program directory. For example, Adagio
Time&Billing reports are in the directory C:\SOFTRAK\TBWIN\StandardRP,
where C:\SOFTRAK is the drive and directory to which you installed Time&Billing.

If you want to modify any of these reports using Crystal Reports for Adagio, place
the modified copy of the report in the C:\SOFTRAK\xxWIN\ModRP directory.
When you do so, Adagio will print the modified version of the report, but the
original report will not be overwritten. Most importantly, when you install upgrades
to your Adagio software, your modified reports will not be overwritten.

If you customize a built-in report, you may wish to redo the
customization with future upgrades of the module, in order to take
full advantage of any report and feature revisions in the updated
version of the software.

Report Files
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Custom Reports
Users of Crystal Reports for Adagio can create custom reports and have them appear
on the Reports menu in Adagio applications. This allows users to print, preview and
export custom reports without needing to run Crystal Reports. This saves you from
having to start Crystal Reports, find the desired report, and use the Set Location or
Verify database functions if the report is printed for multiple companies.

This feature is only available if a copy of Crystal Reports for
Adagio is installed, and it requires Crystal Reports for Adagio to be
registered or within 60 days of installation.

Run-time parameters can be used for ranges and dates. They are typically required
because in most cases you want to select data rather than print all information in the
file. You will be prompted for the parameters when you print a custom report that
uses Run-time parameters.

Security Groups in Adagio are supported, allowing you to restrict certain users from
printing custom reports.

Setting Up Adagio to Use Custom Reports
To use custom reports, you must create a sub-directory named "CUSTOMRP" under
the program directory. For example, the custom reports directory for Adagio Ledger
might be:

M:\SOFTRAK\Ledger\CustomRP

Custom report files (*.rpt) created with Crystal Reports for Adagio must be placed in
this directory.

You can restrict users from printing custom reports unless they belong to a particular
security Group in the Adagio application. To do this you must create a subdirectory
under the CUSTOMRP directory with the same name as the Group to which the user
belongs in the Adagio application. The custom report files (*.rpt) for that Group must
be placed in this directory. For example, to restrict custom reports to users in the
Group "ADMIN" for Adagio Ledger, the report files might be placed in the
subdirectory:

M:\SOFTRAK\Ledger\CustomRP\ADMIN

Custom Reports
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In order to use the custom reports feature on a network, the Adagio
component of Crystal Reports for Adagio must have been installed
to a network drive. In other words, the \SOFTRAK\RPWIN
directory must be on a network drive (although the Crystal Reports
programs can be on a local drive - typically C:\Program
Files\Seagate Software\Crystal Reports).

Designing Custom Reports
Custom Reports are created using Crystal Reports for Adagio.

When designing a Custom Report, you should select the database for which the
completed report will be printed. This allows you to browse data fields during report
creation and test your report. If you are working with a copy of the data in a different
location than the ultimate target database, or if your report will be printed for
multiple companies, you do not need to set location to the actual location of the
database for which the report will ultimately be printed. When a Custom Report is
printed from your Adagio application, the program will automatically set the
location for the Adagio database you have open.

The report should not be saved with data. You want the data to be refreshed each
time you print the report in the Adagio application.

The report Title should be set in Crystal Reports under the File | Report Options
menu. The title you set here will become the menu choice for the report on the
Custom Reports menu in the Adagio application. Report titles should be unique to
each report. If you do not the set the Title in your report, the Custom Reports menu
will display the report by its file name (for example: myreport.rpt).

Printing Custom Reports
Custom reports are located in the Reports | Custom Reports menu in the Adagio
application.

When you first select the Custom Reports menu, all the reports in the custom reports
directory are loaded to generate the list of possible reports. This may take several
seconds, depending on the number of custom reports you have in the directory. Once
the reports have been loaded the first time there is no delay when you select the
custom reports menu again.

If reports have added or removed from the custom reports directory, the message
"Do you want to update the custom reports menu?" is displayed when you open the
Adagio application. You should normally answer "Yes". Updating should only take a
few seconds unless you have a large number of reports. If you do not update, the
Custom Reports menu will display new reports with an asterisk and deleted reports
with be grayed out. In addition, another the menu choice "Update Custom Reports"

Custom Reports
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will be shown underneath "Custom Reports". You can use this function to update any
time the Custom Reports menu is not up to date.

Select a report to print from the menu. A print dialog is displayed, allowing you to
print or preview the report and select the print destination. To change the printer
selection, click the Setup button.

Changes made to the paper orientation will be ignored. The
parameters set in the report in Crystal Reports will be used.

The report Comment feature found in standard Adagio reports is
not supported for custom reports and therefore the Comment button
is disabled.

You will be prompted for the parameters when you print a custom report that uses
Run-time parameters. Typically custom reports will prompt for today's date or a
range of dates, and other ranges such as starting and ending account numbers.

To export a report to another format or destination, first Preview the report, then
click the Export button on the Preview window.

Error messages displayed during report printing can be found in the Crystal Reports
help. Additional errors may be found in the Crystal Reports for Adagio manual.

The performance of some custom reports may be slow for large files.
Unlike standard reports in Adagio applications, custom reports
cannot use indexes and temporary files to speed up the report. The
report will print about as fast is it would if printed directory from
Crystal Reports.

Custom Reports
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Limitations of Custom Reports
Custom Reports have some limitations not found when the report is printed from
Crystal Reports 8.5 for Adagio. The following features are not supported in Custom
Reports:

• Report Alerts
• Some graph/chart features
• Geographic maps
• On-demand subreports
• Parameters screen appears different
• Some export formats (XML, PDF, RTF)
• Fractional Font sizes

Custom Reports
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Chapter 5

Customization

We know that everyone works differently, viewing different pieces of information as
important.

For that reason, we’ve included a Column Editor with each Adagio product which
will allow you to customize the tables in each product to best suit your needs.

Functions that contain lists of information, such as Edit | Distributions in Adagio
Receivables or Edit | Customers in Adagio Invoices, are editable. The lists can be
changed to include the information you want, in the order you prefer.

Using various Adagio modules as examples, let’s take a look at how the Column
Editor works.
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Column Editor
Only those users who have been given rights to the Column Editor
will be able to access this feature. When a user is set up in File |
User Setup, the System Administrator must click the Edit columns
checkbox on if he/she wishes to give the user access to the Column
Editor.

Each window has certain default settings. For example, by default the Vendor List in
Adagio Checks contains four columns in the following order:

• Vendor
• Name
• Contact
• Reference

Each of these columns is a certain default width, as well.

However, if you want to insert a column for a particular inquiry in this window, or
remove a column, or change the order or size of the columns, you can use the
Column Editor to do this.

Although you can resize columns without actually calling up the Column Editor, it is
important to understand that these changes will not be saved. You must make the
changes on the grid, then open the Column Editor and save any permanent changes.

The Column Editor is not available on all grids. If you attempt to
open the Column Editor on a grid where it is not available, Adagio
will display a message that states “The Column Editor is not
available on this grid.”

To see how the Column Editor works, select Vendors from the Edit menu in Adagio
Payables or click the Vendor maintenance button on the Button Bar.

Column Editor
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The following window appears:

Column Editor
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To open the Column Editor, go to the top of the list and double-click on the row
containing the column headings. The Column Editor appears.

In the Field Selection section of the dialog box, you will see a list of all of the possible
vendor-related fields on the left, and a list of the current column headings on the
right.

Several fields appear in the Field Properties section of this dialog box:

Field Description

Title Indicates the title of the currently selected column
heading. (To select a column heading, go to the list in the
top, right-hand portion of this dialog box and click the
column heading you wish to edit.)

You can change the title if desired. To do so, simply delete
the existing title and type in the title you prefer.

Column Editor
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Field Description

Title alignment Allows you to change the default alignment of the column
title. Click the drop-down arrow to the right of this field to
select a different alignment. Your options are Left,
Centered, and Right.

Field alignment Allows you to change the default alignment of the field
contents for each item (in this case, vendor) on the list.
Click the drop-down arrow to the right of this field to
select a different alignment. Your options are Left,
Centered, and Right.

Column width Allows you to change the default column width for this
column. For example, if you use only three digits for your
vendor codes, you might want to change the Vendor
column to a width of 3 by typing 3 in this field.

These fields should only be edited when one of the column headings on the right
side of the dialog box is selected.

Two additional fields appears in this dialog box. The Set view for all users checkbox
allows you to set the default column view for all of the users, if you are running
Adagio on a network. Turn this checkbox on to set the view for all of the users, or
click it off to change the view for yourself only.

The Set view for all users checkbox will only appear in this dialog
box for the System Administrator (user SYS).

The Active records only checkbox appears on many Column Editor screens. Turning
this checkbox on restricts the view to only those records wherein the Active setting is
turned on (i.e. they have not been flagged as Inactive). When this field is turned on
for a particular grid, only those accounts, customers, items, etc. that have the Active
setting turned on in Edit or Maintain Accounts or Edit Customers will be visible.

Adding a Column Title
From the list of all of the possible column titles, listed in the top, left-hand portion of
this dialog box, click the field you wish to add.

Click the right arrow button to copy the field into the list of current column titles.
The selected field will appear in the list, directly above the field that was highlighted
in the column title list. Or, you can double-click the field you want to add.

Column Editor
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Removing a Column Title
From the list of current column titles, listed in the top, right-hand portion of this
dialog box, click the column title you wish to remove.

Click the left arrow button to copy the field into the list of current column titles. The
selected field will be removed from the list.

Changing the Column Title Order
From the list of current column titles, listed in the top, right-hand portion of this
dialog box, click the title you wish to move. Click the up and down arrow buttons to
move the selected column title as desired.

Changing a Column Title’s Properties
From the list of all of the possible column titles, listed in the top, left-hand portion of
this dialog box, click the column title you wish to alter.

Move to the fields in the Field Properties section of the dialog box (described earlier
in this section) and make any desired changes to the column title’s properties.

The Column Editor is available from the Finder and Smart Finder
as well. You can call it up from the results list (or the blank grid in
the Smart Finder, before you conduct your search) in the same way
you would from any other list: simply by double-clicking on the list
headings.

Column Editor
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Styles
Styles are useful for depicting which item records meet the criteria of a particular
Filter (see page 5-126) that has been run. For example, when the filter is run, records
that meet the filter’s criteria can display in a certain style that is assigned within the
filter.

Additionally, the Standard style is where you define how a master record appears
normally and how it appears when selected (highlighted) during the regular course
of working with Adagio.

Selecting File and Styles from the menu, takes you to the Adagio Styles window:

If you have access to the Column Editor (see page 5-118), you may
use it to change which columns appear in the grid.

Styles
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Creating a new or editing an existing style takes you to the Edit Style Codes
window:

Only the Standard style has a Selected column which displays the
style for any item record that is selected/highlighted.

The following table describes each field:

Field Description

Style code If this is a new style, enter the name of the style you are
creating. This code may include as many as 20 characters.

Background color Clicking the existing color invokes a standard Windows
color palette from which you may select basic colors or
define custom colors to be used for the record’s
Background.

Font color Clicking the existing color invokes a standard Windows
color palette from which you may select basic colors or
define custom colors to be used for the Font in the record

Bold font /
Italic font

Select whether the Font will appear in Bold and/or Italic.

Styles
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Field Description

Sample The Sample shows you what the result of the choices
you’ve made will look like when this style is applied to an
record that matches the criteria within a filter.

Selected Only the Standard style has a Selected column. Each field
in this column is set up in the same manner as in the
Normal column.

The Normal style shows how an item record will appear in
a grid when this particular style is used (i.e. normally or
within a filter). The Selected style is how an item record
will appear when you select or highlight it for some
purpose.

Styles
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Grid Filters
Grid Filters can be useful tools for doing custom queries about the master records in
your Adagio module. Once a filter has been created, filters are accessible from the
List and View List grids (eg. items, vendors, customers, etc.). Grid Filters can use
Styles (see page 5-123) so that, optionally, you may have records which match the
criteria defined in the filter that’s been run, display the particular Style assigned
within the filter. Additionally, filters may be Public or set to be run by an individual
user only.

To set up a Filter, select Edit | Filters from the menu.

If you have access to the Column Editor (see page 5-118), you may
use it to change which columns appear in the grid.

Click the appropriate radio button to display only those filters in the grid. The
default is Public; however, Adagio will remember whatever setting you used last.
You may choose from:

• All - Displays all filters for this dataset.
• Public - Displays all filters having a ‘blank’ User Code.
• Yours - Displays only the filters having a User Code equal to the UserID of the

person logged into Adagio Payables.

Grid Filters
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The option of All only appears to the Adagio System Administrator
(user SYS).

Creating a new or editing an existing style takes you to the Grid Filter Edit window:

The following table describes each field:

Field Description

User code If this query is to be run by a single Adagio user only,
enter that user’s ID here or select it from the Finder. A
Filter using a ‘blank’ user code will be available for all
users to run (i.e. Public). A Filter having a specific user
code (i.e. Yours) will only be available to run by that user
when they are logged into this Adagio module.

Description Enter an up to 40-character unique Description of your
Filter. This becomes the Filter code.

Grid Filters
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Field Description

Style priority If you have more than one Grid Filter created, it is possible
that a master record might satisfy the criteria for more than
one Filter. Entering a Style priority tells Adagio which
Filter style has the highest priority and should be applied
to an item satisfying multiple filters. A priority of ‘1’ is the
highest priority; whereas a priority of ‘99’ would be the
lowest priority. An easy way to remember this is “What is
your #1 style?”. Style #1 is applied in preference to style
#10 if a record is eligible for both styles.

NOTE: To ensure the style having the highest priority has been
assigned to an item satisfying that filter’s criteria, run Data
Integrity Check (see page 3-88) . No warnings or errors will be
reported regarding filter styles; however, the styles will be reset
accordingly.

Style code You may select a particular style that can be applied to
item records meeting the criteria within this Filter or
choose to leave the Style ‘blank’. If you want to remove the
Style color from this Filter at a later time, choose the
Standard style.

NOTE: A Style(see page 5-123) must first be created before it
will display in this dropdown.

Active records
only?

Turn this option on to have this Filter report on master
records that are Active only. If you wish to report on
Inactive records also, turn the option off.

Query field Similar to working with the SmartFinder, select the field to
query from the dropdown.

Operation Select the operation to use with the query.

NOTE: When a Date field has been selected using the Floating
date operation, you select what date(s) is meant to ‘float’ or be
updated, based on the session date, when Apply Styles is used
and the filter is run. The date is automatically updated if the
filter is run using the Apply Styles button or the Apply Styles
function (refer to page 5-131).

Grid Filters
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Field Description

Select field When this option is off, the next field is used to enter a
value for the query.

When this option in on, you are able to select another field
as the value in the query. For example, rather than the
filter being based on the ‘Outstanding Balance’ being
‘Greater than 0.00’, the filter might be that the
‘Outstanding Balance’ must be ‘Equal to’ the ‘Last Inv
Amt’.

NOTE: When a Date field has been selected using the Floating
date operation, this option is always off enabling you to select
what date(s) is meant to ‘float’ or be updated, based on the
session date, when Apply Styles is used and the filter is run.
The date is automatically updated if the filter is run using the
Apply Styles button or the Apply Styles function (refer to
page 2-1).

Constant or field Depending on whether the prior field is turned on or off,
you will either enter a value for the operation to act on
here or select another field to be used instead.

Boolean Use this field to include certain boolean operators in your
search such as AND, OR, AND NOT or OR NOT. Selecting
one of these operators opens another filter criterion line.
You may specify up to five separate criterion lines in this
filter.

Click this button to remove the row of fields to the left of
the button from your filter criteria.

Grid Filters
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Field Description

Sort by You may highlight and select (move to the box on the
right) one or more fields to sort the filter results with.

NOTE: Fields in the ‘available’ box on the left are sorted
alphabetically if you turned this option on in your User
Preferences (see page 3-66).

Selecting more than one field to sort by creates primary,
secondary, tertiary, etc. sorts based on the order of
selection (top to bottom). Once you have selected the
field(s), use the other arrow keys to deselect (left arrow)
fields or to move a field up or down to adjust its sort order.
As well, you can select and right click on any of these
fields to change its sort order from Ascending to
Descending (or vice versa).

In the case of a filter that has either never been run before
or for which the Column Editor has not be used to change
the displayed columns on the results grid, adding a field to
the selected list will automatically add that field(s) to the
results grid for the filter. For other filters, you can use the
Column Editor (see page 5-118) to either manually add the
new ‘Sort by’ field(s) to the filter’s results grid or click the
Reset button and the Column Editor will do this
automatically for you.

NOTE: The maximum sort length is 40 characters. Therefore, if
you chose to sort by Category, Vendor 1 Code, Item # and Item
Description, you will have chosen to use 6 + 6 + 16 + 40 = 68
characters. This exceeds the 40 character limit so the last field
will be excluded from the actual sort.

Click OK when you are done. To run your filter and apply an associated style to
records that meet the filter's criteria, highlight the filter and click the Apply Styles
button.

Grid Filters
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Apply Styles
Apply Styles may be used to run one or more grid Filters (see page5-126) and apply
the filter Style to vendors meeting the filter criteria in one step. When a filter
containing a Floating Date operation is run using Apply Styles, the date the filter
used will automatically update based on the session date.

Additionally, Apply Styles may be used to remove all Grid Filter styles previously
assigned to records meeting the criteria of a filter. This may be a useful way to ‘clean
up’, if multiple filters have been previously run and their styles applied to records
perhaps making the grid appear too colorful. By doing this, you may be able to focus
more clearly on just those records that meet the criteria for the filter(s) being run
from this window. If an record meets the criteria for more than one of the filters
being run, the filter style applied to the record will be determined by the Style
Priority set within each grid Filter.

If grid Filters are used, Data Integrity Check (refer to page 3-88)
will reset filter styles used. For records that no longer meet any
filter criteria, any filter style previously assigned to them will be
removed and reset to the Standard style (see page 5-123). For
records that meet more than one grid filter criteria, the style will be
reset to that of the filter containing the highest style priority. No
messages or warnings will be given in DIC.

Apply Styles
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If you’ve been granted access to use the Column Editor (see page
5-118, you may change the field columns that display in this grid.

Click the appropriate radio button to display only those filters in the grid. The
default is Public; however, Adagio will remember whatever setting you used last.
You may choose from:

All - Displays all filters for this dataset.

Public - Displays all filters having a ‘blank’ User Code.

Yours - Displays only the filters having a User Code equal to the UserID of the
person logged into Adagio Payables.

The option of All only appears to the Adagio System Administrator
(user SYS).

Turning the Clear unselected filter styles? option on resets all styles currently
applied to items to the Standard style. When one or more filters are also selected, all
item styles are reset to Standard and then filter styles for the selected filters are
applied to those items that meet the criteria of the filter. Filter styles are applied to
items based on the Style Priority assigned within the filter.

When you are ready, click the Apply button to run the selected filters and applies
styles based on whether or not Clear unselected filter styles? is turned on, the Filters
selected and the Style Priority assigned within the filter.

Apply Styles
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Optional Fields Validation
This Adagio function provides the facility to set up validation rules for each of the
three String fields that may be created in the Company Profile. Validation
determines if the information entered into an Optional field stored within an item’s
Optional tab is correct (valid) or not, or if a user should be able to enter whatever
they want into the field.

If Optional Text Field 1, 2 or 3 are imported and they adhere to the
validation rule set for the particular field, they will be added to the
Valid Fields list.

To access the Adagio Optional fields window, select Optional Fields from the File
menu.

This grid lists all string Optional Fields that have been created within your Adagio
modules’ Company Profiles. The modules that the string field is used in are also
shown, along with certain validation rules.

As long as an Adagio module supports Optional Field Validation (i.e. contains a File
| Optional Fields menu pick), any changes you make to rules for a Field Name used
by that module will affect any validation of the field within that module. If the
module doesn’t support Optional Field Validation, entering a rule for the field will
have no effect in that module.

Optional Fields Validation
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If Optional Text Field 1, 2 or 3 are imported and they adhere to the
validation rule set for the particular field, they will be added to the
Valid Fields list.

Selecting to Edit one of the supported optional fields, opens the following window:

The following table describes each field:

Field Description

Uppercase? Turn this option on to force entering uppercase letters only
in this field. Turn it off to allow both upper and lowercase
text to be entered.

Maximum Length Enter the maximum number of characters that may be
entered in this field. Choose a value between 1 and 30.

Optional Fields Validation
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Field Description

Control to use Select the control to be used for this field:

� Edit only - Field is not validated. You may enter any
value up to 30 characters in this field.

� Combo box - Valid entries may either be selected from
a dropdown arrow in this field or by typing the first
(up to 5) characters of the selection.

� Finder - Valid entries may either be selected from the
Finder button in this field or by typing the first (up to
5) characters of the selection.

Add on the fly? This field is only active if Combo box or Finder field have
been selected as the Control to use.

Turn this option on to indicate that, when a field does not
appear in the dropdown list, text that is entered in the field
may be added to the list when Okay is clicked in the
record or the Finder.

Allow blank? When this option is turned on, nothing needs to be entered
in the field as a value of ‘blank’ is acceptable and may be
saved.

Verify? When this option is turned on, the entry may not be saved
until a valid value is entered or selected from the Combo
Box or Finder.

If this option is off, validation does not occur and any
characters (up to 30) may be entered in the field and saved.

Value grid This grid displays the list of acceptable values to display in
the Combo box dropdown or Finder window. Double
click on a blank row or use the Add button to add a new
value.

NOTE: If Add on the fly is turned on, when a value is entered
on the fly in an item, it will automatically be added to this list. If
Optional Text Field 1, 2 or 3 values are imported and they adhere
to the validation rule set for that field, they will be added to the
Valid Value Fields list.

Click OK when you're ready.

Optional Fields Validation
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Chapter 6

Keyboard Commands

We understand the importance of being able to enter your data using
keyboard-driven commands as the mouse can sometimes slow down data entry.
We’ve made it possible for you to do almost all your work via keyboard commands.

Learning the keyboard shortcuts can help you cut down your data entry time, as they
allow you to move from field to field and window to window without having to
remove your hand from the keyboard to use the mouse.

We’ll describe how to work within each Adagio product using the keyboard later in
this chapter.
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Menus and Menu Commands
You will notice that the menus in each Adagio product display one underlined
character in the menu name, such as File or Edit. When you wish to access one of the
menus, simply press the Alt key and, while holding this key down, press the
underlined letter of the menu you want to access. For example, you would press
Alt+F to call up the File menu.

Depending on what window(s) you currently have open, you may
not be able to access the menus in this way. This is due to conflicts
between buttons within certain window(s) and the menus. You will
need to close the window(s) you are working in and then try to
access the menu you need again. In most cases, you can press
Escape to close an active window. Otherwise, select the OK,
Cancel, or Close buttons. A shortcut on a window overrides the
menu bar.

Once you have called up the menu of interest, you can select any of the commands
listed on that menu in one of two ways:

• Each command on a menu also has an underlined letter which can be used to
select that command. For example, if you selected the Edit menu by pressing
Alt+E, you can now select the Checks command in Adagio Checks by pressing
C. (Note that you do not need to press Alt to select a command; the Alt key is
only used to select the menu itself.)

• Use the Down Arrow and/or Up Arrow keys to scroll through the list of
commands. When the highlight is on the desired command, press Enter to
select it.

Menus and Menu Commands
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Buttons in Windows
Many Adagio product windows, such as Open Batches in Adagio Invoices, contain a
series of buttons down the right side of the screen. For example, the Open Batches
screen contains the following buttons:

• New
• Edit
• Rename
• Copy
• Delete
• Print
• Post
• Archive
• Listing
• Help
• Close

Similar to the menus, each button has one underlined letter. While working in such
screens, you can select any of the buttons by pressing Alt plus the underlined letter
on the button. To create a new batch in Open Batches, for example, you would press
Alt+N. By doing so, you are effectively selecting the New button.

You can also select a button in a window by pressing Tab repeatedly until that button
is highlighted, and then pressing Enter.

Buttons in Windows
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Moving from Field to Field
Within the windows of an Adagio product, you can move from field to field by
pressing the Tab key. Once in a field, you can:

• type in the necessary value.
• press the Down Arrow or F5 to activate the Finder.
• In the Finder window, use the Down Arrow and Up Arrow keys to scroll

through the list of values; highlight the desired value and press Enter to select
it.

• press F5, C, or the Down Arrow to activate the Calendar; or double-click in the
date field of interest.

• In the Calendar, use the Page Down key to move forward one month and the
Page Up key to move back one month. Once in the month you want, use the
Arrow keys to select the desired date. Press Enter to return to the date field. To
quickly move to the current date, press Home. Press End to be automatically
taken to the last day of the currently displayed month.

• press the Spacebar to turn a checkbox on or off.
• when presented with two or more radio buttons, use the Arrow keys to select

the desired button.
• press Enter to select a button.

Note that each time you press Tab, you move forward one field. If you wish to move
backwards, press Shift+Tab instead.

Moving from Field to Field
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Moving from Tab to Tab
Some Adagio product functions are split up into multiple screens, denoted by
“index” tabs that appear across the top of the function’s window. The Company
Profile in Adagio Payables is an example of this. Company Data is the first tab.

Moving from one tab to the next is much like moving from field to field. You must
first press the Tab key until the tab itself is selected (as indicated by a dotted line that
appears around the name of the tab). Then, move between tabs using the Arrow keys.
The Left Arrow key moves you back one tab to the left, while the Right Arrow key
takes you forward one tab, moving to the right. Ctrl+Tab “flips” to the next tab.
Shift+Ctrl+Tab “flips” back to the previous tab.

Moving from Tab to Tab
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Moving Between Windows
If you have more than one window open, you can move back and forth between the
open windows via the Window menu. For example, if you selected Edit | Staff
members in Adagio Time & Billing and then, without closing that function, selected
Edit | Files, you have multiple windows open and can toggle between these open
windows. Use the keystrokes Ctrl+F6 to move to the next open window, or
Shift+Ctrl+F6 to move back to the previous one.

You can also toggle between windows using the Window menu. Press Alt+W to call
up the Window menu. All of the windows you currently have open will appear in a
list at the bottom of this menu. Select the desired window by highlighting it (using
the Arrow keys) and pressing Enter, or by pressing the underlined number to the left
of the function’s name.

Moving Between Windows
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Miscellaneous Commands
• Pressing the F2 key in any grid or list (such as an Edit Accounts list) will open

the highlighted item on the list for editing. Pressing F2 has the same
functionality as clicking the Edit button.

• Pressing the F6 key in any grid or list that includes a Find button (such as the
Edit Accounts list) will automatically call up the Smart Finder. This allows you
to bypass the standard Finder that appears in the Find window, and directly
launches the Smart Finder.

Miscellaneous Commands
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Quick Reference

Key Command Explanation
Tab / Shift-Tab Move to next/previous item (entry field or button or

menu item or index tab)

Alt-"character" Move to item where "character" is Underlined (entry
field or button or menu item or index tab)

Enter � Execute the default button;
� Execute the default button for highlighted line in

grid;
� Create new entry in grid if last item in the grid is

highlighted

Ctrl-Tab /
Shift-Ctrl-Tab

Flip to next/prior index tab

Ctrl-C Copy selected data

Ctrl-X Cut (copy & delete) selected data

Ctrl-V Insert data that was Cut or Copied

F1 Context sensitive help

F2 While in any grid or list (such as an Edit Accounts list),
F2 will open the highlighted item on the list for editing.
Pressing F2 has the same functionality as clicking the
Edit button. (Applies to Adagio versions 8.0B and
higher only.)

F5 � Activate Finder in key field;
� Activate Calculator in numeric field;
� Activate Calendar in date field

� PageDown / PageUp - next/prior month
� Home - current date
� Arrows - select day of month
� End - last day of month
� Enter - return selected date

Quick Reference
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Key Command Explanation
F6 � Activate Smart Finder in key field or in Finder.

� While in any grid or list that includes a Find button
(such as the Edit Accounts list), F6 will automatically
call up the Smart Finder. This allows you to bypass
the standard Finder that appears in the Find
window, and directly launches the Smart Finder.
(Applies to Adagio versions 8.0B and higher only.)

F7 Activate Spell Checker in memo field

RightArrow /
LeftArrow

� Move right/left one character position;
� Select next/prior radio button:
� Move from grid to buttons (or vice versa);
� Flip to next/prior index tab if focus is on the tab

Ctrl-RightArrow /
Ctrl-LeftArrow

Move right/left one word

DownArrow /
UpArrow

� Select next/prior item in grid or drop-down field;
� Select next/prior radio button;
� Activate Finder in key field;
� Activate Calculator in numeric field;
� Activate Calendar in date field;
� Select next/prior value in type field

PageDown /
PageUp

Move to next/prior page in grid

End / Home Move to end/beginning of entry field;

Move to end/beginning of line in memo field

Ctrl-End /
Ctrl-Home

Move to end/beginning of last/first line in memo field

Spacebar � Select item in selection list;
� Special action in some grids (in Check Rec, spacebar

clears selected checks);
� Tick/Untick a checkbox;
� Execute selected button

End / Home � Move to last/first character in entry field;
� Move to last/first item in grid

Alt-Tab /
Shift-Alt-Tab

Move to next/previous Windows application

Quick Reference
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Chapter 7

Faxing

Several Adagio programs, as listed below, allow you to fax invoices, statements and
letters directly from your desktop.

You must complete two simple steps prior to faxing documents:

• Turn the Allow faxing option on in File | Options.
• Specify your preferred default and other faxing options in Fax | Fax Setup.

Fax options must be set for each individual user who intends to use the fax
feature.

Once you’ve completed the aforementioned steps, simply begin faxing by entering
the normal Print dialog box and, after choosing your regular print options, selecting
the Fax option in place of the Print option. Faxes can be sent immediately or at a
specified time.

If you have set your specification to print multiple copies, the fax
feature will only fax the first copy.

All faxed documents will appear in the Fax Queue for that Adagio module. Within
that fax queue, you can edit certain information for each fax, such as the fax number
and the fax status. You can also view or delete faxes.
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Fax Servers
If you are running Adagio on a network, only one machine with faxing capabilities
(namely, a fax modem) is required. Other users can print their faxes to the queue and
the machine with the faxing capabilities would then act as a fax server.

The fax server program runs within Adagio. However, other Windows applications
can run concurrently with the fax server.

Activating Faxing
To allow faxing of documents within an Adagio program, select Options from the
File menu. In the Options window that appears, click on the Allow faxing checkbox
and click OK.

Once you have activated the faxing feature, a Fax menu will be added to the Menu
Bar. As well, a Fax button will be added to the Print dialog boxes.

Fax Servers

Page 7-148 Adagio Fundamentals



Testing the Fax Feature
Before you begin faxing documents to your customers, you may want to test the fax
function. By editing the .INI file, you can set up the fax feature such that all faxes will
be faxed to the same number, regardless of the Fax number displayed in the Fax
Queue.

Activating the Test Mode
1) In a text editor such as Notepad, open the module.INI file, located in your

program directory. For example, if you’re testing faxing in Adagio Receivables,
you would open the Receivables.INI file located in the program directory
(usually C:\SOFTRAK\Receivables).

2) Under the [Fax - SYS] heading (where SYS is the user code, as set up in User
Maintenance), add the following line:

TEST=555-5555

where 555-5555 is the fax number you wish to use for testing.

Testing the Fax Feature
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Setting Up A User for Faxing
Each user who intends to fax documents must set up their preferring faxing options
in the Fax Setup function. To do this, follow these steps:

1) Select Fax Setup from the Fax menu. The Fax Options window appears:

2) The Send fax area of this window allows you to set default information
regarding when faxes should be sent. The option you select here is a default
only; it can be changed for each individual fax. You are given three options:

Field Description

Now Select this option if you will usually want to send
faxes immediately.

This option will not be available if you do not have a
fax modem installed or if you have not selected a Fax
port in the lower portion of this window. If you are
running Adagio on a network and have only one fax
server set up, all users except the fax server will need
to select either the Add to Queue or Schedule in
Queue options instead.

Setting Up A User for Faxing
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Field Description

Add to Queue Choose this option to add your faxed documents to
the queue, to be sent at a later, unspecified time.

Schedule in Queue Select this option if you generally prefer to schedule
the send time of your faxed documents. For example,
if you wish to fax your documents out during the
evening, while the fax machine is not busy, you could
select the Schedule in Queue option and leave the fax
server running when you leave the office. It will
automatically send the faxes at the specified time.

If you select this option, the Time field, in the upper
right-hand portion of this window, will become
active. Use the Time field to set the default time at
which scheduled faxes will be sent. Remember that
this time is a default only; it can be changed for each
individual fax.

If more than one fax in the queue is scheduled to be sent at the same
time, the fax server will simply fax the first fax in the queue at the
specified time (i.e. 6:00 p.m.) and then proceed on to the next fax,
until it has sent all of the scheduled faxes.

If the fax server is not running at the scheduled time, the faxes will
automatically be sent the next time the fax server is started up.

Setting Up A User for Faxing
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3) The middle section of this window gives you a number of options regarding the
information to be included with or on the fax:

Field Description

Header Enter any information you wish to include on the
header of each outgoing fax. A number of codes can
be used within the header, to provide the recipient
with certain pieces of information. They are:

� $D = today’s date in MM/DD/YY format; always
8 characters

� $I = station ID; variable length
� $N = total number of pages; variable length
� $P = actual page number; variable length
� $R = recipient’s name; variable length
� $F = sender’s name; variable length
� $S = title; variable length
� $T = current time in HH:MMpm format; always 7

characters

The default header is Page $P of $N, which would
print Page 2 of 3 on the second page of a 3-page fax,
for example.

Cover page If you wish to send a cover page with each fax, enter
the default cover page document here by either typing
in the drive, directory, and path of the cover page, or
by clicking the browse button to the right of this field.

Cover pages must be text files, and can use the codes
listed above. The file name must have a .TXT
extension and be in the same directory as your data.
Please see the section on Fax cover pages later in this
chapter for more information.

Station ID The text you enter here appears as identification
information on the recipient’s end. You might want to
enter your company name here, your fax number, or
some other piece of descriptive information.

4) The bottom portion of the dialog box is used to set up the actual fax modem and
dial-up information. If you are running on a network and have only one fax
server, only the fax server is required to enter this information.

Setting Up A User for Faxing
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Field Description

Fax port Select the port on which the fax modem is installed. If
you select an invalid port, you will receive a message
indicating that. You will still be able to enter the
remainder of the information, but when you actually
attempt to fax something, you will be unable to do so
until you have selected a valid port here.

Modem
initialization

This field can be left blank, or you can enter normal
modem commands here.

If you do need to add a modem command such as to
change the volume of you modem speaker then the
modem command would look like this:

M0

This would turn the modem speaker off for most fax
modems.

If you wanted to turn the volume on until connect and
set the speaker volume to High then the command
would look like:

M1L3

See the instructions that accompanied your modem
for more information on this and other modem
commands.

The AT is not required.

Setting Up A User for Faxing
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Field Description

Dialing prefix Enter any applicable dialing prefix here. For example,
if you must dial 9 to get an outside line, you would
enter 9, here.

Commas are used to create a pause in the dialing
process. Do not simply enter the prefix (i.e. 9) without
a comma; otherwise, the prefix and the fax number
itself will be run together and the send process will be
unsuccessful.

If you find that the pause is not long enough and your
faxes are not going through properly, you can enter an
extra comma here (i.e. 9,,).

Leave this field blank if no dialing prefix is required.

The fax function automatically adds a 1 to the
beginning of all long distance numbers, unless that
number begins with a 1 or 0 already.

Dialing suffix As with the Dialing prefix, enter any applicable
dialing suffix here, again using the comma to create a
pause. This time, however, the comma would go before
the suffix to create a pause between the dialing of the
number and the dialing of the suffix.

Suffixes might be used if your company requires you
to enter a long distance employee or department code.
For example, if your long distance employee code is
200, you would enter ,200 in this field.

Retry attempts (0-9) Enter the number of times you wish to attempt to
re-send a fax if the first attempt is unsuccessful. The
maximum allowable number of retries is 9. The
default is 3.

Retry delay (min) Enter the preferred number of minutes between each
retry. The default is 2.

5) When you have finished setting up your fax options, click OK to save your fax
setup information.

You are now ready to begin faxing.

Setting Up A User for Faxing
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Faxing Documents
This section describes only the information pertinent to the actual faxing of
documents.

Faxed documents are not flagged as printed.

1) Select the invoices (or batches) you wish to fax and then click Print.

2) In the Print dialog box, verify all of your printing options. When you are ready to
proceed, click Fax. A Fax Print Options dialog box will appear.

3) In the Send fax portion of this dialog box, select one of these options:

• Now sends the fax(es) immediately. Only available if you have a fax card
installed.

• Add to Queue adds the fax(es) to the Fax Queue, to be sent at a later,
unspecified time.

• Schedule in Queue adds the fax(es) to the Fax Queue, to be sent at a specified
time and date.

4) If you selected Schedule in Queue as your send option, the Date and Time
fields will become active.

The Date field always defaults to today’s date; however, it can be set to any date
you wish just by clicking the Calendar button and selecting an alternate date.

Faxing Documents
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The Time field defaults to the time you specified in the Fax Setup window (see
Setting up a user for faxing earlier in this chapter for more information). To change
the time, simply delete the displayed time and type in the time you prefer.

If you enter a time without specifying am or pm, the program will
automatically schedule it in the morning hours, unless you enter the
time in military hours. For example, if you simply entered 7:00, it
would schedule the fax for 7:00am. If you entered 19:00, the fax
would be scheduled for 7:00pm instead.

5) When you have indicated your preferences in this dialog box, click OK. Your
invoice(s) will be printed to fax and either faxed immediately or added to the
queue.

Faxing Documents

Page 7-156 Adagio Fundamentals

Note



Working with the Fax Queue
All faxed documents appear in the fax queue, whether they were faxed immediately
(using the Now radio button), were scheduled for faxing at a later time, or were
simply added to the queue to be faxed at your convenience.

To access the Fax Queue window, select Fax Queue from the Fax menu. The
following screen appears:

Working with the Fax Queue
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The Fax Queue screen lists the faxes by Status, and, by default, displays six pieces of
information about each fax.

Column Description

Status Faxes can have one of six possible statuses:

� If the status column is blank, the fax is ready to
send. It has not been sent yet and is not scheduled
to be sent at a particular date and time.

� C means the fax has been completely sent; it has
been sent successfully.

� H indicates that the fax is on hold. Note that any
faxed invoice for whom the customer does not
have a fax number will be automatically placed on
hold, and cannot be sent until you supply a valid
fax number.

� I means that the fax was attempted but was not
sent successfully; it is incomplete.

� S indicates that the fax is scheduled to be sent at a
later date and time.

P tells you that the fax is currently in progress.

Sch. Date For scheduled faxes, indicates the date at which the
fax is to be sent. For all other faxes, displays the date
at which the fax was added to the queue.

Sch. Time For scheduled faxes, indicates the time at which the
fax is to be sent. For all other faxes, displays the time
at which the fax was added to the queue. Time is
displayed in military hours.

Send To Displays the name of the customer to whom the fax is
being sent.

Fax Number Indicates the recipient’s fax number. If this column is
blank, the fax will be automatically placed on hold
and cannot be sent until you have entered a fax
number in the Edit function.

Working with the Fax Queue
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Column Description

Last Message If the fax has been sent, or an attempt has been made
to send the fax, the last message received by the fax
server will appear here. For example, this column
might indicate that the fax was sent successfully, or it
might indicate that the line was busy on the last
attempt.

The information that appears on this screen can be changed via the
Column Editor. See the “Column Editor” section in Chapter 4 of
this manual for details.

Several buttons appear down the right-hand side of this window. They are:

Button Description

Send Now Click this button to send the selected fax(es)
immediately.

This button is grayed out if the user does not have
faxing capabilities.

Edit Use this button to edit the status of, the recipient
information for, or the header and cover page
information of the selected fax.

Delete Delete the selected fax(es) by clicking this button.

Refresh In a multi-user environment, use this button to refresh
the list of queued faxes, to reflect any changes or
additions other users have made to the queued faxes.

View Fax Preview the fax by clicking this button.

Print Fax Prints the selected fax(es) to your printer.

Working with the Fax Queue
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Button Description

Fax Server Click this button to start the fax server.

When faxes are sent to the Queue, they will not be
sent unless the Fax Server button is selected on the
Fax Queue screen. This means that the station with
access to Adagio and an attached modem must open
the fax queue screen and click the Fax Server button.
If the scheduled time to send the fax has passed, the
fax will be sent. If the fax is schedule to be sent at a
time in the future, the faxing procedures will skip this
fax until the scheduled time is reached (and the fax
server is still active).

Therefore, in order to have faxes sent immediately
from users who do not have workstations with
modems, there needs to be a workstation with a fax
modem that has that Adagio module open and the
Fax Server running from the Fax Queue screen in the
Adagio module that faxes are being submitted from.

Help Access on-screen Help about this function.

Clear All Clears all completed faxes from the queue.

Close Exit the Fax Queue window.

Sending Faxes Immediately
Faxes with any status other than C(ompleted) can be sent immediately by clicking on
the fax(es) of interest and then clicking the Send Now button. This option is only
available if the user has faxing capabilities.

• To select one fax, click that fax on the list.
• To select multiple contiguous faxes, click the first fax you wish to send and,

while holding down the Shift key, click the last fax you wish to send. The two
clicked-on faxes, plus all faxes in between, will be selected.

• To select multiple noncontiguous faxes, click the first fax you wish to send,
then hold down the Ctrl key while you click the other faxes you wish to send
in turn.

Working with the Fax Queue
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Editing Fax Information
If you wish to change the status of a fax, alter the scheduled date and time for a
scheduled fax, or make changes to a variety of other fax options, follow these steps:

1) Click the fax you wish to edit to select it, and then click Edit. Alternatively, you
can simply double-click the fax of interest. The following window appears:

2) Change the fax status or other information as desired. Please note the following
information about select fields on this screen:

• The status of a fax can be changed by clicking the down arrow to the right of
the Status field and selecting any one of the six statuses that appears. Your
options here are the same as the statuses that are listed earlier, under the
Working with the Fax Queue heading.

• If you wish to direct this fax to the attention of a particular person, you can
enter that individual’s name in the Send to field. By default, this field contains
the company name.

• The user name of the individual who faxed the document is entered in the
From field; this information can be edited if desired.

• The Fax header field displays the header information for this fax. See the
information on the Header field in the section entitled Setting up a user for
faxing earlier in this chapter for more information.

This information is taken from the default settings in the Fax | Fax Setup
function. It can be changed for individual faxes by editing this field; however,
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if you want to change the default header itself, you must do so in Fax Setup.

• If a cover page is going to be sent with the fax, the name of the text file to be
used will appear in the Cover page field.

This information is taken from the default settings in the Fax | Fax Setup
function. It can be changed for individual faxes by editing this field; however,
if you want to change the default cover page file itself, you must do so in Fax
Setup.

• The Station ID field displays the name of the program from which the fax
originated. This can be changed, if desired.

• The Last message and Last attempt fields will display information about the
last time the fax server attempted to send this fax, provided that an attempt
has been made at all. The last message received by the fax server will appear;
for example, this column might indicate that the fax was sent successfully, or it
might indicate that the line was busy on the last attempt. Also, the date and
time of the last attempt will appear.

• The document number is displayed in the Key field. This is for your
information only; this field cannot be edited.

• The Application field indicates the application from which the document was
printed. This field is for your information only and cannot be edited.

• The Fax File field indicates the name of the file in which the fax is actually
stored. All faxes are automatically assigned names beginning with their
product prefix and the letters FX. For example, an Adagio Receivables fax
would have a prefix of CRFX. The four-digit number following the prefix is
automatically generated. This field cannot be edited; it is for your information
only.

All faxes use the extension .FAX and are located in a subdirectory
called \SOFTFAX, off your data directory.

3) When you’re finished, click OK to save your changes.

Deleting Faxes from the Queue
Faxes can be deleted regardless of status. However, generally you will only want to
delete faxed with a C(ompleted) status. You should delete C(ompleted) faxes on a
regular basis, to save disk space and to pare the queue down to only faxes that have
some current relevance. This will make the queue easier to work with.

To quickly delete all completed faxes, click the Clear All button.

Faxes can be deleted by clicking on the fax(es) of interest and then clicking the Delete
button.
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• To select one fax, click that fax on the list.
• To select multiple contiguous faxes, click the first fax you wish to send and,

while holding down the Shift key, click the last fax you wish to send. The two
clicked-on faxes, plus all faxes in between, will be selected.

• To select multiple noncontiguous faxes, click the first fax you wish to send,
then hold down the Ctrl key while you click the other faxes you wish to send
in turn.

Fax Queue Listing Report
New releases of Adagio programs now give you the ability to print a report with
details about the faxes listed in the queue. This is helpful if you’ve queued up many
faxes and wish to review the list to check into faxes that didn’t go through
successfully, for example.

To print this report, select Fax Queue Listing from the Fax menu. The following
window appears:
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The fields and options presented to you in the Print Fax Queue Listing window are
described in the following table.

Field Description

Print these statuses You are given a list of possible fax statuses. Put a
checkmark beside all of the statuses you wish to include
on the report, or ensure the checkbox is empty to exclude
certain statuses.

For example, if you only want to print faxes with a status
of “Incomplete”, you would check that option and turn
the other checkboxes off.

Sort By Select the fields you wish to sort the report by. You can
sort by:

� Fax Status;
� The Application the fax originated from, which is the

two-character code for the Adagio application, such
as AR for Adagio Receivables;

� The Fax number of the customer;
� The Invoice key, which is the customer number; or
� The Fax to, which is the customer name.

Choose up to three different sort fields, and, where
desired, indicate the ranges you want included on the
report.

Destination Indicate whether you wish to print the report to a
printer, the screen, or a file.
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Long Distance Dialing Rules
For those Adagio programs that allow faxing, the faxing function has been enhanced
to allow for the creation of special long distance dialing rules.

Due to population increases, some major cities are now divided by more than one
area code, which makes dialing fax numbers a little more complicated. For example,
if you live in a city that uses two area codes, you may need to dial a different area
code to fax others in the city, and your phone company may or may not require you
to dial 1 before entering the number. Adagio now allows you to set up Long Distance
Dialing Rules which can allow for such exceptions.

This system is set up so that you only need to enter rules for the exceptional cases. If
your city does not have any such exceptions, turn the Activate Adagio long distance
rules? field off. Adagio will dial all numbers exactly as they are entered.

Important notes on creating these rules:

• You can have Adagio automatically add a default area code to all seven digit
numbers by turning on the Include area code on seven digit numbers? field. In
other words, whenever you enter a number without an area code, the default
area code, which you enter in the Local area code field, will be added to it.

• A prefix is the first three numbers of the seven-digit number. For example, in
the fax number 555-1234, the prefix is 555. Certain prefixes in your area may
require the area code while others may not. You can create rules for certain
prefixes in your area. To do this, add the area code, then select Only selected
and add the prefixes that require the special rule.

• If a rule will operate for all prefixes in an area code, select All prefixes for the
rule.

• For each rule, select Dial 1 when dialing if the area code requires you to dial a
1 before the number. Select Include area code when dialing if the number
requires that you use the area code.

• The order that you enter the area codes is important. Adagio will follow the
first rule that matches the situation, and will then ignore any following
matches. For example, in some cities you may need to enter two separate rules
for the same area code. Some prefixes in the area code may require one rule,
while others may require another rule. To insert a rule in the middle of the list,
select a rule in the list, then click New. The new area code rule will be added
above the selected rule.

• If a number does not match any of the rules, Adagio will dial seven-digit
numbers exactly as entered, but it will add a 1 to any 10-digit numbers (so
long as the 10-digit number does not start with a 0 or a 1). This is so that you
only need to enter area codes that are the exception to the standard.
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Adding Long Distance Rules
To enter Long Distance Dialing Rules, select Fax | Long Distance. The Long Distance
Dialing Rules dialog will open.

This dialog box has three components:

• The first three fields allow you to set general fax dialing rules.
• The next section, Area Codes, displays a list of all dialing rules you’ve already

defined.
• The third section, Dialing Rules, is used to edit existing rules or create new

ones.
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General fax dialing rules
This section of the window has three fields:

Field Description

Activate Adagio long
distance rules?

You only need to enter dialing rules if you have
exceptional cases. If your city does not have any
such exceptions, turn this field off. Adagio will dial
all numbers exactly as they are entered. If this
checkbox is turned on, then Adagio will check and
use the dialing rules entered here when dialing any
fax number.

Local area code You can have Adagio automatically add a default
area code to all seven digit numbers; the default
area code used in such a case would be the area
code entered in this field.

Include area code on seven
digit numbers?

You can set Adagio automatically add the area
code entered in the field above to all seven digit
numbers by turning on this checkbox. In other
words, whenever you enter a number without an
area code, the default area code, which you enter in
the Local area code field, will be added to it.

Area Codes section
The Area Codes portion of this window displays a list of all dialing rules that have
already been set up. Rules are listed by area code, and display a list of prefixes in that
area code that are affected by the dialing rule, and a synopsis of the dialing rule(s)
imposed on the area code and prefixes.

To edit an existing rule, select it in the list by clicking it once, and then click Edit. To
add a new rule, click the New button.
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Dialing Rules section
This section of the window is where you can edit or create dialing rules. It contains
the following fields and buttons:

Field / Button Description

Area Code Enter the area code for the dialing rule in this field.

Include:
All Prefixes / Only Listed

Use these radio buttons to indicate whether the
dialing rule will affect all prefixes in the area code,
or whether it will affect only those prefixes you
indicate. (To add prefixes to the list of what should
be affected by this dialing rule, click the Add
Prefix button.)

Dial 1 when dialing Click this checkbox if you want Adagio to dial 1
before the area code and prefixes specified.

Turn this checkbox off if “1” doesn’t need to be
dialed for the area codes and prefixes specified.

Include area code when
dialing

Turn this checkbox on if you want Adagio to
include the area code when dialing.

If you’re in a city where you need to dial 1 before
certain prefixes, but don’t need the area code as
well, then you can turn this option off. The area
code will be excluded during dialing.

Add Prefix Use this button to add a prefix in this area code
that will be affected by the dialing rules. Note that
this button will only be available if you’ve selected
the Only Listed radio button.

Add Range Use this button to add a range of contiguous
prefixes in this area code that will be affected by
the dialing rules. Note that this button will only be
available if you’ve selected the Only Listed radio
button.

Delete Prefix To delete a prefix so that it is not included in this
area code’s dialing rules, click the checkbox by the
prefix in the list, and then click this button.
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Field / Button Description

OK When you’re finished entering the dialing rule,
click OK to save it.

Cancel If you want to discard changes you’ve made to a
dialing rule, click Cancel.

Fax Cover Pages
You may want to include a cover page with your faxes. If so, you will need to create
a text (.TXT) file and save it in your data directory. You can then enter the file name
in the Cover page field in the Fax | Fax Options command; it will be included with
each outgoing fax automatically, unless you override this default by editing the
individual fax in the Fax Queue prior to sending it.

Adagio allows you to include up to eight different pieces of information on the fax
cover page, using the following codes:

• $D = today’s date in MM/DD/YY format; always 8 characters
• $I = station ID; variable length
• $N = total number of pages; variable length
• $P = actual page number; variable length
• $R = recipient’s name; variable length
• $F = sender’s name; variable length
• $S = title; variable length
• $T = current time in HH:MMpm format; always 7 characters

Using these codes combined with straight, hard-coded text, you can create simple
cover pages.

Fax Cover Pages
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Chapter 8

Emailing

Certain Adagio programs allow you to email invoices, credit notes, statements and
letters directly from your desktop. Emailed documents are always sent as
attachments in PDF format.

PDF files are opened with Acrobat Reader from Adobe. Acrobat
Reader’s PDF is the most popular file format for distribution of
files over the Internet. If you need more information please visit
adobe.com.

To begin using the e-mail statement option, you must first set up your Adagio
module. This involves a few simple steps:

• Activate the email functionality on the Program | Options window. The
Email menu will not appear if this checkbox has not been turned on. See the
above section entitled “Program Options” for more information.

• Set up your e-mail options on the Email or Fax/Email Setup menu to indicate
the return address that should appear on your e-mails. In new modules, the
SYS user is able to complete the email setup and save it for all users.

• Set up your cover letters for your e-mails. Adagio will use the cover letters as
the text of the actually e-mail files, and then will attach the document to the
e-mail in PDF format.

• Enter customer e-mail addresses in each customer’s file, through the Edit
Customers function. (You can also import their email addresses using the File
| Import | Customers function in some Adagio modules.)

Once you have taken care of the steps, you can email documents through the Batch
windows; or you can email statements through the standard Reports menu, just as
you would normally print or fax statements. The following sections will explain how
to set up Adagio in each of these areas, and how to use the Email Queue.
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Email Setup
Emails to your customers should include a return email address so that if customers
have any questions about the document you emailed them, they can simply hit
“Reply to” on their email and their question will get sent to the appropriate
department.

To set your return email address, select Email Setup from the Email or Fax/Email
menu. The following window will appear:

Use the following table to complete the fields on this window:

Field Description

Return address In this field, enter the address you like to have appear
on your emails as you company’s return address. The
email address you enter should be the address of the
department or person who will be able to field
customer questions and concerns about their invoices,
credit notes, or statements.

Email Setup
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Field Description

Request receipt If you would like to receive confirmations that
emailed documents and statements have gone
through successfully and that the customer has
received them, turn the Request receipt checkbox on.
This will send an email back to you each time a
customer opens and acknowledges an email from
you. If you are using email documents and
statements for the bulk of your customers, you may
wish to leave this option off as it will generate a lot of
email back to you. If you are only using email for the
occasional customer and wish to ensure proper
receipt of those emails, you can turn this option on if
you wish.

NOTE: Turning this option on does not guarantee
that you will get return receipts for the emails you
send. Some email programs disable the ability to send
receipts, for security reasons. Other programs may
prompt the user to send a receipt and if the user
chooses not to, none will be sent; or the user may
agree to send a receipt and, due to security issues,
none will be sent.
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Field Description

Email method If you want to use your default email program, such
as Outlook, to send your emails, choose Mapi as your
email method. This will cause Adagio to generate all
emails in your email program itself, and all sent
emails will appear in that email program’s outbox.

Sometimes the Mapi method is not the best option,
however. Because of viruses that auto-generate emails
from other programs, many email clients have
blocked or limited the ability to auto-send emails
from any other applications.

For example, in Outlook 2003 if you try to send emails
from Adagio through Outlook, the program will ask
you once if you want to allow an external application
to send email; and then, if you click Yes, it will also
require that you click OK for each individual email
you attempt to send -- and will require that you wait
five seconds for each one before you can click OK.
Obviously, this is impractical for sending numerous
emails.

In cases where using the Mapi email client option
creates security problems such as this, you may wish
to use the Direct method instead. This method sends
the emails directly from Adagio using the email
server information you provide in the fields below.

Direct mail options: If you use Direct as the Email method, you will need to
complete the following fields. These fields are not available for the Mapi
method.

Mail server Enter your mail server here. For example:
mail.softrak.com. Your internet service provider can
tell you the name of the mail server.

Display name Enter the name you wish to have appear in the
“From” field of the email that the recipients receive.

Server requires
authentication

If your email server requires authentication -- that is,
a username and password -- turn this option on, and
then complete the fields below.

Email Setup
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Field Description

Account name Enter the account (user) name for your email.

Password Enter the password used for the above account.

Port If your internet service provider uses an email port of
other than 25 (the Adagio default), enter the ISP port
number here.

At time of writing, not all features are available in all
current modules.

To ensure that your email has been set up properly, click the Test email button.
Adagio will ask you:

Click Yes to proceed with the test. The email will be sent to the Return address you
specified in the Email Setup window.

To save your email options, click OK.

Set All Users button
This button is only visible if you are logged in as SYS, the Adagio system
administrator. As well, at the time of writing, the feature may not be available in all
current releases.

If the Email Setup should be used by all users of this company dataset, when you
have finished entering the settings and tested them, click the Set All Users button.
The Email Setup window will close and any existing email settings for users will be
overwritten by the settings entered by SYS.

However, if a user has been granted access to Email Setup in Group Security, they
will still be able to change their own settings.

Email Setup
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Cover Sheets
When you send out an email documents and statement to customers, the document,
statement or letter itself will be attached to the email in PDF format. However, you
will also want to include some text in the email itself so that the customer knows
what is attached and has other information about their document, letter or statement,
as you see fit.

Cover sheets are created through the Email Cover Sheets function. To begin working
with your cover sheets, select Email Cover Sheets from the Edit menu. The following
window appears, listing all of your cover sheets currently on file.

Cover Sheets
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To create a new cover sheet, click the New button. A blank Edit Email Cover window
will appear:

Cover Sheets
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Use the following table to complete your email cover sheet:

Field Description

Email cover Assign this cover sheet a short code to identify it.
When you go to print statements or letters from the
Reports menu, or to email invoices or credit notes,
you will be able to select an email cover sheet to
include. Since there may be any number of reasons
that you’re emailing a customer through this function,
you may wish to have different cover sheets to cover
each possibility. For example, you may wish to have
one cover sheet which is very general to be used
monthly to email all of your customers their
statements. You may also wish to have a different
cover sheet to use periodically when you’re emailing
customers whose accounts are in arrears. Since each
of these purposes are different, you should choose a
code for this cover sheet which reminds you of its
purpose.

Your code can be up to six characters in length, and
should be descriptive in some way, such as MONTH
for the monthly statements you email out regularly.

Description Use this field to further clarify the purpose of this
cover sheet. For instance, if you used MONTH as
your email code, you may wish to enter “Monthly
statements” here.

Subject line In this field, enter the subject line for the email.
Continuing on with our monthly statement example,
if this cover sheet was for general monthly statements
to customers, you may wish to enter something like
“Monthly Statement from Adagio Corp.”. This will
identify the purpose of the email at a glance to your
customers when the email arrives in their inbox.

You may also enter fields from the field tree at the
right in the subject line. Please read the information
on the Cover letter field below for details on how to
insert fields.

Cover Sheets
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Field Description

Cover letter This section of the window is where you will write
the body of your cover sheet. See the section below
for complete information.

Writing Your Cover Sheet/Letter
In the Cover letter section of the window, you can write the body your cover
letter/sheet. You can write straight, hard-coded text, or you can mix hard-coded text
with fields from the field list at the right, both to personalize the email and to include
important information such as balance outstanding.

For hard-coded text, you would simply type your message in this field. However, it
is more likely that you will wish to include some of the fields from the right. To do
this, place your cursor at the spot in the text where you wish a field to appear. For
example, if you wish to personalize each email with the recipient’s name, you can
type “Dear ”, then, leaving your cursor after the space, move your mouse to the
right-hand window and click the plus sign beside Customer Data, then the plus sign
beside Profile to expand the list of possible fields that you can insert. From the list,
locate the Contact field and double-click it to insert it at the spot where you left your
cursor.
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The Adagio Receivables sample data includes the following example of a cover
letter/sheet; in addition, this sample cover letter is also included each time you create
a new Receivables data set. You may wish to review this example to see how to put a
cover letter together, or copy and modify this letter to suit your own needs.

When you are finished, you can ensure that your cover sheet will appear as you wish
when emailed by clicking the Preview button. When you do so, Adagio asks you for
a customer code to use as a sample:

Select a customer code using the Finder, and then click OK. In the Edit Email Cover
window, the fields that you inserted from the right hand box will be replaced with
that customer’s data. Review the cover sheet, and then click Close Preview to return
to the edit mode.

Cover Sheets
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When you’re satisfied with the cover letter, click OK to save it. It will be added to
your list of cover letters, which you can then select whenever you email customers.

Editing Cover Sheets
Cover sheets can be modified as needed. To change a cover sheet, select Email Cover
Sheets from the Edit menu. The Email Covers window appears, listing all of your
cover sheets currently on file. Select a cover sheet to edit by double-clicking on it. The
cover sheet will open and you can modify it however you require, in the same way
that you would create a new one, as described above.

Copying Cover Sheets
If you wish to make a copy of a cover sheet, perhaps to create a new cover sheet that
is very similar to an existing one, you can select it from the Email Covers window,
and then click Copy. You will be asked to enter a new code for the cover sheet. Once
you do so, it will be added to the list of available cover sheets, and you can then edit
it is needed.

Deleting Cover Sheets
If you want to delete a cover sheet, you can select it from the Email Covers window,
and then click the Delete button. You will be asked to confirm the deletion; if you’re
sure that you want to delete the specified cover sheet, click OK and it will be
removed from the list.

Setting Up Customers for Email
Using the Edit | Customers function, you can open each customer file and add an
email address to their data, so that you can email documents or statements to them
whenever you wish. To edit the customer, double-click on that customer name in the
Edit Customer List, and their customer file will open. Click on the Statements tab to
make the changes required. See your Adagio Receivables manual for more detailed
information.
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Emailing Statements & Letters
Once you have set up Adagio for emailing, you can begin using the email feature by
opening a batch window and using the Email button instead of the Print button, or
by selecting Reports | Statements/Letters and using the Email button.

For Adagio Receivables statements and letters, see the section on Reports later in this
addendum for more information.

For other Adagio modules where you are faxing documents, just follow the same
process for emailing as you would for printing.

Adagio Receivables

Letters Option
When you choose Letters as your Document type in the Print Statements/Letters
window, you will see one additional option which does not apply to Statements.

The Email attachment? checkbox appears when you’ve chosen to print Letters.
When you turn this option off, the specification file listed on the left will not be
included in the email as an attachment.

You may want to turn this option off if you are sending an email cover sheet to
customers and the cover sheet itself includes all of the necessary information, and so
a specification file is not required.

Emailing from History
In some cases, history transactions can also be emailed. If this is the case, a Print
button will appear on the History window(s). From the Print dialog, you will be able
to fax as normal.

Emailing Statements & Letters
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Email Queue
All emailed documents appear in the email queue, whether they were emailed
immediately (using the Now radio button), were scheduled for emailing at a later
time, or were simply added to the queue to be emailed at your convenience.

Working with the Queue
To access the Email Queue window, select Email Queue from the Fax/Email or
Email menu.

The name of the menu used for email functions may either be
“Email” or “Fax/Email”, depending on whether you have enabled
both faxing and emailing in your Program Options.

The following screen appears:

Email Queue

Page 8-184 Adagio Fundamentals

Note



The Email Queue screen lists the emails by Status, and, by default, displays six
pieces of information about each email.

Column Description

Status Emails can have one of three possible statuses:

� If the status column is blank, the email is ready to
send. It has not been sent yet and is not scheduled
to be sent at a particular date and time.

� C means the email has been completed; it has been
sent successfully.

� H indicates that the email is on hold. Note that any
email statement for whom the customer does not
have an email address will be automatically placed
on hold, and cannot be sent until you supply a
valid email address.

Date Displays the date on which the email was added to
the queue.

Cust / Name Displays the customer code and name for the
customer to whom the email is being sent.

Email To Displays the email address to which the statement
will be or has been sent.

This list can be sorted by email Status, by the Date the email was added to the queue,
or by the Customer code. Just click the appropriate radio button at the top of the
queue window to change the sort order.

Several buttons appear down the right-hand side of this window. They are:

Button Description

Send Click this button to send the selected email(s)
immediately.

Send All Click this button to send all unsent emails
immediately.

Email Queue
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Button Description

Edit Use this button to edit the status of or the email
method or the recipient email address for the selected
email. You can also change the email cover sheet for
the selected email.

Delete Delete the selected email(s) by clicking this button.

View Preview the email attachment by clicking this button.
This button will open up the email attachment in
Adobe Acrobat Reader. It will not display the email
cover letter.

Clear Clears all completed emails from the queue.

Help Access on-screen Help about this function.

Close Exit the Email Queue window.

Sending Emails Immediately
Emails with any status other than C(ompleted) can be sent immediately by clicking
on the email(s) of interest and then clicking the Send button; or by using the Send
All button to send all unsent emails at once.

• To select email, click that email on the list.
• To select multiple contiguous emails, click the first email you wish to send

and, while holding down the Shift key, click the last email you wish to send.
The two clicked-on emails, plus all emails in between, will be selected.

• To select multiple noncontiguous faxes, click the first email you wish to send,
then hold down the Ctrl key while you click the other emails you wish to send
in turn.
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Editing Email Information
If you wish to change the status of an email or to make changes to the mail method or
email address, or to change the email cover letter, double-click on the email of
interest to open it. The following window appears:

You can change the following fields on this screen:

Field Description

Status The status of an email can be changed by clicking the
down arrow to the right of the Status field and
selecting any one of the three statuses that appears.
Your options here are the same as the statuses that are
listed earlier, under the Working with the Queue
heading.

You may wish to change an email’s status if, for
example, you learn that a customer’s email address is
incorrect and you wish to re-send it to another email
address by changing the status from Completed to To
Send.

Email Queue
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Field Description

Mail method As described earlier in this addendum, under Email
Setup, you can choose to send emails through your
email client (such as Outlook) or directly through
Adagio. If you need to change the mail method due to
problems with your email client or something similar,
then you can do so here.

Email to The email address for the recipient is displayed here,
and can be modified if needed.

Cover The email cover sheet that was used when this email
was sent (or added to the queue) is displayed here; it
can be changed by clicking the Finder button and
selecting a different cover letter from the list.

Other fields that appear on this screen cannot be edited, and appear for your
information only. They are:

Field Description

Generated Indicates the date and time that the email was added
to the queue.

Last sent If the email has already been sent before, this field will
display the date and time that the email was sent. It
can be useful information if the customer calls and
inquires about an email statement, so that you can
verify not only that it was sent, but can see when it
was sent.

Customer This field displays the customer information for this
email.

User Displays the name of the user who generated the
email (added it to the queue via the Reports |
Statements/Letters function).

Email Queue
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Field Description

Attachment Indicates the file name of the PDF file that was/will
be sent to the customer. This is the auto-generated
PDF file of the letter or statement you chose to send to
the customer. The PDF files displayed in this field get
generated in a sub-directory of your main data
directory; the sub-directory is called SOFTMAIL. For
example, if your data directory is
C:\SOFTRAK\DATA, then the PDFs will appear in
the C:\SOFTRAK\DATA\SOFTMAIL directory.

Emails are considered to be “added to the queue” even if they were
sent immediately using the Now radio button when they were
generated. They appear in the queue whether they are still
outstanding or are already sent, until the queue is cleared.

When you’re finished, click OK to save your changes.

Deleting Emails from the Queue
Emails can be deleted regardless of status. However, generally you will only want to
delete emails with a C(ompleted) status. You should delete C(ompleted) emails on a
regular basis, to pare the queue down to only emails that have some current
relevance. This will make the queue easier to work with.

To quickly delete all completed emails, click the Clear button.

Emails can also be individually deleted by clicking on the emails(es) of interest and
then clicking the Delete button.

• To select one email, click that fax on the list.
• To select multiple contiguous emails, click the first email you wish to send

and, while holding down the Shift key, click the last email you wish to send.
The two clicked-on emails, plus all emails in between, will be selected.

• To select multiple noncontiguous emails, click the first email you wish to send,
then hold down the Ctrl key while you click the other emails you wish to send
in turn.

Email Queue Listing Report
The Email Queue Listing feature on the Fax/Email or Email menu prints a report
with details about the emails listed in the queue. This is helpful if you’ve queued up
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many emails and wish to review the list to check into emails that were put on hold
because the customer file does not include an email address, for example.

To print this report, select Email Queue Listing from the Fax/Email or Email menu.
The following window appears:

The fields and options presented to you in this window are described in the
following table.

Field Description

Print these statuses You are given a list of possible email statuses. Put a
checkmark beside all of the statuses you wish to include
on the report, or ensure the checkbox is empty to exclude
certain statuses.

For example, if you only want to print emails with a
status of “On hold”, you would check that option and
turn the other checkboxes off.

Email Queue
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Field Description

Sort By Select the fields you wish to sort the report by. You can
sort by:

� Email Status;
� Customer number;
� Customer name;
� The Date the email was added to the queue;
� The User who added the email to the queue.

Choose up to three different sort fields, and, where
desired, indicate the ranges you want included on the
report.

Destination Indicate whether you wish to print the report to a
printer, the screen, or a file.

Email Queue
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Chapter 9

Designer

Many of Softrak’s Adagio products include a specification editor that allows you to
create and modify specifications for printing checks, invoices, bills, picking slips,
orders, etc... We call this specification editor the Designer.

If you are using Adagio Ledger, a Financial Reporter manual will
have been shipped to you. Use the Financial Reporter manual to
learn how to create financial statements for Adagio Ledger or
Adagio FX.
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About the Designer
The Designer used in Adagio products is a powerful, visual tool that allows you to
create personalized documents to meet your company’s needs. And because the
Designer is based on the “WYSIWYG” principle, “What You See Is What You Get,” it
is easier than ever to create your documents.

When you use the Designer to create documents, it is easy to achieve a highly
professional look in very cost-effective ways, since you can print your documents on
the paper or forms of your choice. This includes the ability to use the same blank
check stock for all of your banks and accounts in Adagio Checks and Adagio
Payables. (You may need magnetic toner to print the MICR encoded bank transit and
account information at the bottom of each check.)

The Designer is a flexible, valuable tool that can create documents that contain any
combination of customer/vendor and transaction information. Not only does the
Designer allow you to specify what information you want included on your
documents, it also lets you decide how you want that information presented.

Using the Designer, you can create documents that take full advantage of Windows
formatting capabilities, such as the ability to:

• add graphics such as your company logo to your invoices, checks, receipts,
picking slips, quotes, and so forth,

• insert lines of any length and width, to add some structure and visual appeal,
• insert rectangles or ellipses to add even further visual flavor, or to draw

attention to important information,
• add color,
• use many different fonts, as well as bolding, underlining, italicizing, and

different font sizes throughout your documents, for various purposes.

The Adagio products were designed to be used with laser printers.
We strongly recommend using a laser printer rather than a dot
matrix printer.

About the Designer
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Setting Up Your Documents
If your company uses documents which are similar to those in one of the sample sets,
you can use them as a template for your own documents.

If, however, you need to create your own specifications from scratch, there are two
basic steps involved in this process:

1) Using the Designer, write a specification which covers all of the document
information. To access the Designer from any Adagio product, select Maintain
Specifications from the Maintenance menu.

2) Test the specification and fix any problems. Print a test document, then make
any necessary changes to the specification. Repeat this process until you are
satisfied with the end result.

Setting Up Your Documents
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Terminology
There are several terms used in this section which should be clarified before you start
designing and writing your own specifications:

Term Definition

Bitmap A picture, such as clip art, in .bmp file format that can
be placed anywhere on the specification page. Prints
on the document exactly as it appears on the
specification. Can be used to place your company logo
on a check or invoice.

Detail sections The sections of a document that contain detailed
transaction information.

Field See Information code.

Footer section The bottom section of a document which contains no
detail lines; usually contains the invoice total, check
amount, or something similar, depending on the
Adagio application you are using.

In most Adagio applications, you can create more than
one type of footer section.

� A Page footer section would appear on all pages
except the last one, unless it was the only footer
section on the specification. In that case, it would
appear on all pages of the document.

� A Last page footer section would appear only on
the last page of a document. If your document is
only one page long, this section would appear on
that single page.

Graphic Anything beyond straight text and information codes;
namely, lines, shapes, and bitmaps.

Terminology
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Term Definition

Header section The top section of a document which contains general
information such as the vendor or customer name and
number as well as the transaction number and date.

In most Adagio applications, you can create more than
one type of header section.

� A Page header section would appear on page one
of the document. If your document is only one
page long, this section would appear on that single
page.

� A Second page header section would appear on all
pages of a document except the first page.

Horizontal line A horizontal rule placed on the specification page.
Most often used as a separator such as a long line
extended across a series of headings on an invoice, a
separating line between a breakdown of the items the
invoice is covering and the total amount due for those
items. A horizontal line may also be used for signature
lines on checks.

Information code A code that specifies which piece of information is to
be placed on the document at a given point; entered as
fields from the Spec List in the Designer.

Label Text that is part of the specification and that prints on
the documents exactly as it was typed into the
specification. Labels cannot exceed one line of text.

Lasso A tool in the designer that “catches” all objects wholly
or partially within its boundaries, to select them.

Line See Vertical line or Horizontal line.

Literal text Text which is part of the specification and which
prints on the document exactly as it was typed into
the specification. Entered as Labels or Memos.

Memo Text that is part of the specification and that prints on
the document exactly as it was typed into the
specification. Memos should be used for blocks of text
that exceed one line, or for vertical labels.

Terminology
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Term Definition

Object Anything that gets placed on a specification page.
This includes Information codes (also called Fields),
Labels, Memos, Lines, Shapes, and Bitmaps.

Properties Attributes of an object on a specification. For example,
the selected formatting of a date field is a “property”
of that field; likewise, a trailing vs. a leading negative
for an amount field is a “property” of that field.

Sections Parts of a specification. Depending on the type of
specification you are creating, the sections will vary.

Each section contains information (text, information
codes, and graphics) that control the look of the
printed document.

Please see “Sections” later in this chapter for more
information on the various types of sections available
to you for each Adagio application.

Spec List The Spec List is a complete list of the Information
codes you can add to your specification. To call up the
Spec List, click the Spec List button. Add information
codes to your specification by clicking them on the
Spec List and then dragging and dropping them on to
the specification page.

Specification The document which controls the printing of your
documents.

Vertical line A vertical rule placed on the specification page. Can
be used as a short line to simply draw attention to a
line on the specification, for example, or as a long rule
that runs down the length of the section. The most
common and practical use for vertical lines would
likely be to create a columnar effect on an invoice or
an advice slip, with vertical lines separating the
various columns of transaction detail information.

Terminology
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The Specification
The specification is a master set of instructions, or a template, that the Adagio
program refers to every time it prints a document (such as an invoice in Adagio
Invoices or a check in Adagio Payables). The specification contains instructions that
control what information will be included on your documents, and how that
information will appear.

What Does A Specification Contain?
A specification simply contains the information codes, text blocks, and lines, shapes,
and bitmaps that will make up your document, formatted to suit your needs. The
placement of the information codes, text blocks, and other objects tells Adagio what
to print and where to print it on the page or form. The text and codes are then
formatted as you would like them to appear on the printed document; for example,
in Adagio Checks you might want to bold the check amount or add ruling lines to
the advice slip, or you might wish to use a different font for certain information. The
specification allows you to do all of this.

We are now ready to look at parts of a specification.

Sections
Depending on which Adagio module you are using, there will be different types of
sections. We’ll briefly go over each module and some specific points about its section
types.

Module Sections

Adagio BankRec � Receipts will always contain a Page header and Last Page
Footer section.

� Each specification can include the following detail types:
� Receivables

� Miscellaneous

Adagio Checks � Check specifications always include a check section.
� Advice specifications include Advice header, detail, and

footer sections.
� Combination check/advice specifications contain a check

section, an Advice header, an Advice footer, and at least
one Advice detail section.

The Specification
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Adagio Invoices � Invoices will always contain a Page header and Page
footer section.

� Invoices can contain many different detail line sections.
Detail sections are assigned style letters (A-Z); the style
letter indicates that each time Adagio Invoices encounters
an item on the invoice with the same style letter, it will
print the text, fields, and other items in this section for
that particular item.

Adagio OrderEntry � Orders and picking slips will always include a Detail line
section, which is used to print the item details on the
documents.

� Orders and picking slips will also include header and
footer sections.

� Various other section types are available:
� Comment lines sections may be used to print

comment detail lines that were included on the
document, if any.

� Serial # sections can be used to print serial number
detail lines.

� Instructions sections may be included, particularly on
picking slips, to print any instruction detail lines
from the order.

� Subtotal sections will create subtotals at the bottom
of each page of a multi-page document.

Adagio Payables � Check specifications always include a check section.
� Advice specifications include Advice header, detail, and

footer sections.
� Combination check/advice specifications contain a check

section, an Advice header, an Advice footer, and at least
one Advice detail section.

The Specification
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Adagio Receivables � Statements will always contain a Page header and Page
footer section.

� Each specification can include up to three different detail
type sections:
� without matching details: lines under this section

will print statement information without matching
details. This section type should be used in
conjunction with: Detail line (matching details)

� matching details: lines under this section will print
the matching details for the information printed in
the previously-mentioned section: Detail line
(without matching details). These two section type
should be used in conjunction with each other.

� with matching details: lines in this section will print
the invoice information and the matching details.
This section type should be used by itself: it should
not be combined with either of the other two detail
section types.

Adagio SalesCQ � Quotes will always include a Detail line section which is
used to print the item details on the documents.

� Quotes will also include header and footer sections.
� Various other section types are available:

� Comment lines sections may be used to print
comment detail lines that were included on the
document, if any.

� Instructions sections may be included
� Subtotal sections will create subtotals at the bottom

of each page of a multi-page document

Adagio Time&Billing � Documents will always contain a Page header and Page
footer section.

� Each specification can include the following detail types:
� Bill

� Disbursements

� Time

� Progress bill

� Tax details

Each section on a specification will contain at least one basic element: information
codes, to tell the Adagio module what information you want on the document.
Sections can also contain other elements, such as labels or memos, to provide any
necessary text information, bitmaps, horizontal and vertical lines, and boxes.

These elements should be placed on the specification in the same position you want
them to appear in the final, printed document. You can then add any desired
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formatting to these elements by changing their alignment, by bolding or underlining
them, by changing the font, or by adding ruling lines or shapes. Because of the visual
nature of the Designer, you can see the effects of your formatting changes right on
screen, as you create and work with the specification.

To insert a section:
1) Open the specification to which you want to add a section. Then click the

Sections button.

2) Move the cursor to the area of the specification that you want to add the new
section to. For example, if you are adding a new detail section, you may want to
position the cursor between an existing detail section and the Page footer
section. Click the left mouse button once to insert the new section.

3) The Edit sections dialog box appears:

• Select the desired Section type.

If you have selected a detail section, be sure to enter all of the necessary detail
section information, such as the detail section letter in Adagio Invoices or the
detail section type in Adagio Checks or Adagio Payables.

The visual grid and the snap to grid are NOT the same. The visual
grid displays a generic grid based on the unit you choose in Options
| Properties. The snap to grid is invisible and allows you to place
objects on a specification while maintaining a certain line and
column spacing.

• Click the down arrow to the right of this field to view a list of the possible
types of visual grids.

Grid type Details

None Default setting; no rules will be added to the section.

Horizontal Horizontal rules will be added to the section.

Vertical Vertical rules will be added to the section.

Both Both horizontal and vertical rules will be added to the
section.
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One quick method of turning the grid on and off is to click the
section bar with your right mouse button, then select Visual Grid
On or Visual Grid Off from the pop-up menu.

• If you would like to create a border around a section you must also edit the
fields in the Border section of this dialog box:

Field Details

Width Sets the width of the rules. A setting of 1 is a hairline
width, and increases incrementally as you increase the
value in this field.

Top
Bottom
Left
Right

Click any combination of these checkboxes on to add a
border to that portion of the section. You will notice as you
click these checkboxes on and edit the Width field that the
white box to the left of these checkboxes will display a
sample of the rules you have selected.

• To change the section’s background color, click the down arrow to the right of
the Background color field, and select the desired color.

The background color will not be displayed while you are editing
the specification; you must select Preview from the File menu or
print out the specification or the actual document to see the selected
background color.

• Enter the desired height for this new section in the Section height field.

You can change the section height by clicking on the section bars
and moving them up or down.

All detail sections must be the same size. To make certain they are
exactly the same size, click the section bar of the first detail section
with your right mouse button. Select Properties from the pop-up
menu. The Edit sections dialog box appears. Check the value that
appears in the Section height field. Now repeat this process for the
remaining sections, editing the Section height field as needed.

4) When you are satisfied with the information displayed in this box for your new
section, click OK. The Designer will add the new section in the position you
indicated.
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To edit a section:
1) Click the gray section bar to select it.

2) Click the right mouse button to call up the pop-up menu, and select Properties.

3) Edit the desired section as indicated in step 3 above.

To delete a section:
1) Click the gray section bar to select it.

2) With the red handles on the section bar, press Delete. The Designer asks:

3) Click Yes to delete the section and all objects in that section. To delete just the
object, however, you can If you click No, however, the text, fields, and graphics
that were in the section do not disappear. You can either delete these items by
selecting them and pressing Delete, or you can move them to a different section.

To size a section:
You can maintain a consistent line spacing on your specification if you know how to
properly size your sections. Assume, for instance, that you intend to insert a
single-line detail line section. How can you determine what an appropriate size for
the section should be, given that it will only contain one line of text?

Users of older, DOS-based accounting systems may remember that, in a DOS
specification, each line is 1/6" or .1667" high. In the Adagio Designer, you can base
your section sizes on this information, provided that you are using a standard,
10-point font such as Courier 10 point or Times Roman 10 point. (As we discussed
earlier in this manual, different type faces and font sizes will produce different
results.) If you are using a standard, 10-point font, you can size your section to a
typical single-spaced line by doing the following:

1) Click the gray section bar for the section you wish to size.

2) Click the right mouse button and select Properties from the pop-up menu that
appears.

3) When the Edit sections dialog box appears, enter .1667 in the Section height
field.
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The basic principle is that each line in a section should be .1667" when you are using
standard-sized fonts. Therefore, if you want your section to be two lines high, or
double-spaced, you would simply multiple .1667 by 2 and enter .3333 in the Section
height field. And so on.

Remember, however, that your section heights will vary with the fonts you use. If
you generally prefer to use larger fonts, such as 11 or 12 point fonts, experiment a
little to determine a good section size for that font size and type face. Then, when you
have determined an appropriate height for a single line, you can use that information
throughout the sections on your specification.

When using a standard, 10-point font you may also want to use
.1667 as your Horizontal grid setting in Options | Properties. This
will make it easier to place objects in an even, single-line spacing
manner, provided you have turned the Snap to Grid on.

You can adjust this value for different size fonts.

Placement of Information
Information can be positioned anywhere on the page. To position a field, text block,
line, shape, or bitmap when you first place it on the specification, click the
appropriate button on the Button Bar. Your cursor will change to a crosshair; simply
move the crosshair cursor as close as possible to the desired location and click. The
field, text, or graphic will appear in the specified position. (Please see the following
sections for more information on inserting fields, text blocks, or graphics.)

If you are not satisfied with its position or if you want to make a change for any
reason, you can move a field, text block, line, shape, or bitmap in one of the following
ways:

• Click on the item you want to move and drag it to the desired position.
• Click on the item you want to move. With the red handles (or gray handles, if

multiple objects have been selected) showing, use the Arrow keys to move the
object up, down, left, or right. This is an especially good option if you only
want to move the object in small increments.

• Use the Size & Colors option. Click on the item you want to position, click the
right-mouse button, and select Size & Colors from the pop-up menu that
appears. Move the item to the left by decreasing, or to the right by increasing,
the measurement displayed in the Left field. Move the item up by decreasing,
or down by increasing, the measurement in the Top field. This method of
positioning is not as quick and easy as simply dragging the item to the desired
position, but it does allow for very precise placement of information.
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The value in the Top field is relative to the section bar; it is not an
absolute measurement from the top of the specification page itself.

When the Designer’s Snap to Grid option is turned on, anything you place or move
on the specification will “snap to” the grid; as you drag an item vertically or
horizontally, you will see it jump to certain positions, as it aligns itself with the grid.
For more information on the grid, see the information on Properties under the Options
menu section, later in this chapter.

The Snap to Grid is not the same as the visual grid; please do not
confuse the two.

Information Codes
Information codes let you place information from several different sources on the
printed document. Information can be drawn from the customer file or from the
various parts of the transaction information. There are also information codes that
allow you to print today’s date, the page number, and running totals and subtotals
for quantities, prices, amounts, etc. To see a complete list of information codes, select
Spec List from the Options menu in the Designer, or click the Spec List button on the
Button Bar.

Click the + signs to expand the list, or the - signs to contract it.

To place an information code:
You can place an information code on a specification in one of two ways:

• While you are designing a specification, click the desired code on the Spec
List, hold down the left mouse button, and drag the code to the desired
location. To place it, just release the left mouse button.

We recommend using this method to place your information codes, as the
hierarchical format of the Spec List makes it easy to find the correct code.

In each Designer session, the first time you attempt to place an
information code on a specification you may have to click the field
of interest on the Spec List once, then click it again before you drag
it on to the specification page.

• Click the Field button.

Move the crosshair cursor to the approximate position you wish the field to
appear and click once. In the Edit field object dialog box, select the field of
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interest from the Specification field drop-down box. Click OK. The Designer
will place the selected information code in the position you indicated.

To edit the information code properties:
1) Click on the information code you want to edit.

2) With the red handles showing, click the right mouse button. From the pop-up
menu that appears, select Properties.

3) The Edit field object dialog box appears. This dialog box will vary, depending
on the type of information code you are editing. For example, if you want to edit
a dollar field, the Edit field object dialog box will be similar to the following:

There are a number of possible fields in this dialog box, depending again on the
type of information code you are editing. Most of these fields are covered in
greater detail in the section on the Options menu, under the heading Properties
later in this chapter. Please refer to that section for more information. For more
information on amount fields, please see the section on Amount field notes.

To align the information code:
The Designer lets you change the alignment of an information code. By default,
amount fields are right-aligned and text fields are left-aligned. However, if you need
to change this default alignment for a particular field, you can do so by following
these steps:
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1) Click the information code for which you wish to change the alignment.

2) With the red handles displayed, click the right mouse button.

3) From the pop-up menu that appears, highlight the Align Text option. From the
fly-out menu that appears, select Left align text, Right align text, or Center
align text.

Amount field notes:

When placing different types of amount fields on a specification, you should be
aware that there are actually two different types of Edit field object dialog boxes that
may appear when you attempt to edit an amount field’s properties. The type of
dialog box that appears depends on the type of information you inserted on the
specification.

• When you insert a real number, such as a quantity, the corresponding Edit
field object dialog box will be similar to the following:

This dialog box gives you certain options for the formatting of real numbers,
and appears whenever you select a field such as a units field.
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• If you insert a dollar field, the Edit field object dialog box will be slightly
different:

The options presented here allow you to format the dollar field. If you wish to
change the default currency format for the chosen field, you must click off the
Use field’s currency form checkbox before you can edit the Symbol and other
fields.

Literal Text
Literal text can be included anywhere in a format line. Literal text can be added as a
label or as a memo. A label is a short (less than one line) block of text that is generally
used to “label” important pieces of information on the specification, such as the
check total on an advice slip or the total amount due on an invoice. Memos should be
used for longer blocks of text; for example, if you want to insert your company name,
address, and phone and fax numbers on a document, you may want to do that in a
memo. Memos can also be used for vertical labels.

Literal text, whether in the form of a label or a memo, should not be enclosed within
quotes, but should be typed exactly as you want it to appear on a printed document.
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Labels
To place a label:

1) Click the Label button.

2) Move your cursor to the desired location and click once.

3) The Edit label dialog box appears:

• Enter the literal text you wish to insert on your specification in the Label field.
• In the Print on field, put a checkbox beside each copy of the document on you

wish to have the label appear. The checkboxes for all copies but the first will
only be enabled if you’ve already set the Specification Options (on the File
menu) to print multiple copies of the document.

• Click the Suppress duplicates checkbox on if you want this label to appear
only once for each document, even if there is more than one occurrence of this
label.

• Click the Auto size field checkbox on to have the Designer automatically size
the field to the correct height and width.

4) Click OK when finished. Your label appears in the place you indicated in step 2.

To edit a label:

1) Click the label you wish to edit once.

2) With the red handles showing, click the right mouse button.

3) From the pop-up menu that appears, select Properties.

4) Make your changes in the Edit label dialog box. When finished, click OK.

To delete a label:

1) Click the label you wish to delete.

2) With the red handles showing, press Delete.
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Memos
To place a memo:

1) Click the Memo button.

2) Move your cursor to the desired location and click once.

A text block similar to the following appears:

3) Click the right mouse button and select Properties from the pop-up menu that
appears. The following dialog box will appear:

In the text field, delete the word “Memo” and type in the desired text. Click OK
to save your changes.

4) Resize the text block by moving your cursor over one of the red handles until a
double-headed arrow appears.

5) Click the left mouse button, hold it down, and drag the cursor along the screen
until the text block is the size and shape you want.
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To edit a memo:

1) Click the memo text block you wish to edit.

2) Click the right mouse button and select Properties from the pop-up menu that
appears. The following dialog box will appear:

The size of the edit box is the size of the actual memo field. In
addition, when you are in the Edit memo dialog box, the text will
appear with its proper font formatting.

In the text field, make any desired changes to the text, then click OK to save your
changes.

To delete a memo:

1) Click the memo once.

2) Press Delete.

One final note about memos. Unlike labels and other objects on a specification, you
cannot make a memo transparent. In addition, you cannot move a memo to the front
or return it to the back as you would other objects. This is due to a difference in the
properties of a memo versus the properties of a label or any other object on a
specification, and cannot be helped. If you are having difficulty with a memo
partially covering a line, a field, or another object on the specification, we
recommend that you resize the memo to its smallest possible size or readjust the
spacing slightly. If that doesn’t resolve the problem, you can use multiple labels in
place of the memo.

To align the text block:
The Designer gives you the choice to change the alignment of a block of literal text.
By default, all labels and memos are left-aligned. To change the default alignment for
a particular block of text:

1) Click the label or memo you wish to change.

2) With the red handles displayed, click the right mouse button.

3) From the pop-up menu that appears, highlight Align Text. A fly-out menu will
appear; select Left align text, Right align text, or Center align text.
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Header and Footer Styles
Headers and footers apply only to invoices, advice slips, statements, and so forth;
checks do not have header and footer sections. They are mandatory for all documents
except checks; the program expects header and footer codes to be present. You can
choose to have headers and footers contain any of the information codes from the
specification list except the detail information codes, which may appear only in detail
sections.

If you don’t want a header or footer to print, you can simply leave the section blank.
However, the section itself must be there, whether it is empty or not.

Adagio Payables and Adagio Checks notes
When the Adagio module begins printing a check, it assesses the number of detail
lines to determine whether it will be able to print the entire advice, including check
details and header and footer information, on one advice slip. If not, it prints the
header information and as much of the detail as it can on the first advice slip; then, it
goes to the next page and prints the header information again, the remainder of the
check detail lines, and the footer information. When you are printing advices
together with the checks themselves and the advice requires two or more pages, the
check will always print on the last page. The unused checks will be voided and the
program will store a copy of the voided check number to maintain the audit trail.

Please see “Sections”, earlier in this chapter, for more information
on adding, editing, and deleting sections.

Header and Footer Examples
An example of a header and a footer follows. We have used Adagio Checks for this
example, demonstrating a possible header and footer for an advice slip.

Header example

This header is for the first (or only) advice slip, and it prints on every page.
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The first line is blank.

The second line contains the Company name information code at the far left. The
company name has been bolded to make it stand out. In addition, this line prints the
Check number information code at the right-hand margin of the page.

Line three prints the label Vendor as literal text approximately ¼" in from the left of
the page, followed by the Check - Vendor number information code. Approximately
1-3/4", this line prints the label Name as literal text, then includes the Check - Name
information code. Finally, at the right margin this line prints the Check date.

The fourth line is blank.

Line five prints three literal text labels across the page. These labels are column
headings to explain the information that will be printed in the Advice detail
section(s).

First, ½" from the left margin, the label Code appears. This indicates that the
corresponding information that will appear below, in the Advice detail section(s),
will be the distribution code.

Next, the label Description appears 3-1/2" in from the left margin.

Finally, the Amount label appears 6-1/2" across the page. The last line is also blank.

Footer example

This footer is for the first (or only) advice slip, and it prints on the final page of an
advice. If there is only one page, it will print on that page.

The first line is blank.

Line two prints the label Total Amount: as literal text 5" across the page, followed by
the Check - Total amount information code, right-aligned from the 7-1/4" mark.

Lines three and four repeat the same spacing; the labels appear left-aligned and the
dollar amounts appear right-aligned. On line three, the label Discount: appears,
followed by the Check -Discount amount information code. Line four displays the
Check Amount: label, followed by the Check amount information code.

The fifth line is blank.
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Detail Line Sections
Depending on the Adagio module you are using, The Designer allows you several
different detail sections. The following table briefly describes the detail sections
allowable in each module.

Module Sections

Adagio Checks � Check specifications always include a check section. They
do not have header and footer sections, or a standard
“detail” section.

� Advice specifications can include up to three different
detail types:

� Purchase
� Job Cost
� Time & Billing

Job Cost and Time & Billing are only available if you have
turned the Job Cost and Time & Billing interfaces on in the
Company Profile.

� Bear in mind the following:
� You must have one Advice detail section for each type

of check detail line you use. For example, if you use
the Job Cost detail type, you should have an Advice
detail - Job Cost detail section on each advice for each
specification you use. If you attempt to print a check
with a Job Cost detail line on it, but the specification
you are using does not have a corresponding Job Cost
detail section, it will simply print a blank line.

� If you have more than one detail section on a
specification, each detail section must be the same
size. For example, if you have both an Advice detail -
Advice 1 - Purchase section and an Advice detail -
Advice 1 - Time & Billing section on your
specification, these sections must be the same height.
You cannot have a Purchase section that is .1667” high
(approximately one line) and a Time & Billing section
that is .3229” high (approximately two lines) on the
same specification. Both must be the exact same
height.

Adagio BankRec � You may have either or both of Receivables detail section
or Miscellaneous detail section.

� A receipt does not require a detail section.
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Module Sections

Adagio Invoices � Invoices can contain many different detail line sections.
Detail sections are assigned style letters (A-Z); the style
letter indicates that each time Adagio Invoices encounters
an item on the invoice with the same style letter, it will
print the text, fields, and other items in this section for that
particular item.

Adagio OrderEntry � Orders and picking slips will always include a Detail line
section, which is used to print the item details on the
documents, and header and footer sections.

� Various other section types are available:
� Comment lines sections may be used to print comment

detail lines that were included on the document, if any.
� Serial # sections can be used to print serial number

detail lines.
� Instructions sections may be included, particularly on

picking slips, to print any instruction detail lines from
the order.

� Subtotal sections will create subtotals at the bottom of each
page of a multi-page document.

Adagio Payables � Advice specifications include Advice header, detail, and
footer sections. See Adagio Checks above for additional
information.

Adagio Receivables � Each statement specification can include up to three
different detail type sections:

� without matching details: lines under this section will
print invoice information without matching details.
This section type should be used in conjunction with:
Detail line (matching details)

� matching details: lines under this section will print
the matching details for the information printed in the
previously-mentioned section: Detail line (without
matching details). These two section type should be
used in conjunction with each other.

� with matching details: lines in this section will print
the invoice information and the matching details. This
section type should be used by itself: it should not be
combined with either of the other two detail section
types.
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Module Sections

Adagio SalesCQ � Quotes will always include a Detail line section which is
used to print the item details on documents.

� Quotes will also include header and footer sections.
� Various other section types are available:

� Comment lines sections may be used to print comment
detail lines that were included on the document, if any.

� Instructions sections may be included
� Subtotal sections will create subtotals at the bottom of

each page of a multi-page document

Adagio
Time&Billing

� Each Time&Billing specification can include the following
detail types:

� Bill

� Disbursements

� Time

� Progress bill

� Tax details

Using Adagio Checks to illustrate a detail line section, a simple example of a
Purchase detail line follows.

Detail line example

This item style prints only one line for each Purchase detail it encounters on a check.
First, it prints the Inv - Distribution code ½" in from the left margin. At 2", it prints
the Inv - Description. Finally, right-aligned at 7-1/4", it prints the Inv - Amount.
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Formatting Your Documents
One of the advantages of the Designer is the ability to add special objects and
formatting in order to enhance the appearance of your documents. Using the
Designer, you can:

• use different fonts, in varying sizes, as well as underlining, bolding,
strike-through, and other effects.

• add varying shades of gray, or colors if using a color printer.
• insert bitmaps, lines, and shapes anywhere on your checks and advices.
• add borders to text, fields, and entire sections.
• align text right, left, or center.

Font Formatting
You can change the appearance of any text block (label or memo) or information code
by changing the font, the size of the font, or the bolding, underlining, italicizing, and
other font options. To do this:
1) Select the text block or information code you wish to edit by clicking it once.

2) With the red handles showing, click the right mouse button. From the pop-up
menu that appears, select Font.

3) The Font dialog box appears.
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This dialog box gives you several options:

Field Details

Font Select a font from the list of available fonts. Scroll
through the list using the up and down arrows to the
right of the list, and select the preferred font by
clicking it. You will notice that the font name appears
in the field above the list. The default is specified in
Options | Properties.

Font style Select the desired style for the font you’ve just
selected. Your options here will vary, depending on
the font you’ve chosen, but the standard options are
Regular, Italic, Bold, and Bold Italic. The default is
specified in Options | Properties.

Size Select the font size you prefer from the list. Or, simply
type the font size in the field itself. The default is
specified in Options | Properties.

Effects section The Effects section of the dialog box allows you to
add certain special effects, like Strikeout and
Underline. You can click one or both of these options.
This section also provides you with the option to
change the text’s color. View a list of possible colors
by clicking the down arrow to the right of the Color
field; select a color by clicking it. The default is
specified in Options | Properties.

You will notice as you make changes in the Font dialog box that the Sample section
reflects your changes. This gives you a good idea of what your changes will look like
on screen.

You can use as many different fonts, with as many combinations of font formatting
options, as you’d like on your documents. Simply select each text and/or information
code you’d like to change and follow the steps described above.

You can change the default font settings by selecting Properties
from the Options menu and clicking the Set Font button. See the
information on the Properties command under the “Options menu”
section, later in this chapter, for more information.
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Graphics
The use of graphics on your documents can add visual flair and interest, as well as
adding structure and creating a specific, corporate image.

Bitmaps
This option is especially useful for creating professional looking advice slips with a
specific corporate identity because it allows you to add your company logo to the
header or footer of your documents. You can also add bitmaps for other purposes; be
creative!

To add a bitmap:
1) Click the bitmap button.

2) Move your cursor to the place you want to insert the bitmap, and click once.

3) The Select Bitmap Image dialog box appears:

Choose the drive, directory, and filename of the bitmap you want to insert.
When you are finished, click OK. The Designer inserts the bitmap on your
specification.

To resize a bitmap:
1) Click the bitmap once to select it

2) Click the right mouse button and make sure that the Stretch Image option is
turned on. (If it is turned on, it will have a checkmark beside it.) This allows you
to resize the image as you wish.

3) Move your cursor over one of the bitmap’s red handles, until a double-headed
arrow cursor appears.
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4) Click the left mouse button, hold it down, and drag the cursor along the screen
until the bitmap block is the size and shape you want.

The Designer does not automatically resize the bitmap
proportionally. If you wish to ensure that it is resized
proportionally, you should edit the bitmap in MS Paint or another
graphics program, save the changes, and then insert the revised
bitmap on your specification.

If you have resized the bitmap and are unhappy with the change, you can easily
restore it to its original size and shape by clicking the Undo button.

To move a bitmap:
1) Click the bitmap once.

2) With the red handles showing, click your left mouse button and, while holding
the mouse button down, drag the bitmap to the desired location.

3) Release the mouse button.

To delete a bitmap:
1) Click the bitmap once.

2) With the red handles showing, press Delete. Your bitmap will disappear.

Lines
Lines are excellent tools for adding a sense of structure to your documents; they can
be used to separate sections, or, most commonly, to separate total amounts from the
preceding lines on the advice slip. You can also use lines to create columns or to
enclose related fields on your advices. Lines can also be used to add some visual
interest.

You can place either vertical or horizontal lines on your specification.

To insert a line:
1) Click the Vertical line or Horizontal line button.

2) Move your cursor to the place you want the line to begin (the line will begin
approximately at that point and extend down or to the right) and click once to
insert the line. Defaults for the inserted line, such as the initial, default length of
the line, are specified in Options | Properties.
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To edit a line:
1) Select the line by clicking it once, so that the red handles appear.

If you have difficulty selecting a line in this manner, try using the
lasso instead. See the section entitled “Manipulating objects on a
specification” for more information on using the lasso.

2) Click the right mouse button. From the pop-up menu that appears, select Size &
Colors.

3) The Edit size & colors dialog box appears:

This dialog box allows you to position the line by moving it up or down, or to
either side; in addition, you can change the length, thickness, and color of the
line.

Field Details

Left /
Top

The first two fields in the Size section of this dialog
box allow you to reposition the line. To move the line
to the left, decrease the measurement in the Left field;
or, to move it to the right, increase the measurement.
Move the line up by decreasing the measurement in
the Top field; conversely, increasing the measurement
in the Top field will move the line down.

The value in the Top field is relative to the section
bar; it is not an absolute measurement from the top of
the specification page itself.

Width This field determines how long a horizontal line is.
You can increase or decrease the line’s length by any
amount. For example, if you want a horizontal line
that extends across an 8-1/2" page with 1" margins,
you would enter 6.5 here.
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Height The Width field will be grayed out if you are editing a
vertical line. Instead, the Height field will be active.
For vertical lines, this field determines how long the
line will be. As with the Width field, you can increase
or decrease the line’s “height” by entering a different
value in the Height field.

Transparent The Transparent checkbox has been disabled; you
cannot make a line transparent.

Show border This field is grayed out and cannot be edited. (This
field is only available when editing sections, text
blocks, and fields.) The other options in the Border
section, however, can be changed to alter the thickness
and the color of the line.

Border width This field allows you to change the thickness of the
line. The default is 2, which is a hairline thickness. Use
the up and down arrows to the right of this field to
increase or decrease the line’s thickness.

Color You can change the line’s color by entering a different
color in the Color field. Click the down arrow to the
right of this field to view a complete list of the colors
available to you, and choose the desired color from
this list.

Foreground color This field is also disabled, as it is only available when
editing sections, text blocks, or fields.

You can set different line length, thickness and color defaults for
your horizontal and vertical lines. For example, if you generally
prefer to use thicker lines, you might want to increase the default
thickness. To change your line defaults, select Properties from the
Options menu. When the Program properties window appears, click
the Lines tab. Set your defaults in the fields that appear. For more
information, see the section on the “Options menu” later in this
chapter.

4) When you have made all of the necessary changes to your line, click OK.
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To delete a line:
1) Select the line by clicking it until the red handles appear.

If you have difficulty selecting a line in this manner, try using the
lasso instead. See the section entitled “Manipulating objects on a
specification” for more information on using the lasso.

2) Press Delete. The line will disappear.

To create a vertical line across multiple sections:
You may wish to include a vertical line which runs through more than one section on
your specification. For instance, inserting a vertical line that runs down one side of all
of your detail sections may create an excellent visual effect, separating the detail
sections from the header and footer.

To do this:

1) Insert a vertical line in the section you want the line to run through. This might
be a header or a detail section. Make sure you align the top of the vertical line
with where you want the vertical line to begin.

2) While the vertical line object is still selected, right click and select the Extend
Thru Detail option.

3) Next, with the vertical line object still selected, click on the bottom handle of the
vertical line and drag it down until it extends to the bottom of the first detail
section. When you preview the specification, the vertical line will extend
downward through to the bottom of the specification detail sections.

If you want to create a vertical line that extends through footer sections also,
repeat the above steps within each additional section you want the line to appear
in. If this line is to be an extension of the prior line, use the cursor keys while the
new line is selected to nudge the line into alignment with the prior line. Or,
lasso the lines and use the Align objects Left or Right function in the right click
menu.

At the time of writing, the Extend Thru Detail feature may not yet
be available in all current releases.

If the Extend Thru Detail option is not available in your version, do this

1) Insert a vertical line in each section you want the line to run through.

2) For each line you inserted in step 1:
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• make certain that they are of equal thickness, and
• for every detail section, fit each vertical line to section. You can do this by

clicking each line in turn, then clicking the right mouse button. Select Fit to
Section from the pop-up menu that appears. The line will be extended from
the very top of the section to the very bottom of the section.

The Fit to Section feature does not apply to horizontal lines; it can
only be used on vertical lines.

3) Select all of the lines you created in step 1 by holding down the Shift key while
you click once on each line in turn. Start by clicking the line that is in the desired
horizontal position across the page.

4) With all of the lines selected, click the right mouse button and select Align
objects from the pop-up menu. A fly-out menu appears, giving you four
alignment options: Top, Bottom, Left, and Right.

5) Since you wish to align these lines to the same horizontal position across the
page, click Right or Left.

6) The Designer aligns the selected lines to the first line you clicked in step 3.

Shapes
The Designer allows you to insert two different shapes on a specification: a rectangle
or an ellipse. Shapes can be used for very practical purposes, like inserting a
rectangle around the total on an invoice to make it stand out, or visually grouping
related pieces of information together, or for aesthetic purposes.

To insert a shape:
1) Click the Shape button.

2) Move your cursor to the area of the specification where you want the shape to
appear. Click once to place a shape. The default is a .8333" square with white fill
and a black border; however, this default can be changed under the Shapes tab
in Options | Properties.

To edit a shape:
1) Click the shape once.

2) With the red handles showing, click the right mouse button and select Size &
Colors from the pop-up menu.

The Edit size & colors dialog box appears:
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• This dialog box gives you the same options that you are given when you edit a
line. You can reposition the shape using the Left and Top fields, alter the size
of the object by editing the Width and Height fields, make the shape
transparent, and alter the border width and color. For more information on
making these changes, see the section on Lines, earlier in this chapter.

• You also have one additional option here. You can edit the Foreground color
field, to change the “fill” in the shape. For instance, if you selected red here,
your rectangle might be a red object with a black border. To change the
Foreground color, click the down arrow to the right of this field and select the
preferred color from the list that appears.

When you have made the desired changes to the size and color of the shape,
click OK.

3) Again, with the red handles showing, click the right mouse button to call up the
pop-up menu. This time, select Shape.

The Edit shape dialog box appears:

This dialog box simply allows you to decide whether your shape will be a
rectangle or an ellipse. Click the desired button and then click OK.

Note that you can also change the size of the shape by placing your cursor over one
of the red handles until the double-headed arrow appears. Click your left mouse
button and, while holding it down, drag the handle until you are satisfied with the
size of the object. Release your left mouse button.
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To delete a shape:
1) Click the shape once.

2) With the red handles showing, press Delete. The shape will disappear.

Manipulating Objects on a Specification
The Designer allows you to move, copy, paste, realign, reorder, and delete objects
once you’ve placed them on the specification page. It is important to understand how
to work with the objects on the specification so that you can easily make changes to
your specification.

Selecting Objects
To begin, you must understand how to select one or more objects, as you cannot
work with an object unless it has first been selected. An object is considered
“selected” if red handles appear around it. If you have chosen to select multiple
objects, gray handles appear around each selected object to indicate that more than
one object has been selected.
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Select objects in one of two ways:

• Click the object to select it.
• To select a single object, click it once. Red handles will appear, indicating

that it has been selected.
• To select multiple objects, hold down the Shift key while you click each

object you want to select in turn. Gray handles will appear around each
selected object.

• Use the lasso. Think of the lasso as a rope that “catches” anything within its
range. A lasso will select any object that is partially or wholly within its
boundaries.

• Select one or more objects with the lasso by clicking the left mouse button
anywhere near the object(s) you wish to select, except on the actual
object(s). Hold the left mouse button down while you drag the mouse to a
new position. A box appears as you drag the mouse across the
specification; this is the lasso.

• When the lasso is touching or encompassing all of the objects you wish to
select, release the left mouse button. The object(s) will be selected.

If you use the lasso to select multiple objects, then find that you
have accidentally included one or more objects in the lasso that you
did not wish to select, you can easily deselect them. Simply hold the
Shift key down and click once on each object you wish to deselect.
All of the other objects in the lasso will remain selected, allowing
you to then make the desired changes to that group of objects.

Cutting, Copying, and Pasting Objects
Once you have placed an information code, text block, or graphic on the
specification, you can cut, copy, or paste that object in one of three ways:

• Select Cut, Copy, or Paste from the Edit menu.
• Click the right mouse button and select Cut, Copy, or Paste from the pop-up

menu that appears. If you wish to cut or copy an object, you must first click it
once to select it.

• Use the keyboard commands.
• Press Ctrl+C to copy an object. Make sure you have first clicked the object

you wish to copy to select it.
• Press Ctrl+X to cut an object. Again, you must first select the object you

want to cut by clicking it once.
• Press Ctrl+V to paste an object.

Note that the Paste command will not be available until you have cut or copied any
object. Once you have done so, you can paste the previously cut or copied object in
one of the above ways.
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The pasted object will always appear slightly down and to the right of the object you
originally copied. It will also be selected (e.g. handles will surround it) automatically,
so that you can immediately reposition it as desired.

One potential use for the copy and paste features is the ability to copy one or more
objects on a specification and then paste those objects on a different specification.
You may wish to use this capability if you are creating documents that are very
similar to each other but are to be used for different bank accounts or
clients/vendors.

Aligning Objects to Each Other
A very useful feature in the Designer is the ability to horizontally or vertically align
multiple objects to each other. This allows you to ensure that any rows and columns
on your specifications will be neatly and precisely aligned. Best of all, the Designer
does this for you — quickly and easily.

The horizontal alignment feature aligns multiple objects horizontally, in a column
down the page. One possible application for this feature is the right-alignment of
columns of numbers or amounts on your advice slips. For example:

The vertical alignment feature, on the other hand, aligns multiple objects vertically,
in a row across the page. A useful example of this is bottom-aligning several fields
across the page, such as:

To align objects to each other, follow these steps:

1) Select the objects you wish to align, either by holding down the Shift key and
clicking each object in turn or by lassoing the objects. (Please refer to the section
on Selecting objects earlier in this chapter for more information on using the
lasso.)

2) Click the right mouse button to call up the pop-up menu.
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Highlight Align objects. A fly-out menu appears, presenting you with four
options.

• To horizontally align the selected objects, click one of the following options:

Option Details

Right Right-aligns the selected objects in a column down the page.
You will generally want to select this option if you are
planning to align amount fields to each other.

Left Left-aligns the selected objects in a column down the page.

• To vertically align the selected objects, click one of the following options:

Option Details

Top Top-aligns the selected objects in a row across the page. For
objects of differing heights, this option means that the top of
each object will start at the same place across the page.

Bottom Bottom-aligns the selected objects in a row across the page.
For objects of differing heights, this option will align the
bottom of each object across the page.

The Designer will align the selected objects according to your instructions.

The Designer aligns the objects to the first object you selected in step 1. To illustrate,
assume you wanted to horizontally right-align several objects and the first object you
selected was the object closest to the right margin:
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When you select Right from the Align objects fly-out menu, all of the objects you
selected will be moved to the same position on the page as the first object you
selected, extending left from the right edge of that first object:

However, this only holds true when you use the Shift+Click method of selecting
multiple objects. If you choose to use the lasso, the Designer aligns the objects to the
furthest left, uppermost object selected.

If you align objects using the lasso, you may have to move the selected objects to the
desired position once they have been right-, left-, top- or bottom-aligned correctly.

To move the aligned objects up, down, left, or right, be sure the
objects are selected and use the Arrow keys.

Sizing Objects
The Designer also allows you to resize several objects at the same time. This feature
essentially assigns a uniform size to all of the selected objects, as per your
instructions. If you need to ensure that certain objects are all the same size, use this
function to quickly resize all of the objects of interest at once.

To use this feature:

1) Select the objects you wish to resize, either by holding down the Shift key and
clicking each object in turn or by lassoing the objects. (Please refer to the section
on Selecting objects earlier in this chapter for more information on using the
lasso.)

2) Click the right mouse button.
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From the pop-up menu that appears, select the Size objects command. The
following dialog box appears:

3) You can uniformly change the height and/or width of all selected objects.

• Use the radio buttons in the Width section of this dialog box to change the
width of all selected objects. Your options are as follows:

Option Details

No change Leaves the width of the selected objects unchanged.

Shrink to smallest Shrinks the width of all selected objects to match the
width of the smallest selected object. For example, if
the objects have widths ranging between .5" and 1.0",
selecting this option will shrink all of the objects to a
.5" width.

Grow to largest Expands the width of all selected objects to match the
width of the largest selected object. For instance, if the
objects have widths ranging between .5" and 1.0",
selecting this option will change the width of all
objects to 1.0".

Width Specify the exact width you desire for all objects.
When you click this radio button on, a measurement
field becomes active, allowing you to enter the width
you want to use for all objects.

If you select the Width option but do not enter a new value in the
measurement field, your objects will all be resized to the size of the
first selected object.
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• Use the radio buttons in the Height section of this dialog box to change the
height of all selected objects. Your options are as follows:

Option Details

No change Leaves the height of the selected objects unchanged.

Shrink to smallest Shrinks the height of all selected objects to match the
height of the smallest selected object.

Grow to largest Expands the height of all selected objects to match the
height of the largest selected object.

Height Specify the exact height you desire for all objects.
When you click this radio button on, a measurement
field becomes active, allowing you to enter the height
you want to use for all objects.

If you select the Height option but do not enter a new value in the
measurement field, your objects will all be resized to the height of
the first selected object.

4) Indicate the uniform size changes you wish to make to the objects you selected in
step 1. When you are ready, click OK. The Designer will resize the objects
according to your instructions.

Changing the Order of Your Text, Fields, and Graphics
Each time you select a text, field, or graphic and click the right mouse button, you
may notice that there are two additional options we have not yet discussed: Move to
front and Return to back.

Whenever you place overlapping objects on your specification, you are creating
“layers” on the specification. The order of these layers can be altered, allowing you to
fix problems that occur when you insert a new object on the specification and end up
covering all or a portion of an existing object.

For example, assume that you want to use a rectangle to highlight the balance
outstanding total on a statement. Try inserting a total field in a footer section and
then inserting a rectangle (shape) over top. You will see that the rectangle covers up
the total field, making it invisible. Obviously, this is not the effect you were aiming
for! To rectify this problem, select the rectangle and, with the red handles showing,
click the right mouse button to call up the pop-up menu. Select Return to back from
the menu; you will notice that the total field becomes visible again. This is because it
is now on the top “layer” of the specification.
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You can also resolve this same problem by making the rectangle
transparent in the Edit size & colors dialog box.

You might also want to change the object order if you cannot select an object because
another object is on top of it. In such a situation, send the top object to the back (by
selecting it and selecting Return to back from the pop-up menu), then try selecting
the object of interest again.

If you encounter problems with overlapping objects on a specification, try sending
the top object to the back or moving the hidden or partially hidden object to the front.
You should also make both objects transparent.

The Undo Feature
The Designer includes an Undo feature which can be used to reverse your last action.

The Undo feature can be accessed in one of four ways:

• Select Undo from the Edit menu.
• Click the Undo button on the Button Bar.
• Click the right mouse button to call up the pop-up menu; then click Undo.
• Press Ctrl+Z.

Undo can be used to reverse your last action with only one proviso. It will only undo
the last action if you have not yet selected another object. For example, if you move
an object, then select another object, and then decide that you want to return the first
object to its original position, you will not be able to use the Undo feature to reverse
this action because you selected another, different object. However, if you move an
object and then use the Undo feature right away, the object will return to its original
position. Or, if you move an object, then deselect it by clicking outside of it or any
other object on the specification page (so that nothing is selected), you can still use
the Undo feature to return the object to its original position.

Undo can be used to reverse the movement of objects, changes to the font, size, or
color of objects, the insertion or deletion of objects (including information codes), the
alignment of objects, the change in object order (using the Move to front and Return
to back commands), and other things.
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The Spec Writing Process

An Overview
The specification writing process has two primary parts:

• designing your specification, and
• entering and activating your specification.

Most of the design work is done on paper, before you sit down at the computer.
Entering and activating the specification is, of course, done at the keyboard.

The Design Process
1) Plan out your specification. Decide:

• what information you want to include on your checks and advices,
• where the information should come from, and
• how the information should be arranged and formatted.

2) For each piece of information from Step 1, make sure you know which
information code(s) you should be using. The information codes are listed on the
Specification List in the Designer.

Entering Your Specification
3) Call up the specification editor by selecting Maintain Specifications from the

Maintenance menu, or by clicking the Maintain Specifications button.

4) Create a new specification or edit an existing one.

5) Save your specification when finished.

The next several sections review the design and entering/editing processes in greater
detail.

Designing Your Specification
The first stage in writing a specification for any of the Adagio modules is to choose
the most common type of document you produce for that program and study it
carefully. You may also want to take this opportunity to make changes in the layout.

1) For Adagio modules where you are given the option to create more than one
type of specification, decide which type you’d like to create. For example, in
Adagio Payables you would want to determine beforehand whether you want to
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create a check only specification, an advice only specification, or combination
check/advice specification.

You would use advice only specifications if you normally issued
handwritten checks for a certain account but still wanted to print
advices for those checks at some point, or in cases where checks
include a large number of details on the advice.

2) Determine the length and width of the specification, and decide on the top,
bottom, left and right margin widths.

3) Decide whether you will be using regular paper or pre-printed forms or check
stock.

Remember, if you are printing checks, you can use blank check stock
if you use MICR encoding. (You may need magnetic toner.)

4) Sketch the layout of your specification, including the advices, if desired, and the
check itself. Decide what information you want included on both the advices and
the check, and how you want that information to appear.

We strongly recommend using a laser printer for your Adagio
documents.

Using the Sample Specifications
Once you have a good idea of how your existing documents are structured and how
you want them to look in your Adagio module, look through the sample and
template specifications supplied with the program.

Template Files
Select sample template specifications are listed on the File | Open Template fly-out
menu. Using template files is a little faster and easier than using sample data files,
since you do not need to copy the files into your data directory. Be sure to check
them out before moving on to the sample data directory.

See the section on using template specification files beginning on page 9-263 for more
information.

Sample Data
Sample specifications are included with the sample data for each Adagio module.
You can find sample specifications in the \SAMDATA directory for any of the given
Adagio modules. For example, Adagio Payables sample checks and advices will be
placed in C:\SOFTRAK\APWIN\SAMDATA, where C:\SOFTRAK is the drive and
directory to which you installed Adagio Payables. In addition, all sample
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specifications are automatically copied to your data directory, using your chosen
data extension, each time you create a new data set.

You may find the following procedure useful to determine which, if any, of the
sample specifications may be of use to you.

• Print one of the documents included with the sample data, each time using a
different sample specification. You can choose the specification you wish to
use each time you select the Print option.

• If one of the samples is close to what you want, use that sample file from your
company’s data directory. If necessary, modify it to fit your own requirements.

Deleting Unnecessary Specification Files
Once you have reviewed all of the sample specifications, you may want to delete
those specification files that you do not intend to use in the future. This will limit the
list of specifications to only those specifications you regularly use, so that each time
you attempt to print a batch or an individual check, you are not faced with an
unnecessarily long list of specifications from which to choose.

You can delete the specification files you do not wish to use from your data directory
using Windows Explorer.

For instructions on deleting files in Windows, see your Windows manual.

Copying the Specification File
If you have deleted a sample specification file from your data directory and now
wish to use it, you need to copy the specification file from the sample data directory
to the directory that you have selected for your data files. To do this, copy the file
using Windows Explorer.

For instructions on copying files in Windows, see your Windows manual.

Editing the Sample Specifications
Even if none of the sample specifications exactly fits your needs, it may be faster to
pick one that most closely matches your needs and modify it using the Designer than
to start from scratch.
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The Designer Menus
The Designer can be accessed by selecting Maintain Specifications from the
Maintenance menu. Alternatively, you can start up the Designer by selecting the
Designer icon under the Adagio module’s Start menu folder.

All of the work you do in the Designer is directed from the Designer screen. Five
menus appear on this screen.

Menu Details

File Allows you to carry out file operations, such as
opening and saving files.

Edit Provides editing functions like cut and paste.

Options Allows you to determine the appearance and
properties of the Designer. Also allows you to view
the Spec List, a complete list of the information codes
you can place on your specification.

Window Provides several Windows-specific functions, such as
the ability the toggle between specifications (so you
can copy something from one specification and paste
to another, or simply compare specifications, etc.).

Help Displays on-line help for the Designer.

A more detailed look at each of those menus follows.

File Menu
The File menu contains the following options:

New
Allows you to create a new specification from scratch. Depending on the Adagio
module you are using, this option will either open up a new, blank specification
automatically, or it will present you with a dialog box that provides you numerous
options regarding the type of specification you wish to create.
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Open
Opens an existing specification, allowing you to view or edit the specification.

Open Template
Opens a template specification, which you can then modify to fit your company's
needs. See page 9-263 for more information on working with the template
specification files.

Save
Saves the specification currently on your screen. If the specification has not been
previously saved, choosing this command will call up the Save specification dialog
box. See Save As for more information.

Save As
Saves the currently open specification under a new file name.

Use this option when you want to save a new specification, or when you want to
create a copy of an existing specification using a different file name. In order to use a
specification for future check printing, you must save the specification in the same
directory as your data and the file must have the same extension as your data set.

In addition, the specification must have a certain three-character prefix, such as AR$
for Adagio Receivables specifications. For example, an Adagio Receivables sample
specification might be called AR$SAMP.DAT where .DAT is your data set’s file
extension.

Here is a list of the required prefixes for each Adagio module:

Module Prefix

Adagio BankRec BR$

Adagio Checks QC$

Adagio Invoices QI$

Adagio OrderEntry OE$

Adagio Payables AP$

The Designer Menus

Designer Page 9-239



Module Prefix

Adagio Receivables AR$

Adagio SalesCQ AC$

Adagio Time&Billing TB$

TIP: When creating a new specification from an existing
specification, open the existing specification and immediately save
it with a new name using the Save As option. This way, you will
not inadvertently save your changes under the existing file name.

If you started the Designer by selecting Maintain Specifications
from the Maintenance menu right in the Adagio module, the Save
dialog box will select the same drive and directory as your
company’s data by default. However, if you started the Designer
from your desktop, this will not be the case: You will need to select
the correct drive and directory manually.

Specification Options
Allows you to assign title, page size and margin information for the specification.

In the Edit specification options screen, you can:

• enter a Title for the currently open specification. The assigned title will appear
in the drop-down list of specifications in the Print dialog box. (If you do not
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assign a title to the specification, the drop-down list will display the
specification file name instead.)

• enter the Type of specification being designed; later, when reports of this
specification type are being printed, only specifications of this type will
display in the dropdown on the print dialog.

• choose the page orientation. Select Portrait to print your specifications in
regular page orientation (e.g. 8.5" x 11"); otherwise, select Landscape to print
your specifications on their side (e.g. 11" x 8.5").

• select the paper size, margins, and number of copies:
• in the Paper size field, click the down arrow to view a list of possible sizes.

Select the size you prefer; if the size you want does not appear on the list,
select Custom and then indicate the size in the Length and Width fields.

• in the Left margin field, enter the margin width you would like to use for the
left side of your specification.

For Adagio Payables and Checks, the page orientation, paper size,
and margins must be the same for your checks and advices.

• in the # of Copies field, enter the number of copies you wish to print each
time you print a document using this specification.

In the case of multiple copies for checks, each copy you print will be
assigned a new check number.

Special Adagio Payables and Adagio Checks Notes
In the case of Adagio Payables and Adagio Checks, the Specification Options dialog
also allows you to:

• use the section fields to indicate the order in which the check and the advice(s)
should appear when printed. For example, if you are using check stock that
has two advices and a check, in the advice/check/advice order, you would
select Advice 1 in the Section 1 field, Check in the Section 2 field, and Advice
2 in the Section 3 field. If you do not require all three sections, simply select
None in the sections that are not applicable.

If you are creating an advice/check/advice specification but both
advices will be identical, you can enter Advice 1 in both the Section
1 and the Section 3 fields.

• in the Max details field, indicate the maximum number of detail lines that will
fit on one advice. You will need to calculate this by subtracting the size of the
advice header and footer from the height of the advice slip. Then, take that
calculation and divide it by the height of your advice detail section(s).
(Remember that all advice detail sections must be the same height, so if you
have more than one detail section, simply use the height of any one of the
detail sections for this calculation.)
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To illustrate:

• Assume that your advice is 3.5" in height. Your header is 1" in height, your
footer is .75" in height. To find out how much room you have for detail
lines, subtract the header and footer measurements from the height of the
total advice slip, as follows:

Advice height - (Header height + Footer height) =
Max. detail section height

For our example, this would be:

3.5 - (1 + .75) = 1.75

• You can have up to 1.75" of detail lines. Now assume that your detail
sections are .1667" high (approximately one line). To calculate the
maximum number of detail lines, you need to divide the 1.75" total by the
height of one .1667" detail section.

Max. detail section height /Height of one detail line =
Max. number of detail lines

For our example, this would be:

1.75 / .1667 = 10.5

• In a situation where the maximum calculated number of detail lines is not
a whole number, round down. Here, we would enter 10 in the Max
details field.

However, all of the sections of the advice slip must add up to the total
length of the advice itself; in this case, 3.5".

(10 x .1667) + 1 + .75 = 3.417

• If we had 10 lines of details, plus our 1" header and .75" footer, our advice slip
would be .083" short.

3.5 - 3.417 = .083

We would need to add that amount to either the header or footer section.
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Preview
Displays the specification on screen, as it would appear if it was printed.

The Preview screen allows you to:

• view the specification in three different sizes by clicking the page size button.
• When you first enter the Preview window, you will be viewing the

specification at its “Fit in Window” size. Click the page size button once to
view the specification at 100% size. Click the button once more to view the
specification at the “Page Width” size, which displays the entire width of
the page at once but may not display the entire length. Finally, if you click
the page size button once more, you will be returned to the “Fit in
Window” size.

• scroll through the pages of the specification.
• print the specification by clicking the Print button.
• exit the Preview window and return to the Designer by clicking the Close

button.

Print
Prints the specification you are currently working on.

Printer Setup
Allows you to specify the printer you wish to use when you print the specification, as
well as to indicate the preferred page size and orientation.
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Print Definition
Prints the specification definition to your screen or printer. The definition prints out
basically what you see on screen, except that in place of the Xs, it displays the name
of the information codes. For example, if you had inserted the name of the vendor,
the specification will read “Vendor name” in place of the Xs you would normally see
on screen.

List of recently opened files
Lists the 25 most recently opened specification files. Click one of the recently opened
files to edit or print it.

Exit
Exits the Designer, returning you to the main window of the Adagio module you’re
currently working in.

Edit menu
The Edit menu provides the following functions:

Undo
Reverses the last action.

Cut
Removes a selected field, label, memo, line, bitmap, or shape from the specification.

Copy
Copies a selected field, label, memo, line, bitmap, or shape.

Paste
Pastes a selected field, label, memo, line, bitmap, or shape that was previously cut or
copied on to the specification.

Select All
Selects all fields, labels, memos, lines, bitmaps, and shapes on the specification.
Among other uses for this feature, you can use this function to move everything on a
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specification up, down, or to the left or right, or to copy everything on a specification
onto another specification.

View Menu

Spec List
Displays the list of information codes that you can place on your specification.

You will notice that the items on the Spec List may have + or
- signs beside them. The + sign indicates that there are
information codes under this heading. To view the
information codes, highlight the item with the + sign beside
it, and double-click. The list of information codes will appear.
To hide the information codes and display just the heading,
double-click the item with the - sign beside it. The
information codes will disappear from view.

For more information on dragging and dropping information
codes from the Spec List onto the specification page, please
refer to the section entitled Information codes earlier in this
chapter.

Newer Adagio modules will contain three kinds of address 1
through address 5 codes (eg.'address line 1' and 'address 1
(compressed)' and 'address 1 (formatted)' fields). How these fields
work can depend on whether the 'Formatted' field is turned on in
the particular record (eg. customer record or company profile).

Regular address lines (not formatted nor compressed) always print
an address line even if that line is blank.

In newer modules, the 'compressed' address lines behave the same
way that 'formatted' address lines did in older modules -- blank
address lines are omitted do not print a blank line.

In new modules, if the 'Formatted' option is turned on in the record
being printed and if 'formatted' address lines are also selected in the
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specification designer, the address will print like 'Compressed'
addresses do; however, the Zip/Postal code will print immediately
to the right of the City and State/Prov information.

Copies
You can view copies of multi-page documents using the View menu. The View
menu now gives you these options:

• All Copies
• 1st Copy
• 2nd Copy
• 3rd Copy
• 4th Copy
• 5th Copy

Select which copy of the document you want to view. Selecting All Copies will
display all labels and other items one on top of the other.

For example, if you have a specification with a “Customer Copy” and an
“Accounting Copy,” you can view one copy at a time by selecting the copy from the
View menu, or you can view both copies at once by selecting All Copies from the
View menu. This will display all labels, fields and spec codes one on top of the other.

If you have a single-copy document open, these options on the View menu will be
greyed out.

Options Menu
The Options menu contains several useful features:

Properties
Allows you to change the Designer defaults and other properties. When you select
Properties from the Options menu, the Program properties screen appears. This
screen contains six tabs:

• System
• Formats
• Dollar
• Units
• Lines
• Shapes
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System tab
The System tab contains basic default information for the Designer.

You can set your grid options here. (See the previous section on the Snap to Grid for a
detailed look at the grid.)

Field Details

Grid unit Here, you can set the grid in Inches, Centimeters, or
Points.

Note that Points translate into character height, as the
height and width of non-proportional fonts are not
constant. A setting of 12 points equals 6 lines per inch.

Vertical In this field, you can set the default width between the
vertical lines on the grid. To see the effect of the
values you set in this field, try changing this default
width to 1", then dragging a field from left to right
across the page. Notice how it jumps from position to
position in 1" increments. The default value for this
field is .2500".
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Field Details

Horizontal Here, you can set the default height between the
horizontal lines of the grid. Again, experiment with
the effect that the value you specify in this field will
have on the placement of fields. Change this default
height to 1" and drag a field up and down on the
specification. Notice that it jumps from row to row in
1" increments as well. The default value for this field
is .2500".

Set Font The Set Font function allows you to specify a default
font for your specifications. Changing the default font
will not affect existing objects on your specifications; it
only affects new objects placed on specifications. The
default font is Arial, Regular 10 point, but if you wish
to change this default font, click the Set Font button.
A Font dialog box appears. Set the desired default
font here, and click OK when finished to return to the
Program properties box.

Occasionally, it is necessary for the Designer to slightly alter your
Vertical and Horizontal grid settings. These changes are very
minute and should not be cause for concern.

If you turned the grid on in a section (by selecting Horizontal,
Vertical, or Both as your Visual grid in the Edit sections dialog box,
or by clicking the gray section bar and selecting Visual Grid On
from the right mouse button pop-up menu), the visual grid will
reflect the units you enter here for your default grid settings.

The grid unit set here determines only the units used for the ruler
(the visual grid). However, the settings in the Vertical and
Horizontal fields are what the grid actually “snaps to” if you have
the Snap To Grid option turned on. The Snap To Grid does NOT
“snap to” the ruler, or visual grid, displayed on your screen.
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Formats tab
The Formats tab allows you to set default format information for certain type of
fields.

Field Description

Date format Select a format to use for dates on your specification. M
stands for month, D for day and Y for year.

Boolean format Select a for mat to use for boolean phrases. For example,
True or False, T or F, Yes or No, Y or N, 1 or 0.

Phone format Select a format to use for phone numbers

Auto Size If you want the auto size feature on by default, turn this
option on. When you add new labels and other items to
the specification, they will be automatically sized by
default.

Time format Select a time format to use in your specification. H is for
hours, M is for minutes and T is for seconds.

AM/PM format Select a format to use for AM and PM indicators.

The Designer Menus

Designer Page 9-249



These settings are only defaults. You can change the format for any
of these fields right in the specification, by selecting the field you
want to change, clicking the right mouse button, and selecting
Properties from the pop-up menu that appears.

Dollar tab
The Dollar tab allows you to specify defaults for all dollar amount fields.

Field Details

Use currency Check the Use currency field on if you wish to retain
the currency format of dollar amount fields, as
specified in your currency table. Otherwise, click this
checkbox off.

Decimal places Enter the preferred number of decimal places in the
Decimal places field.

Symbol In this field, enter the currency symbol you wish to
use for the dollar amount fields. If you do not want to
use any symbol, delete the symbol that is currently
displayed in this field, leaving the field empty.
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Field Details

Symbol position This field allows you to set the default position for the
symbol you entered in the Symbol field. Your options
are:

� Leading with no space between symbol and
value. Example $1,000.00

� Trailing with no space between symbol and
value. Example 1,000.00$

� Leading with space between symbol and value.
Example $ 1,000.00

� Trailing with space between symbol and value.
Example 1,000.00 $

Click the down arrow to the right of the Symbol
Position field and click the desired default to select it.

Thousand separator Select the character you wish to use as a thousand
separator by clicking on the down arrow to the right
of the field and selecting one of the following options:

� Comma , Example $1,000
� Decimal . Example $1.000
� Space Example $1 000

Decimal separator Select the character you wish to use as a decimal
separator by clicking on the down arrow to the right
of the field and selecting one of the following options:

� Decimal . Example $100.00
� Comma , Example $100,00

Negative sign This field allows you to specify the default format for
a negative dollar amount. Your options are:

� Leading - Example $-100.00
� Trailing - Example $100.00-
� Brackets () Example $(100.00)

The Use currency field is only a default. You can change the format
for any of these fields on the fly, by selecting the field you want to
change, clicking the right mouse button, and selecting Properties
from the pop-up menu that appears.
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Units tab
The Units tab allows you to specify defaults for all unit fields.

Field Details

Variable decimal Click this checkbox on if you would always like the
unit information to display the exact number of
decimal places you entered in a given unit field. If you
do not have this checkbox turned on, the Adagio
module will use the number of decimal places
indicated in the Decimal places field. If more decimal
places are entered than there is room to display or
print, the value will be rounded.

Decimal places In this field, enter the number of decimal places you
want unit fields to default to. You can only edit this
field if the Variable decimal checkbox has been
clicked off.

Thousand separator Select the character you wish to use as a thousand
separator by clicking on the down arrow to the right
of the field and selecting one of the following options:

� Comma , Example $1,000
� Decimal . Example $1.000
� Space Example $1 000
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Field Details

Decimal separator Select the character you wish to use as a decimal
separator by clicking on the down arrow to the right
of the field and selecting one of the following options:

� Decimal . Example $100.00
� Comma , Example $100,00

Negative format This field allows you to specify the default format for
a negative dollar amount. Your options are:

� Leading - Example $-100.00
� Trailing - Example $100.00-
� Brackets () Example $(100.00)

These settings are only defaults. You can change the format for any
of these fields on the fly by selecting the field you want to change,
clicking the right mouse button, and selecting Properties from the
pop-up menu that appears.

Lines tab
The Lines tab allows you to set defaults for all horizontal and vertical lines.
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Your options in this tab are:

Option Example

Width Enter the length you want all horizontal lines to
default to.

Height Enter the length you want all vertical lines to default
to.

Show border The Show border checkbox is grayed out and cannot
be edited.

Border width Enter the preferred default line width. A setting of 1
indicates a hairline thickness; this line thickness
increases incrementally as you increase the value in
this field.

Color Select a default color for your lines by clicking the
down arrow beside the Color field and choosing a
color from the drop-down list that appears.

Shapes tab
The Shapes tab allows you to set the shape defaults.
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You cannot change the default shape to an ellipse; however, you can
specify a number of other default settings.

Option Example

Width Enter the width you want all shapes to default to.

Height Enter the height you want all shapes to default to.

Transparent Click the Transparent checkbox on if you want your
shapes to be transparent by default. When shapes are
transparent, any object beneath them will be visible
through the shape itself.

Show border The Show border checkbox is grayed out and cannot
be edited.

Border width Enter the preferred default border width for your
shape. A setting of 1 indicates a hairline thickness; this
thickness increases incrementally as you increase the
value in this field.

Color Select a default color for your shapes’ borders by
clicking the down arrow beside the Color field and
choosing a color from the drop-down list that appears.

Foreground color Select the “fill” color you want your shapes to default
to. The color you select here will fill the entire shape.
Note that this is not the same as the border color,
which only affects the color of the line that runs
around the perimeter of your shape.

These settings are only defaults. You can change the format for any
shape on the fly by selecting the shape you want to change, clicking
the right mouse button, and selecting Size & Colors from the pop-up
menu that appears.
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Toolbar
This menu choice has a fly-out menu which provides several toolbar-related options:

Field Description

Visible Toggles the toolbar off and on. If you do not wish to use
the buttons on the toolbar, you might want to turn the
toolbar off. However, using the toolbar buttons can be a
quick and easy way to carry out certain functions. Also,
certain functions that are available on the toolbar cannot
be accessed in any other way. For example, you can
only insert a section, field, line, shape, or bitmap on the
specification by using the toolbar buttons.

Flat If you want the buttons on the toolbar to appear as flat
buttons, turn this option on.

Text If you want text labels displayed for the buttons on the
toolbar, turn this option on.

Images If you want to display the button icons on the toolbar,
turn this option on.

Hints
When this feature is turned on, the Designer provides you with some helpful “hints”
as you are working. It displays a small yellow rectangle below the cursor, to explain
the item your cursor is currently on. For instance, if your cursor is on the Section
button on the button bar, the yellow box will display:

Section

Or, if your cursor is on one of the fields/information codes you inserted on your
specification, the “hint” would display that as well. For example:

Customer name

A hint will not appear for a field that has been selected (e.g. a field
that has red handles around it). If you want to view the hint for a
selected field, you must first deselect it by clicking once anywhere
else on the specification. When the red handles disappear, move
your cursor over the field again and the hint will appear.
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The hints also appear in the Status Bar, regardless of whether you
have turned the Hint option on or off.

Snap to Grid
When turned on, the grid option provides an invisible grid that text, fields, and other
objects “snap to”. Try dragging an object up, down, and across a specification while
the grid option is turned on. Notice how the object seems to jump from invisible row
to invisible row as you move it up and down, or from invisible column to invisible
column as you move it left or right.

Now, turn the grid off. (Just select Snap to Grid from the Options menu to turn it
off; when the checkmark beside Snap to Grid disappears, the grid has been
disabled.) Try dragging the object across and up and down the page again. This time,
you will notice that the object does not jump between the grid’s invisible rows and
columns; rather, it moves smoothly and can easily be placed wherever you want it.

The advantage to using the grid is the ease with which you are able to properly align
and space the fields, text, and graphics as you place or move them on your
specification. However, if you want to have more control over the positioning of
certain things, like graphics, you might want to temporarily turn the grid off.

Please see the section below on Properties for more information on setting up your
grid. This section describes how to set the distance between those invisible lines and
columns.

Windows Menu
The Windows menu performs the same kinds of functions as other Windows menus
in most Windows applications. For detailed information on Windows functionality,
please consult your Windows manual. A brief overview of the functions on this
menu follows.

Cascades
Displays all of the specifications you currently have open in a “cascading”,
overlapping list, with the title of each specification showing. To edit a certain
specification, click on its name; it will move to the front of the cascading list, allowing
you to edit it.

Tile Horizontal
Tiles all of your open specifications horizontally, across the width of the screen.
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Tile Vertical
Tiles all of your open specifications vertically, down the length of the screen.

Arrange Icon
If you have minimized one or more of your specifications, this option will arrange
the icons for those specifications in a row across the bottom of the Designer screen.

Reduce all
Minimizes all of the specifications you currently have open.

Restore all
Restores all of the open specifications to their previous size and position.

Close all
Closes all of the open specifications. If you attempt to close the specifications using
this function, prior to saving any changes, you will be asked if you want to save each
unsaved specification.

List of open specifications
Lists all of the specification files you have open at any given time, with a checkmark
appearing beside the specification file that is currently displayed, and allows you to
switch between multiple specification files by selecting the file you wish to view from
this list.

Help Menu
The Help menu provides information about the Adagio module and the Designer,
via two options:

Contents
Lists all of the available Help topics. From this index, you can select a topic of
interest.

Topic Search
Allows you to search for certain topics by keyword.

The Designer Menus

Page 9-258 Adagio Fundamentals



About…
Provides details about the version of the Designer you are using, including your
company name and address, as well as other pertinent system information.
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Working with Specifications

Using a Specification
To use a specification:

1) Create a new specification or edit an existing specification until it meets your
needs.

2) Save it in your data directory.

3) When you print a batch or an individual document, select the desired
specification from the Specification field in the Print dialog box.

Be sure to save the file in the drive and directory where your data is stored.

The drive and directory will default to the data directory for the
database you currently have open if you start the Designer from
within the Adagio module (e.g. by selecting Maintain Specifications
from the Maintenance menu).

If, instead, you start the Designer from the Windows Start menu,
you must manually choose the correct drive and directory. The
Adagio program will not select it for you.
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Creating a New Specification

Creating a Specification from Scratch
1) Select File | New or click the New button in the Designer:

If a blank specification is created automatically, skip to step 4. Otherwise,
proceed to step 2.

2) Depending on the Adagio module you are currently working with, either a new,
blank specification will open up automatically, or a dialog box similar to the
following will appear:

3) You are given seven options:

Option Example

Check only Use this option to create a specification that will only
be used to print checks.

Advice only Use this option to create a specification that will only
be used to print advices.

Check / Advice Use this option to create a specification in which the
check appears first, and then a single advice follows.

Advice / Check Use this option to create a specification in which a
single advice is printed first, then the check.

Check / Advice /
Advice

Use this option to create a specification in which a
check is printed, followed by two advices.
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Option Example

Advice / Advice /
Check

Use this option to create a specification that prints two
advices, then a check.

Advice / Check /
Advice

Use this option to create a specification that prints one
advice, then a check, followed by a second advice.

You will notice that a special checkbox is available for the options that print two
advices. When the Both advices are same format checkbox is turned on, you
only need to create one advice section (including advice headers, footers, and
detail lines); the Designer will then use the advice portion of the specification for
both the first and second occurrences of the advice.

4) To select one of these options, click it once. A specification appears, with the
appropriate default sections for your selection. For example, if you had selected
the Check / Advice option, your screen would appear as follows:

5) Enter your new specification.

6) Assign the specification a brief, descriptive Title in File | Specification Options.

7) Select File | Save As when finished, to save the specification. Assign the
specification a name, making sure that its first three characters are correct for the
module (see table below), and that it has the same extension as your data uses
(e.g. SAM or DAT).
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When you start the Designer through the Adagio module, Adagio
will default to the proper data extension.

Make sure you save the file in the drive and directory where your data is stored;
otherwise, you will not be able to use the specification with your data.

Module Prefix

Adagio BankRec BR$

Adagio Checks QC$

Adagio Invoices QI$

Adagio OrderEntry OE$

Adagio Payables AP$

Adagio Receivables AR$

Adagio SalesCQ AC$

Adagio Time&Billing TB$

Whenever possible, it is recommended that you take a copy of an
existing specification and modify it to meet your needs, rather than
creating a new specification from scratch. In most cases, it will be
faster and easier.

Several sample specifications are provided with each Adagio
module. See the following section on using specification templates,
or the section on “Using the sample specifications” earlier in this
chapter for more information.

Creating a Specification from a Template
Several of the Adagio modules include some templates that may speed up the
specification creation process. If you want to view and modify a template, you can do
so through the Open Template option on the File menu.

To use this feature:

1) From the Designer menu, select the File menu. Move your mouse over the Open
Template option, and a fly-out menu will appear to the right.
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2) From the fly-out menu, select the template you wish to review and modify. The
templates are listed with a descriptive name to help you select the most
appropriate one.

3) If the template you call up fits your needs fairly closely, modify it as needed.

4) Although the templates already have titles, you may want to modify the title to
best suit your needs. To assign the specification a brief, descriptive title, see the
Title field in File | Specification Options.

5) Select File | Save As when finished, to save the specification. Assign the
specification a name, making sure that its first three characters are correct for the
module (see table below), and that it has the same extension as your data uses
(e.g. SAM or DAT).

Notes
• Two CPA Standard 006 complaint check specifications are available in Adagio

Payables. These specifications also work with the Wellspring check stock
which is available from Softrak Systems.

Editing an Existing Specification
1) Select File | Open or click the Open button in the Designer.

2) The Open Specification dialog box appears, with the default drive and directory
path pointing to the location of your data.

Select the name of the specification you want to edit by highlighting it and
clicking OK. The desired specification appears.

3) Make the necessary changes.

4) Select File | Save when finished, to save your changes.
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Copying a Specification
Specifications can be copied if you have a basic format you’d like but wish to make
minor alterations for a different bank or for some other purpose. To copy a
specification:

1) Open the specification you want to copy.

2) Select File | Save As. Enter a different file name for the specification and click
OK.

Again, you must ensure that the first three characters of the file name are correct,
that the data extension is the same as the extension used by your data set (e.g.
SAM or DAT), and that the specification is saved in the same drive and
directory/folder as your data.

3) In the new specification, select File | Specification Options. In the Edit
specification options dialog box, change the Title of the specification, in order to
differentiate between the original specification and the newly copied one.

4) Make the other changes you need.

5) Select File | Save to save your changes.

Deleting a Specification
Specifications must be deleted using the Windows Explorer. See your Windows
documentation for more information.

Printing a Specification
Select Print from the File menu. The Designer will print your specification.

If you would like to print an actual document to test out a new or
revised specification, you can do so by printing a test document
using the sample data and selecting the new or revised specification
from the Specification field in the Print check dialog box.

Multiple Specifications
If you use more than one type of specification and each one is different in its layout,
you will want to have a separate specification for each. However, if your documents
are basically the same, you should have only one specification.
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Selecting a Specification for Printing
When you use more than one specification to print your checks, you must select the
specification you wish to use before you print the batch or individual document. To
do this, click the down arrow to the right of the Specification field in the Print dialog
box, and select the desired specification from the list that appears.

The list will display the specification title, or, if no title has been
assigned to that specification, the specification file name. A title
can be assigned to a specification in the Designer, by selecting
Specification Options from the File menu and assigning a name for
the specification in the Title field.
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Importing Specifications
Specifications created in previous versions (6.6A or older) of the Adagio Designer
will be converted as they are used, or if saved with the new Designer.

When converted, the Autosize property is automatically turned off due to the
conversion. Thus the spec may need to be edited to turn autosize back on for any
field where it was on prior to the conversion.

If in the old version you had Autosize turned off in the Properties | Formats dialog,
there should not be a problem during conversion as most or all fields will not be
using the Autosize feature. However, minor adjustments may be required after the
spec is converted, and we recommend that you print test forms after installing the
latest version of the Adagio program to ensure that they are printing correctly .
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Converting Specifications
Adagio products (versions 6.8A and higher for most Adagio products) include a new
version of the Designer. In most cases specifications will print correctly from existing
specifications designed in earlier versions. However, we recommend specifications
created in previous versions be converted before they are used. To convert a
specification, simply open it and save it in the designer. Minor adjustments may be
required after the specification is converted, and we recommend you print test
documents after installing the new Adagio program to ensure they are printing
correctly.

In some cases if the Page Size in an invoice or credit note specification is set to
‘Default’, it may not print correctly, depending on your printer settings in Windows.
We recommend you change the setting to ‘Letter 8 ½ x 11 in’ (or other specific size as
appropriate).

When specifications are converted from pre-6.8A releases, the Autosize property is
automatically turned off due to the conversion. The specification may need to be
edited to turn Autosize back on for any field where it was on prior to the conversion.
If in the old version you had Autosize turned off in the Properties | Formats dialog,
there should not be a problem during conversion as most or all fields will not be
using the Autosize feature.

Specifications created with Adagio 6.8A or higher cannot be used
with earlier versions of Adagio programs.
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Chapter 10

Getting Help

Each product in the Adagio suite offers a comprehensive Help system to support you
during every step of whatever process you are working on.

The Help system is easy to use. If you’ve used Help systems in other Windows
programs (or in Windows itself, for that matter), you probably know enough to begin
using the Adagio Help system without further study. If you need more information
on using Windows Help, see the documentation that you received with Microsoft
Windows.

The program offers two kinds of help: context sensitive help and indexed help.
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Context Sensitive Help
Context sensitive help gives you immediate help with the screen element that is
selected (a menu command, a field in a dialog box, etc.). The program takes you
directly to the help information you seek without the need to traverse the indexing
system.

To get help on a field or a button in a dialog box, go to that field or button and press
F1. (Do not click the button for which you want to obtain Help; instead, use the Tab
key to tab through the fields on the screen until the button is selected, as indicated by
a light line surrounding the command name.)

Indexed Help
Indexed help takes you to the help indexing system, a hierarchy of indices which is
designed to help you target your topic of interest. Using the indexing system, you
can select a broad topic of interest from the first index and then narrow your
selection using the next index that appears, then the next, etc.

The Help system is a storehouse of information that can make your work in the
Adagio suite of products more productive. A comprehensive indexing system and
hundreds of search terms provide you a variety of avenues for finding the help you
need, right from your computer.
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Appendix A

Lanpaks & ADS

All Adagio 6.8 products (and higher) use the Adagio Lanpaks for multi-user licenses,
which replaces the MUPs or Multi-User Packs used by previous versions of Adagio
products. In addition, Adagio 6.8 products use the “Adagio Data Source” to access
the Adagio databases. This chapter describes how ADS and Lanpaks work.

What is ADS?
“Adagio Data Source”, or ADS for short, is a program that allows Adagio
applications to access the Adagio database. ADS manages record and file locking. All
Adagio products, version 6.8 or higher, use ADS.
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What are Adagio Lanpaks?
A Lanpak is a system utility that increases the number of license units available for
Adagio users over a network. Lanpaks allow multiple users to run Adagio
applications and access the databases on the same network.

To verify the number of units you’re using, display the Help | About screen in any
Adagio application.

Who Should Use Adagio Lanpaks?
• Adagio sites who have multiple people in their accounting and order

departments, who need to run more than one copy of the same Adagio
product at the same time.

• Companies who were previously using the Multi-User Packs (MUPs) from
Softline Systems or ACCPAC International to increase the number of licenses
available for Adagio users over a network.

How Many Lanpaks Do I Need?
Lanpaks are only needed if you will run more than one session of an Adagio module
at a time. You may use separate Adagio modules on different machines in the
network, or start them all on the same machine.

If a second user attempts to access an Adagio module that is already running,
Lanpaks are required. To determine the maximum number of Lanpak units you will
need, subtract 1 from the maximum number of simultaneous users in each Adagio
module; then add together the counts for each module.

Adagio Lanpaks come in several sizes (2, 5, 10 and 20 units), and the cost per unit is
lower for the higher sizes. For higher numbers of units, you can purchase additional
Lanpaks.

For example, the Adagio Corporation has purchased a Quartet (Invoices, Receivables,
Payables, Ledger). They expect 3 people to be using Invoices at the same time, 2
people to be in Receivables, and one each in Payables and Ledger. So, they need 2
Lanpak units for Invoices and 1 Lanpak unit for Payables; no Lanpak units are
required for Payables or Ledger. Since a total of 3 Lanpak units are required, they
should buy either a 5 unit Lanpak or two 2 unit Lanpaks.
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How Lanpak Licensing Works

Example #1
Sarah starts her work day by opening the following applications:

• Adagio Invoices,
• Adagio Inventory, and
• Adagio Receivables

At the time, no one else is on the network, using Adagio applications, so at this point,
no Lanpak units have been used.

Later, Ben and John both start up Adagio Receivables. Now, three copies of Adagio
Receivables are being used. Since the first instance of an application (when Sarah
started A/R up earlier) doesn’t take a unit, this means that there are now two units in
use.

After lunch, Ben wants to check something in Adagio Inventory, so he starts it up.
Remember that Sarah has Adagio Inventory open already, so this second call to the
application will require a unit. However, because the company only has two
multi-user units installed, and they’re both being used, Ben gets a message indicating
that there are no units left. He has to exit the program.

He decides to close Adagio Receivables, so that he can free up one unit. That done,
he starts up Adagio Inventory successfully. Both available units are again in use.

Example #2
Sarah starts her work day by opening Adagio Receivables.

At the time, no one else is on the network, using Adagio applications, so at this point,
no Lanpak units have been used.

When they arrive at work, Ben and John both start up Adagio Receivables. Now,
three copies of Adagio Receivables are being used. Since the first instance of an
application (when Sarah started the product up earlier) doesn’t take a unit, this
means that there are now two units in use.

Later, Sarah starts Adagio Inventory. This is the first time Adagio Inventory is being
called, so no unit is required.

When Ben wants to start Adagio Inventory later, however, it does require a unit. But
both units were invoked when Ben and John started up Adagio Receivables earlier.

Ben decides he can do his work in Adagio Inventory later, and instead decides to do
some invoicing. He starts up Adagio Invoices. No one else has yet called Adagio

What are Adagio Lanpaks?

Lanpaks & ADS Page A-273



Invoices, so this time there is no unit required, and he can proceed without any
problem.

Summary
As the above examples indicate, Lanpak units are not needed if no one on the
network is running more than one copy of any given Adagio application. Three
different people can have three different Adagio applications open at the same time
without using any Lanpak units. Units are only invoked when more than one user
(or computer) calls the same Adagio application.

As also illustrated in the above examples, Adagio Lanpak will maximize the number
of units available to you, as users enter and exit the various Adagio applications. Any
necessary adjustments will take place within 60 seconds of a user exiting an
application.

Running with a mix of different Lanpak versions is not
recommended. To ensure optimal use of Lanpak licenses, all
Lanpaks should be at the same an latest version available. See
Lanpak Versions on page A-6 for more information.

Upgrading
The following information is necessary if you are upgrading from a pre-6.8 version of
an Adagio product.

Users
User lists are maintained separately for ADS and DBI applications. When you install
Adagio applications that use the ADS system (versions 6.8 or higher), users in the
DBI user list are converted automatically. However, on conversion, the users’
passwords change to their user ID and should be re-entered.

For example, if a user has the user ID “ABC” and the password “DEF”, when they
are converted, their user ID remains “ABC” but their password changes to “ABC” as
well. The password should be changed after conversion.

The user “SYS”, or System Administrator, will always be there post-conversion.
Again, however, the SYS user’s password will also be “SYS”, so be sure to change it
immediately, for security reasons.
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Lanpak Versions
Adagio 8.1A modules require Lanpak 8.1A or higher. Adagio 9.0x versions require
Lanpak 9.0A or higher, as do some 8.1A, 8.1B and 8.1C versions. Adagio 8.0x (and
lower) modules all use Lanpak 6.8A or higher licenses.

Please refer to our website at www.softrak.com under Support, Compatibility for
up to date information about products and versions that are compatible with the
module you are wanting to install.

It is possible to have a mix of different Lanpak versions. However, this is not
recommended for the reasons discussed below and illustrated by the following
example. To ensure optimal use of Lanpak licenses all Lanpaks should be at the same
and latest version available.

An Adagio site has these sizes and versions of LP installed:

Lanpak/02, V6.8A

Lanpak/05, V8.1A

Lanpak/10, V9.0A

Adagio modules at these versions will have the number of licenses available as
shown:

V6.8A to 8.0x 17

V8.1A 15

V9.0A 10

If you have a mix of Lanpak 6.8A and Lanpak 8.1A, and mix of V8.0x and V8.1A
modules, your V8.0x modules may consume Lanpak 8.1A licenses, which could
cause 8.1A licenses to be unavailable to your V8.1A modules. This will depend on the
order in which you open your V8.0x vs. your V8.1A modules. If you started all your
of V8.0A modules first, they may use 8.1A licenses and your V8.1A modules might
not have sufficient licenses available to them. Whereas if you started your V8.1A
modules first you would have sufficient licenses to start your V8.0A modules.

The number of Lanpak licenses available is shown in the ‘Licensed users’ field in
Help | About. The number of licenses available to 8.0x modules is the total of all
Lanpak licenses for all Lanpak versions. The number of licenses available to 8.1A
modules is the total of licenses for all Lanpak versions 8.1A or higher, exclusive of
any 6.8A licenses.
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If all 8.1A licenses are consumed, 8.1A modules could show “x of y in use”, where x
can be greater than y.

Lanpak version requirements for third-party products from Adagio Developer
Partners may vary. Check with the developer for further information.

Use the System Status Check function (refer to page 1-22) and its
Check Lanpak Status button to display a list the number of each
Adagio Lanpak version installed on your network.
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Appendix B

Converting DOS
Specifications

Adagio programs allows you to convert specifications that were originally created in
the relevant Softrak DOS products or ACCPAC* Plus programs, so that you will not
have to re-enter each specification manually. This should save you a considerable
amount of time and effort as you move from your DOS programs to Adagio.

Due to the vastly different way that specifications are entered in DOS specification
editors, the convert function has a limited ability to fully interpret everything it finds
in a DOS specification. The following sections look briefly at each possible type of
information the convert function encounters as it reads a DOS specification, and
explains how it handles that information.

Please note that the Adagio Designers will not ask you if you wish to convert a DOS
specification. If you attempt to open a DOS specification file name, it assumes you
want to convert the selected specification, and so the conversion process begins
immediately, without any prompting from you. If you do not wish to convert a
specification, you should return to the DOS program and view it in the DOS
specification editor. However, the convert function does not alter the original DOS
specification, so even if you convert a DOS specification, you will always be able to
return to the DOS program and view and/or edit the original specification in the
DOS specification editor.

This chapter will first explain how to convert a DOS specification, and then evaluate
the process Adagio goes through to convert different kinds of information.

Converting DOS Specifications Page B-277



Converting a DOS Specification
The following takes you step-by-step through the process of converting a DOS
specification to a specification that can be used by Adagio Invoices.

We strongly recommend that you read through the remainder of this chapter before
attempting to convert a specification.

1) Open the appropriate Adagio Designer (for example, the Invoice Designer in
Adagio Invoices) by selecting Maintain Specifications from the Maintenance
menu, or by clicking the Maintain specifications button.

2) In the Designer, select File | Open, or click the Open button:

An Open Specification dialog box appears:

3) The List Files of Type: field appears in the upper, right-hand corner of this
dialog box. Click the down arrow to the right of this field and select Dos
Specification. A list of DOS specifications will appear below the File name field.

4) Select the specification you wish to convert and click OK. Adagio converts the
requested specification and displays it on your screen.
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5) Save the converted specification using the appropriate Adagio prefix (see below)
as the first three characters of the file name, to differentiate between the old DOS
specification and the newly converted Adagio specification.

Module Prefix

Adagio Checks QC$

Adagio Invoices QI$

Adagio OrderEntry OE$

Adagio Payables AP$

Adagio Receivables AR$

Adagio Time&Billing TB$

The Designer will not ask if you wish to convert the selected
specification; it automatically begins the conversion process once
you have chosen a DOS specification file.

The DOS specification you select for conversion is not affected by
the convert function; it will remain unchanged and can continue to
be used in the relevant DOS module.

Once the specification has been converted, work with it as you would any other
specification. See the Adagio Fundamentals manual for more information.
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Information Codes
In all cases except date fields, information codes are converted straight into the same
information code on your new Adagio specification.

If you used any of the number control codes in combination with numeric fields on a
DOS specification, the convert function will also attempt to convert those additional
pieces of information

Please see the relevant DOS manual for further information on all of these control
codes.

Date Fields
The single exception to a straight conversion of information codes involves date
fields. As you will recall, date fields are entered into DOS specifications by using the
information code for the desired date followed by a period and a letter indicating
what portion of the date you wish to print in that position (the month, the day, or the
year), and in what format you want that information to appear. So each date entered
in a DOS specification will use the information code three times, each time followed
by a different “extension”. For example, to print November 1, 97 on a DOS
specification, you were required to enter:

%E22.L %E22.D, %E22.Y

Because Adagio handles the formatting of a date field all at once (not in three distinct
parts, as displayed above), there is no way to convert a date field’s formatting. As a
result, when Adagio sees a date field on a DOS specification, it places it on the
Windows specification with only the default formatting. The information code is the
same, but the formatting is not. If you want to revert back to the DOS formatting
once you have converted the specification, you must do that manually. The convert
function will not do it for you.

Due to the way the conversion function handles date formatting, you may want to set
the default date format before conversion. Do so by selecting Properties from the
Options menu and clicking the Formats tab.

Information Codes

Page B-280 Adagio Fundamentals



Literal Text
Any literal text that appears on a DOS specification will be placed in a label on the
Adagio specification. This includes straight text as well as all hyphens, underscores,
or equal signs that were used for underlining or creating separating lines in the DOS
specification.

For example, if you entered the word “Invoice” in the header of a DOS specification,
it will appear as a label on your Adagio specification. If you then used a series of
hyphens on the next line of your DOS specification to create an underline effect for
the word “Invoice”, that series of hyphens will also appear as a label on your Adagio
specification. The convert function will not translate those hyphens into a horizontal
line. However, you can easily fix this by deleting the label and inserting a horizontal
line.

Literal Text
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Formatting

Page Settings
You must manually set the page size and left margin once you have converted a DOS
specification.

The convert function attempts to duplicate the vertical spacing (lines per inch setting)
you set when you created your DOS specification, so that your information codes
and literal text appear evenly spaced on the newly converted specification.

In addition, the convert function attempts to deal with a variety of number control
codes that affect how certain numeric fields are printed. This includes:

• Dollar Width control codes (^Dnn) which set the column width for printing
dollar values.

• Dollar sign control codes (^D$nn) which turn a floating dollar sign on and sets
the width of the dollar fields.

• Width and decimal place control codes (^Unn.mm, ^Rnn.mm, and ^Bnn.mm)
which set the width and decimal places for real numbers.

Please see the relevant DOS manual for more information on these and other control
codes.

Line Spacing
The convert function also attempts to match the vertical, or line, spacing of a DOS
specification as closely as possible. If you used a vertical spacing code to set the line
spacing at the beginning of a DOS specification, it will try to match the value you
entered. If, however, you did not specify the vertical line spacing, it will use the
default of 6 lines per inch when in converts the specification.

As you will see from the following discussion on fonts, since there are so many
different types of fonts you can use in the Adagio Designers, in such a wide variety
of sizes, you may find that the line spacing is too wide (e.g. there is too much white
space between lines) or that it is too tight, even to the extent that lines are slightly
overlapping. If this occurs, you can either manually readjust the spacing of all the
objects on the converted specification, or you can return to the DOS specification
editor, set a different line spacing for the original specification, and then reconvert
the specification.

Formatting
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Fonts
When Adagio converts a specification, it uses the default font you set under Options
| Properties. All literal text and information codes it encounters in the DOS
specification will appear in this default font on the newly converted specification.

Font Size
The DOS specification editor allowed you to set the print pitch for your
specifications, and the convert function attempts to match that print pitch as closely
as possible. Your converted specification will use the same print pitch as the DOS
specification. If no print pitch was specified, it will default to 12 points. You must be
aware of certain facts regarding print pitch in DOS applications and font size in
Windows applications, however.

Print pitch is not the same thing as font size. When you set print pitch on a DOS
specification, you were telling it how many characters per inch to print. If you chose
a print pitch of 10, it would print 10 characters per inch. Likewise, a setting of 12
would print 12 characters per inch. The larger the number, the smaller the print, since
it would be squeezing more characters into the same amount of space.

However, font size in Windows applications is exactly the opposite. In Windows
applications, as you increase the font size, each character gets larger. Text that is
printed in a 10 point font will appear smaller than text that is printed in a 12 or 14
point font. With proportional fonts, the font size defines the height of each character
rather than the width, as with pitch size in DOS.

In addition, there are many, many different kinds of fonts in Windows and since
each font is stylistically different, two fonts that are both set to 10 points may look
fairly different in terms of size.

Because of these differences, it is virtually impossible to translate the print pitch from
a DOS specification into the exact same size in your chosen default font. The convert
function attempts to roughly translate the print pitch to an appropriate point size.

If you find that the font size is not to your liking once you’ve converted a
specification, your best recourse is to return to the DOS specification editor and add a
print pitch setting (or change it, if one is already there), specifying a print pitch size
that will work better for you. For example, if you did not specify a print pitch in the
original DOS specification, the print pitch will be 10 characters per inch by default. If
you converted this specification and found the resulting 12 point font size too large
for your liking, return to the DOS specification and add a print pitch line at the top of
your specification using a different print pitch. You might want to try 12 characters
per inch, which will convert to about 10 points in the Windows specification. In this
case, you would add the following line to the top of your DOS specification:

^P12

Formatting
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Once you have made the change to the DOS specification, save it and return to
Adagio. Convert the specification again and check the result.

Similarly, if you have converted a specification and it does not appear in the font you
wanted, go into Options | Properties in the Designer and change your default font
to the desired font for the converted specification, and then try to convert the
specification again.

Text and Information Codes
When the convert function finds text or fields that made use of the overstrike effect
or that were bolded or underlined in a DOS specification, it will also overstrike, bold,
or underline the new label or field. So if you had inserted the word “Statement” in
the header of your DOS specification using the ^N font control code to underline it,
the result would be an underlined “Statement” label on the Adagio specification.

The convert function does not convert special font or script control codes, so if you
used the special font (^Sn) control code or the script (^Cn) control code on your
specification, the relevant text or information code will be converted, but that special
font and scripting will not. Because of Adagio’s full Windows formatting
capabilities, however, it is very easy to use multiple fonts, with a variety of
formatting effects, on your specification, or to add superscript or subscript formatting
to a label.

Formatting
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Miscellaneous Notes
• Position codes on a DOS specification are recalculated so that your literal text

and information codes appear in the same relative position on the Windows
specification page as they did in DOS. Since the DOS program required that
you use position codes to indicate correct placement of information on your
specifications in most cases, you should not have to do much readjustment
and realignment of your labels and fields on the converted specification.

• Adagio’s Designers do not allow you to use lowercase letters when you create
detail line sections from scratch on a specification. However, the DOS
specification editor allowed you to choose between using an uppercase or a
lowercase letter on a line. If you chose to begin a line with a lowercase letter
(e.g. .a), that line would always print, regardless of whether it was blank or
not. If you instead chose to begin a line with an uppercase letter (e.g. .A), that
line would only print if it contained information. In Adagio, this
upper/lowercase feature has been replaced with a Suppress blank option. If
you turn the Suppress blank option on for a section in Adagio, it has the same
effect that beginning a line with an uppercase letter did in DOS.

The convert function differentiates between lines in a DOS specification that
begin with lower and uppercase letters, and creates multiple sections for that
style where necessary. Each time the convert function finds a line that begins
with an uppercase letter, it creates a new section and automatically turns the
Suppress blank option on. It does this for each line beginning with an
uppercase letter, regardless of whether these lines appear in succession on the
DOS specification, since that is the only way to suppress a line at a time.

• While Adagio does its best to convert DOS specifications as completely and as
accurately as possible, you will likely find it necessary to make some
adjustments to the converted specification. For example, one area where the
conversion process has some difficulty is in properly determining the length of
labels or information codes. This is primarily due to the differences between
DOS print pitch and Windows font formatting, and cannot be helped. As a
result, you may need to go through the specification and manually resize some
of the fields and labels, to ensure that the full field or label will appear when
you print the specification. If you do not check the size of the fields and labels,
you may find that some information is cut off when you print the
specification.

• Bolding and underlining in a DOS specification are converted.

• Once the conversion process is complete, you must save the specification
using the Windows file name convention for specifications, by replacing the
first three characters of the DOS file name xx# with the correct first three
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characters for a Windows specification file, xx$. See below for a list of the
proper specification file prefixes in Adagio.

Module Prefix

Adagio Checks QC$

Adagio Invoices QI$

Adagio OrderEntry OE$

Adagio Payables AP$

Adagio Receivables AR$

Adagio Time&Billing TB$

Miscellaneous Notes
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Appendix C

Considerations for
ACCPAC Users

Compatibility with ACCPAC Plus
The most up-to-date compatibility information is on the Product Reference
Compatibility Info link at www.softrak.com including compatibility with ACCPAC
Plus. Also, please refer to the Readme documentation available with each Adagio
module for more detailed information on product compatibility with that specific
Adagio module.

Report Tables Drive
During installation you will be asked for the Report Tables Drive. The report tables
drive defaults to the drive on which ACCPAC Plus or other Adagio programs are
found. The Report Tables Drive should be the same for all Adagio products;
additionally, if ACCPAC Plus is installed, it should be the same as the drive where
your ACCPAC Plus programs are installed.
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Using with Existing ACCPAC Plus
Databases

If you are using ACCPAC Plus and you wish to use Adagio with the existing
ACCPAC Plus data, choose the path to your ACCPAC Plus data when creating or
opening databases for Adagio.

EZFile Directories Dialog
If this is your first time creating or opening an Adagio database, the EZFile
Directories dialog box will appear. This dialog box requires you to complete two
fields to indicate the location of some required system files. Adagio will attempt to
automatically select the locations of the files discussed below for you. One this
information is entered for one Adagio database, it will be used for all further Adagio
modules that use the same path and data extension.

Field Description

Currency path The currency path must contain files called
MCCODES.LD4 and MCDEF.LD4. If you are running
ACCPAC Plus, those files are usually located in your
\ASP directory. For example, if ACCPAC Plus is installed
on your hard drive, you would generally find those files in
C:\ASP.

If you are using ACCPAC Plus, all Adagio and ACCPAC
Plus products should have the same currency path.

If you attempt to select a path in which the
above-mentioned files are not found, you will get an error
message. Select the path again using the browse button.

Adagio installs currency files in the \SOFTRAK\SYSTEM
directory. These files should not be used unless you
cannot find the currency files used by your ACCPAC Plus
data.



Field Description

EZTasks path If you are using ACCPAC Plus, the EZTasks path must be
the same as it is for ACCPAC. As with the currency path,
this is generally your \ASP directory.

All Adagio products and ACCPAC Plus must use the
same EZTasks path. If this is not correct in a multi-user
environment, data corruption may result.
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Appendix D

Glossary

Alignment check A test check that is printed prior to a check run, to verify that
the check stock has been loaded into the printer correctly and
that the checks will print properly.

When an alignment check is printed, that check number is
included on the check Audit List as an alignment check.

Alignment checks are primarily used for dot matrix printers.

Archive checks Checks that have been saved for repeated use. When you
restore an archive check, you effectively create a new check
based on information used in past checks. This is useful when
you need to issue the same check month after month, for
example.

Archive batches/
invoices

Batches or invoices that have been saved for repeated use.
When you restore an archive batch or invoice, you effectively
create a new batch or invoice based on information used in
past batches or invoices. This is useful when you need to
issue the same invoice month after month, for example.

Audit detail
section(s)

Part of a check specification. The section(s) of an advice slip
that contain detailed check information. Specifications can
have up to three different audit detail sections for each advice
slip; these include Purchase, Job Cost, and Time and Billing
sections. As you can see, this allows you to insert one audit
detail section for each possible detail line type.
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Audit footer
section

The bottom section of an advice slip which contains no detail
lines; usually contains the check amount.

If the check contains more detail lines than can fit on one
advice, the audit footer section will appear only on the last
page of the advice slip.

Audit header
section

The top section of an advice slip which contains general
information such as the vendor name and number as well as
the check number and date.

If the check contains more detail lines than can fit on one
advice, the audit header section will print on each page of the
advice slip.

Bank code A code used to represent a particular bank account upon
which checks will be issued.

Buttons Graphic representations of certain Adagio and Adagio
Designer commands. When you click a button, it carries out
the same command as you would carry out by selecting the
corresponding option from a menu. For example, if you click
the Edit company profile button, this opens the Company
Profile; if you had selected Company Profile from the Edit
menu, the Company Profile would have been opened in the
same way.

Calculator A calculator is available in most of Adagio’s unit and amount
fields. When you double-click in these fields, a calculator
appears on screen, allowing you to perform any necessary
calculations right in Adagio. If you perform a calculation and
then click OK, Adagio will insert the calculated amount in the
selected field; if you want to discard the calculated amount,
click Cancel instead.

Calendar A calendar is available in Adagio’s date fields. If you click
the calendar button beside these fields, you can edit any date
field by selecting a different month, date, and even year from
a small pop-up calendar that appears.



Checkbox An option in the Company Profile that determines how you
want the program to deal with certain repetitive sets of
circumstances. For example, the Increment checkbox in the
Adagio Invoices Company Profile determines whether you
want the program to assign an unused, sequential document
number to created, copied, or restored documents or to assign
a specified default number to created, copied, or restored
documents.

When you click a checkbox on, a checkmark appears in the
box. This indicates a “yes” answer to the question, which sets
the system to work one way. If you click the checkbox off, so
that no checkmark appears, this turns the option off, which
tells the system to work a different way. It is much like
turning an electric switch on or off. All Adagio checkboxes
work globally; that is, they work whenever the specific set of
circumstances occurs rather than once only.

Check details Expense distribution detail for the items you are actually
paying for with the check: hours, items, services, etc.

Cleared check A check that has been issued and has cleared the bank for the
same amount as the issue amount.

Cleared with
error check

A check that has been issued and has cleared the bank for an
amount other than the issue amount.

Cursor keys Cursor keys are the keys on your numeric keypad that control
cursor or highlight movement. These include Home, End, Pg
Up, Pg Dn, and the Arrow keys.

Customer category A customer category is a set of tax rates that applies to a
specific group of customers within a jurisdiction.

Default A default is a pre-loaded response to a software request for
data. It is the response the computer accepts automatically if
you don’t enter different data. You do not need to edit the
default information unless you want to enter a different
response.

Distribution
code

A code to which you assign a single Ledger account (and
department, if applicable), and to which transactions are
distributed. May be used to control the automatic breakout of
tax from a tax inclusive invoice amount.

Glossary Page D-293



Page D-294 Adagio Fundamentals

Drop-down box A small down arrow appears to the right of many fields in
Adagio. When you click this down arrow in a particular field,
Adagio displays all of your options for that field by dropping
a list of possible choices down below the selected field.

History In some Adagio modules, if you have the Retain history
checkbox turned on in the Company Profile, Adagio keeps
copies of all posted documents until you manually delete
them. This allows you to review the documents once they’ve
been issued and processed.

Invoice items The items on an invoice which you are actually billing for:
hours, items, services, etc.

Item category A set of tax rates that applies to a specific group of items
within a jurisdiction.

Item code The code which controls entry of invoice items.

Item style A detail line section on the specification that controls how one
type of item is printed on the invoice.

Jurisdiction A taxing authority, a governmental agency or department that
levies taxes; e.g. a city, a state, a federal government, etc.

Leading check Some dot matrix printers require that one blank form be fed
through the printer in order to print properly. This blank
form, which you manually feed through the printer prior to
doing a check run, is called a leading form or leading check.

If you use leading checks, Adagio Checks and Adagio
Payables records the check number of each leading check,
adding it to the check Audit List as a leading check.

Line items See Invoice items.

Manual check See Non-printable check.

MICR encoding The encoded transit and bank information that appears on the
bottom of checks. In the Edit | Banks function, Adagio
Checks and Adagio Payables allows you to enter your transit
information in MICR encoded format, which can then be
added to your check specification and printed out with each
check.



Multi-select The process of selecting more than one item at a time. (“Items”
can include documents, batches, detail lines, bank codes,
objects on a specification, etc.)

To select more than one item, hold the Ctrl key down and
click each item of interest once.

Non-printable
check

A check that was written manually and entered into QCWIN
after the fact. It does not need to be printed as it has already
been issued, usually written up by hand in a checkbook.

Outstanding
check

A check that has been issued by has not yet cleared the bank.

Pop-up menu A menu that appears when you click the right mouse button,
displaying your options in a given screen. From the pop-up
menu, you can select the desired command or action by
clicking it once.

Printable check Any check that needs to be printed.

Prompt A short message on the screen that lets you know that the
computer is waiting for some response from you. A prompt
also indicates the kind of response that is expected.

Reversed check A check that was issued but was cleared by the bank or
vendor, or for which payment was stopped.

Scroll bars When a list or display is too big to fit on a single screen, scroll
bars appear down the right side of the screen and/or across
the bottom of the screen. To view the remainder of the
information that is hidden from view, click the arrows at
either end of the scroll bars.

Specification The document which controls the printing of your documents.

Style code The Detail line section code that identifies the section of the
specification you are formatting. For example, a Detail line A
section on an Adagio Invoices specification includes all of the
formatting information for any style code A items on your
invoice.
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Tab Many of the functions in Adagio are broken up into several
different screens, each containing certain types of information.
When this occurs, Adagio displays “tabs”, for each screen. To
go from one screen to another, simply click the desired tab.
This is very similar to file folders; when you open a filing
cabinet, each file contains certain types of information. To
view the information in a file, you find the file tab you need
and pull the file folder out.

Tax group The set of rules and rates used for taxing sales within a sales
area. Each sale that is subject to identical rules and rates from
an identical set of jurisdictions, with posting to identical
accounts, is said to belong to a single Tax group.

A sales area is an area in which all sales are taxed according to
an identical set of rules and rates by an identical set of
jurisdictions (one or more).

Sales to a rural area may be subject to taxes only from the state
while sales to a large city may be subject to taxes from both
the state and the city. Since sales to both areas are taxed
differently, each area is considered a separate sales area, and
each area requires a separate Tax group.

Voided check A check that was reprinted during a check run.

Window When you are using a Adagio function, it appears in its own
“window”. Adagio allows you to have multiple windows
open at one time, allowing you to easily go back and forth
between various functions.
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C
Calculator 3-82

defined D-292

Calendar 3-81

defined D-292
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item, defined D-294

Changing column title order 5-122
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Check Designer

hints 9-256

menus 9-238
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snap to grid 9-257
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toolbar 9-256

undo 9-234

Check System Utility 1-22 - 1-24

Check Lanpak Status 1-23 - 1-24
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keyboard 6-137
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specifications 9-265
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Decimals

setting default number of places 9-250

variable, setting 9-252

Defaults

defined D-293

for Check Designer font 9-248

for Check Designer grid 9-247

for decimal places 9-250

Deleting

specifications 9-265

Deleting faxes 7-162, 8-189

Designer
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Designing specifications
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defined 9-196
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Dollar format
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9-253

setting default symbol 9-251

Double-arrow cursor 2-45

Drag and drop cursor 2-45
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Drop-down box
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Email queue 8-184 - 8-191
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hints 3-84

printing options 3-85 - 3-86
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Field object

editing 9-207

File menu

in Check Designer 9-238
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Creating 5-126 - 5-130
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Font

setting default in Check Designer 9-248
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defined 9-196
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setting defaults 9-247
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H
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defined 9-197
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in Check Designer 9-256
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defined 9-197

Hourglass cursor 2-45
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Implied decimal 3-68
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defined 9-197
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defined 9-197
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Integrity checker 3-88 - 3-89
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